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Designing Networks with 
Cisco TransportPlanner

Cisco TransportPlanner provides you with numerous tools for customizing the software, creating and 
analyzing networks, and creating a bill of materials (BoM). You can use Cisco TransportPlanner to 
perform the following tasks:

• 2.1 Launching Cisco TransportPlanner, page 2-1

• 2.2 Setting Cisco TransportPlanner Options, page 2-6

• 2.3 Creating a Project, page 2-25

• 2.5 Analyzing the Network, page 2-52

• 2.6 Viewing Network Reports, page 2-52

• 2.7 Editing a Project, page 2-81

• 2.8 Managing the Network Design, page 2-120

• 2.9 Generating a BoM, page 2-125

• 2.10 Managing the Price List, page 2-130

Note To run Cisco TransportPlanner, you must install Java Runtime Environment (JRE) 1.5.0. You can 
download it from the following URL:
http://www.oracle.com/technetwork/java/javase/downloads/index.html

2.1 Launching Cisco TransportPlanner 
Before you start Cisco TransportPlanner, you need to save the user profiles provided to you by Cisco 
Systems to the profiles directory. Access to Cisco TransportPlanner features depends on the user profile 
you select when you start Cisco TransportPlanner. The default profile is Network Designer.

Note In Cisco TransportPlanner Software Release 8.5, the user does not need a user ID and password to log 
into Cisco TransportPlanner.

Use the following procedure to launch Cisco TransportPlanner:

Step 1 Copy the CTP-v850.zip file to your hard drive. 
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Step 2 Extract the ZIP file using the Extract to Folder option.

Step 3 Copy the profiles provided to you to the profiles folder.

Step 4 Launch Cisco TransportPlanner by double-clicking the ctp.jar file. 

The Cisco TransportPlanner 8.5 Login dialog box appears (Figure 2-1).

Figure 2-1 Cisco TransportPlanner 8.5 Login Dialog Box

Step 5 Click Continue to open Cisco TransportPlanner. 

The login profile type appears in the lower right corner of the Cisco TransportPlanner window. 

2.1.1 Opening a Project
Use the following procedure to open an existing Cisco TransportPlanner project. To create a new project, 
see the “2.3 Creating a Project” section on page 2-25.

Step 1 Click the project name under Open in the Tasks Pane (Figure 2-2). The project opens. If you do not see 
the project name listed, continue with Step 2.

Step 2 Click Open under Project in the Tasks Pane or in the File menu.
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Figure 2-2 Opening a Project from the Tasks Pane

Step 3 In the Open Project dialog box, navigate to the desired directory and choose the project. Click Open. 
The Cisco TransportPlanner project appears.

2.1.2 Loading and Unloading Networks
Each network in a project requires memory. To save memory, when Cisco TransportPlanner opens a 
project, all networks are in the Unloaded state. An unloaded network appears in the Project Explorer with 
a “U” next to the network identifier (Figure 2-3). To load an unloaded network, double-click on the 
network folder in the Project Explorer, or right-click the network and choose Load from the shortcut 
menu. 

Figure 2-3 Unloaded Network in the Project Explorer 

A loaded network appears in the Project Explorer with an “L” next to the network identifier (Figure 2-4). 
To unload a loaded network, right-click the network icon in the Project Explorer and choose Unload 
from the shortcut menu.
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Figure 2-4 Loaded Network in the Project Explorer 

2.1.3 Saving a Project
Use the following procedure to save a project:

Step 1 Choose one of the following:

• To save an existing project with the same filename, choose File > Save. You have completed this 
procedure.

• To save a new project, choose File > Save and go to Step 2. 

• To save an existing project with a different filename, choose File > Save As and go to Step 2.

Step 2 In the Save Project dialog box, navigate to the desired directory and type the filename. Click Save. 
Cisco TransportPlanner saves projects as zipped files with the MPZ extension.

2.1.4 Importing a Cisco TransportPlanner Release 2.5 Project
Use the following procedure to import a Cisco TransportPlanner Release 2.5 project:

Step 1 From the File menu, choose Import 2.5.x project. 

Step 2 In the Open Project dialog box, navigate to the desired directory and choose the project. 
Cisco TransportPlanner Release 2.5 projects have a file extension of CMZ. 

Step 3 Click Open. The Import R2.5-Project-Name dialog box appears (Figure 2-5).
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Figure 2-5 Import <R2.5 Project Name> Dialog Box

Step 4 Choose one of the following:

• Import only inputs—Choose this option to import all of the Cisco TransportPlanner 2.5x project 
input data. The Cisco TransportPlanner 7.0x will define service aggregation, routing of services, 
amplifiers, and dispersion compensation units (DCU) during network analysis. 

• Import outputs as forcings—Choose this option to import all of the Cisco TransportPlanner 2.5x 
input and output data with the exception of the optical results and installation parameters. When you 
run the network analyzer in Cisco TransportPlanner 7.0x, it does not change the imported output 
data parameters; the network analyzer treats these imported values as forced parameters. 

Step 5 In the Target System Release area, choose the desired release: Release 4.7, Release 5.0, Release 7.0.

Step 6 If you chose Import outputs as forcings, choose the desired outputs to import:

• Import OADM units

• Import Amplifier units and parameter

• Import traffic constraints

• Import client SFP modules

• Generate aggregation groups

Step 7 Click OK. The Cisco TransportPlanner Release 2.5 project appears.
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2.1.5 Closing a Project
Use the following procedure to close a Cisco TransportPlanner project:

Step 1 From the File menu, choose Close. 

Step 2 In the Save Project dialog box, click Yes to save or No to close without saving changes. 

Step 3 If you clicked Yes and have not previously save the project, the Save Project dialog box appear. Type the 
name of the project and click Save. The project closes. 

Step 4 To exit Cisco TransportPlanner, choose Exit from the File menu.

2.2 Setting Cisco TransportPlanner Options
Cisco TransportPlanner provides numerous options for customizing the tool and the design.

Note The following procedures for setting options using the Tools menu apply to new projects during project 
creation. To change an existing (open) project, click the desired item in the Project Explorer pane 
Subnets folder and edit the parameter in the Properties pane.

2.2.1 Setting the Graphical Display
Use the following procedure to set the Cisco TransportPlanner graphical display:

Step 1 From the Tools menu, choose Options. 

Step 2 In the Options Explorer dialog box (Figure 2-6), right-click the Graphic folder and choose Expand from 
the shortcut menu.
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Figure 2-6 Options Explorer Dialog Box 

Step 3 To change the color scheme for Cisco TransportPlanner, click Look & Feel and choose the desired 
scheme from the drop-down list. 

Step 4 To change the appearance of the Project Explorer tree, click Project Explorer and complete the 
following as needed:

• Overlapping—Check to reorder sites for a selected network.

• Alarm Mode—Choose Single for an alarm icon to report only the condition of that item or 
Cumulated for an alarm icon to summarize the most critical alarm of the item and its children. 

• Bottom Right Icon—(Display only) Displays Locking to indicate that the lock icon appears at the 
bottom right of each locked item in the Project Explorer. 

• Top Right Icon—(Display only) Displays Alarm to indicate that the alarm icon appears at the top 
right of each alarmed item in the Project Explorer. The alarm icon will be green, yellow, orange, or 
red to indicate the alarm severity.

Step 5 To change the NtView Name tab appearance, click Network View and complete the following as needed:

• In the Site area, complete the following:

– Color, Selection Color, and Highlight Color—To change the site colors, click in the Color, 
Selection Color, and/or Highlight Color fields in the Site list. Click on the drop-down arrow to 
display a color swatch popup window. Click the desired color.

– Show Name—Check to display the site name on the NtView Name tab.

– Show Amplifiers—Check to display the amplifier icon for a site on the NtView Name tab.

• In the Fiber area, complete the following, as needed. Figure 2-7 shows an example of a duct with all 
of the following details shown.
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– Color and Selection Color—To change the fiber color, click in the Color and/or Selection Color 
fields in the Fibre list and then click the drop-down arrow. 

– Show Spans—Check to display fiber spans on the NtView Name tab.

– Show Length—Check to display fiber length on the NtView Name tab.

– Show total SOL Loss—Check to display start of life (SOL) loss on the NtView Name tab.

– Show total EOL Loss—Check to display end of life (EOL) loss on the NtView Name tab.

– Show CD C-band—Check to display C-band chromatic dispersion (CD) on the NtView Name 
tab.

– Show CD L-band—Check to display L-band chromatic dispersion (CD) on the NtView Name 
tab.

• To change the color of the traffic demands on the NtView Name tab, in the Point To Point, P-Ring, 
and Any To Any areas click in the Color and Selection Color fields, and then click on the drop-down 
arrow to display a color swatch popup window. Click the desired color.

Figure 2-7 Duct Details Shown on the NtView Name Tab

Step 6 To change the Network Mgmt Tree tab appearance, complete the following as needed:

• In the Network area, click in the Color and Selection fields. Click the drop-down arrow to display a 
color swatch popup window. Click the desired color.

• In the Link area, complete the following:

– To change the link color, click the Color field in the Link list and then click the drop-down 
arrow. Choose the desired line width from the drop-down list.

– To change the link appearance, click the Stroke field in the Link list and then click the 
drop-down arrow. Choose the desired line appearance from the drop-down list.

Step 7 Click Ok.

2.2.2 Setting the Default Platform Values
Use the following procedure to establish the default traffic mapping, dense wavelength division 
multiplexing (DWDM) design, and default layout settings for a particular platform and system release. 
The default settings will appear during project creation. All the options that you specify can be changed 
after project creation on a per span basis.

Step 1 From the Tools menu, choose Options. 

Step 2 In the Options Explorer dialog box (Figure 2-6), right-click Platform and choose Expand from the 
shortcut menu.

Step 3 Click the desired System Release folder and complete the following as needed:
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Note Default changes apply only to the specified system release.

• For software R8.5, choose the desired settings in the General area:

– Shelf Management—The options available are Multi Shelf Integrated Switch, Multi Shelf 
External Switch, and Individual Shelf. These options allow you to specify the type of 
management to be used for the sites on the network. 
Select Multi Shelf Integrated Switch to configure all the Multi Service Transport Platform 
(MSTP) optical units (OADMs and amplifiers) in different shelves connected together through 
a LAN. The LAN is implemented with switches plugged into the MSTP shelves. 
Select Multi Shelf External Switch to configure all the MSTP optical units (OADMs and 
amplifiers) in different shelves connected together through a LAN. The LAN is implemented 
with switches external to the MSTP shelves. 
Select Individual Shelf to configure all the MSTP optical units (OADMs and amplifiers) in the 
same shelf.

– Node Protection—The options available are Same Shelf and Separated Shelves. 
Select Same Shelf to configure the optical units (amplifiers and OADM) facing the east side 
(CW direction) and west side (CCW direction) in the same shelf. 
Select Separated Shelves to configure the optical units (Amplifiers and OADM) facing the east 
side (CW direction) in one shelf and those facing the west side (CCW direction) in a second 
shelf. 

– C-band Rules—Select the options from the drop-down. The options appear in the following 
format: C 64Chs 50Ghz(+2dBm/Ch). The channels available are 80, 72, 64, 40, 32, 20, 16, and 
8; the reference per channel power options available are -1 dBm, -2 dBm, 1 dBm, 2 dBm, 4 
dBm, 5 dBm, 7 dBm and 8 dBm; and the spacing options available are 100GHz or 50GHz.

– L-band Rules— Select the options from the drop-down. The options appear in the following format: 
32 Ch. 100Ghz +5dBm. The options available are: None, Expand, and channels available are 32; 
the reference per channel power options available are 2 dBm and 5 dBm; and the only spacing 
options available is 100GHz. 
Select Expand to indicate that the L-band rules as upgradable.

– Installation w/o M/P—Check this box to install network with default parameters. If this option 
is selected, Cisco TransportPlanner will design the network according to set of predefined 
conditions, so that the selected node can be installed without the Cisco TransportPlanner 
configuration files (thresholds and setpoints). 

– Dithering Lower Limit—Enter a value that satisfies the following conditions:

• Not lower than zero

• Not higher than 32

• Not higher than the dithering upper limit value

– Dithering Upper Limit—Enter a value that is not lower than zero and not higher than 32.

Note CTP uses dithering value as site identifier to adjust power on 40-WXC-C cards. CTP 
displays these parameters only for sites equipped with 40-WXC-C cards, that is, for sites 
with multi-degree site structure and with the functionality OXC or Auto. CTP does not 
display these parameters for non-OXC sites.

• For Software R7.0, choose the following in the General area:

– C-Band or L-Band as the default band.
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– Scalable C/L—(System Release 7.0 only) Check to set scalable C bands and L bands as the 
default setting during project creation. If checked, the design will be scalable to support both 
C-band and L-band on the same system.

– Scalable C/50GHz—(System Release 7.0 only) Check to set scalable C-band 50 GHz as the 
default setting during project creation. If checked, the design will be scalable to support 50-Ghz 
channel spacing in C-band.

– Shelf Management—The options available are Multi Shelf Integrated Switch, Multi Shelf 
External Switch, and Individual Shelf. These options allow you to specify the management to 
be used for the sites of the network. 
Select Multi Shelf Integrated Switch to configure all the MSTP optical units (OADMs and 
amplifiers) in different shelves connected together through a LAN. The LAN is implemented 
with switches plugged into the MSTP shelves. 
Select Multi Shelf External Switch to configure all the MSTP optical units (OADMs and 
amplifiers) in different shelves connected together through a LAN. The LAN is implemented 
with switches external to the MSTP shelves. 
Select Individual Shelf to configure all the MSTP optical units (OADMs and amplifiers) in the 
same shelf.

– Node Protection—The options available are Same Shelf and Separated Shelves. 
Select Same Shelf to configure the optical units (Amplifiers and OADM) facing the east side 
(CW direction) and west side (CCW direction) in the same shelf. 
Select Separated Shelves to configure the optical units (Amplifiers and OADM) facing the East 
side (CW direction) in one shelf and those facing the west side (CCW direction) in a second 
shelf.

Step 4 Click the Restricted List folder. To restrict a card, check the check box in the Restricted column for that 
card. 

To change the setting back to unrestricted, uncheck the check box.To apply restricted list changes to an 
open project, complete the following:

a. Right-click the folder for the network that you want to update and choose Expand from the shortcut 
menu.

b. Right-click the desired platform and release folder under RestrictedEqptListFolder in the Project 
Explorer and choose Edit List from the shortcut menu. The Restricted Equipment list for MSTP 454 
DWDM[Release Number] dialog box appears.

c. Click Update.

d. Click Ok to close the dialog box.

Step 5 Enter the Fiber Options details. 

• Span Label Tag—Enter the desired span label; the default label is Duct.

• Span Length—Enter the span length. The displayed unit of measure is retrieved from the 
Span Measurements Units field.

• EOL Ageing loss [dB]—Enter the EOL aging loss value. The EOL loss-per-span value is added at 
the end of life to each discrete fiber in the network (for example, to add an EOL margin for splicing).

• EOL Ageing Factor—Enter the number to use when factoring fiber aging. This factor is multiplied 
by the SOL total span loss without connectors. 

Note Enter a value in either EOL Ageing Factor or EOL Ageing loss; you do not need to enter a 
value in both fields.
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• Connector loss [dB]—Enter the concentrated loss at the end of the span.

• Length Based Loss—If checked, the fiber loss is determined by multiplying the Span Length by the 
Loss Factor. If the check box is not checked, you must enter the total loss of the span.

• Tot SOL loss w/o conn [dB]—Enter the start of life link fiber loss for each span, without the 
connector concentrated loss. The total SOL loss without connectors is equal to the loss factor 
multiplied by the length. In the Length Based model, this value is calculated automatically.

• DCN Extension (With Software R8.5 Only)—Click the check box to enable the default use of data 
connection network (DCN) extension on each span in the project. This implies that the OSC channel 
is not used to connect the two nodes. This default can be overridden on the network wizard pane. 

Note Use one of the following formulas to calculate the fiber loss at SOL: 
SOL = km * dB/km + (2 * connector loss)
SOL = user entered loss + (2 * connector loss)
Use one of the following formulas to calculate the fiber loss at EOL: 
EOL = km * dB/km * EOL Aging Factor + (2 * connector loss) + EOL Aging Loss, or 
EOL = user entered loss * EOL Aging Factor + (2 * connector loss) + EOL Aging Loss

• Select the Fiber Type of each span of the network. You can specify a fiber type even if the fiber type 
is not supported for the design.

Step 6 Click the Traffic Mapping folder and complete the following as needed.

• In the Fixed traffic area, choose the unprotected routing strategy from the drop-down list: 

– Auto

– Unprotected optimum optical path—Each node pair is connected using one connection. The 
unprotected optimum optical path minimizes the number of required optical amplifiers.

– Unprotected minimum hop count—Each node pair in the traffic group is connected by one 
connection. The unprotected minimum hop count minimizes the number of channels (for 
unprotected traffic types only) that can be deployed among the nodes of the traffic group.

Step 7 Select the C-band and L-band rules.

• C-band Rules—Select the options from the drop-down. The options appear in the following format: 
C 64Chs 50Ghz(+2dBm/Ch). The channels available are 80, 72, 64, 40, 32, 20, 16, and 8; the 
reference per channel power options available are -1 dBm, -2 dBm, 1 dBm, 2 dBm, 4 dBm, 5 dBm, 
7 dBm and 8 dBm; and the spacing options available are: 100GHz or 50GHz.

• For L-band Rules— Select the options from the drop-down. The options appear in the following format: 
32 Ch. 100Ghz +5dBm. The options available are: None, Expand, and channels available are 32; the 
reference per channel power available are 2 dBm and 5 dBm; and the spacing options available is 
100GHz. 
Select Expand to indicate the L-band rules as upgradable.

Step 8 Click the DWDM Design Rules folder and complete the following as needed:

• No Tilt Design—Check to force Cisco TransportPlanner to operate the amplifiers inside the gain 
range where no tilt is generated and to determine the type and number of amplifiers in each site of 
the network accordingly. This option sets all the intermediary points of the network so that channels 
are always at the reference power level. Default value is Disabled.

Note Long spans (with insertion loss greater than 25 dB) might not be supportable.
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• No In-line Bulk Attenuator Design—Check to design the network without using any inline bulk 
attenuators. In case the network cannot be designed without using external in-line attenuators, 
Cisco TransportPlanner displays the following error message: “Unfeasible Network design. Site X 
should require usage of in-line attenuator. Leave unchecked to allow inline bulk attentuators.”

• No TXT/Line-Card Bulk Attenuator Design—Check to design the network without using any 
external receive (Rx) bulk attenuators on transponder or line cards. If any of the clients require Rx 
bulk attenuators, then the related channel is shown with the working condition (flagged red, orange, 
or yellow). No Rx bulk attenuator will be shown in any of the reports (such as Optical Channel 
Results, Internal Connections, or BoM). Leave unchecked to allow bulk attenuators.

• Prevent Use of E-LEAF Dispersion—Check to prevent Cisco TransportPlanner from using E-LEAF 
dispersion compensation units (DCUs) on E-LEAF spans for the overall network. Leave unchecked 
if you want the algorithm to automatically optimize the usage of the E-LEAF DCUs.

• OSNR Alarm For Regeneration—This option allows you to define the optical signal-to-noise ratio 
(OSNR) alarm severity. When this limit is reached, Cisco TransportPlanner suggests channel at an 
appropriate site on the network. After the network is designed and analyzed, in the Tasks pane 
(under Reports), click Optical Results to see if any site requires regeneration. The regeneration 
column will suggest the site where Regeneration is required. 

• Turbo Simplex—Check to achieve faster results by optimizing a subset of the total channels based 
on type and path rather than optimizing each and every channel. Deselecting can result in longer 
analysis times for large networks, especially with Any-to-Any ROADM traffic. 

• Max Sc Value—This option allows you to enter the maximum slope compensation value. 

Step 9 To define the shelf configuration parameters, click the Layout folder and complete the following:

• Osmine Compliant—Check to instruct Cisco TransportPlanner to ensure that all the sites placing 
Transponder and Line Cards are compliant with OSMINE. 

• Hybrid Node—Check to instruct Cisco TransportPlanner to ensure that cross-connect, SDH, and 
SONET cards not placed within the optical transport section (OTS) shelf. 

• Max Number of Shelves—This option allows you to specify the maximum number of shelves per 
rack. Default is Auto and the maximum number of shelves you can specify is 4. 

• AIC—Select Yes to instruct Cisco TransportPlanner to put the AIC card in Slot 9 of the first shelf 
in each site.

• FiberStorage—Select Yes to instruct Cisco TransportPlanner to put the fiber storage within the rack 
below the optical shelf.

• Y-Cable—The options available are Auto, 1RU FlexLayer Shelf Assembly, and 2RU Y-Cable Panel.

– Auto—Instructs Cisco TransportPlanner to set the default value for the Y-Cable option.

– 1RU FlexLayer Shelf Assembly—Instructs Cisco TransportPlanner to use the ONS 15216 
Splitter/Combiner Flex Layer modules to implement the required Y-cable protections.

– 2RU Y-Cable Panel—Instructs Cisco TransportPlanner to use the new ADC Splitter/Combiner 
modules to implement the required Y-cable protections. 

• FanTry—(Software R8.5 only) Instructs Cisco TransportPlanner to put the type of fan tray within 
each node. Options available are: FTA-3-T or FTA 4-T.

• DCC Shelves Management—Check to instruct Cisco TransportPlanner to reserve Slot 12 for 
equipping 15454-MR-L1 unit to implement data communication channel (DCC) Shelves 
Management.

Step 10 Click OK.
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2.2.3 Setting the Default Project Values
Use the following procedure to set the default project settings and repair time. These defaults will appear 
during project creation.

Step 1 From the Tools menu, choose Options. 

Step 2 In the Options Explorer dialog box (Figure 2-6 on page 2-7), click Project and complete the following 
to set the defaults that appear in the Project Creation wizard:

• Customer—Enter the default customer name (128 character maximum).

• Created by—Enter the default user name (128 character maximum).

• Units—Choose the desired default span length unit of measure from the drop-down list, either Km 
or Miles.

• Price List—Choose the desired default price list.

• Layout—Choose either ANSI (American National Standards Institute) or ETSI (European 
Telecommunications Standards Institute) from the drop-down list. 

Step 3 Click General and complete the following:

• MTTR (hours)—Enter the mean time to repair (MTTR) for all sites in the network. This will apply 
to every site in the network. If you change the MTTR value after creating sites, the new value will 
only apply to sites you create after the change.

• Restocking Time (days)—Enter the number of days required (including transportation time) to 
restock the units into the maintenance center.

• Confidence Level (%)—Choose the confidence level for finding the spare units in the maintenance 
center (50, 75, 95, or 99 percent).

Step 4 Click Ok.

2.2.4 Defining Third-Party DWDM Interfaces
Cisco TransportPlanner allows you to define a third-party DWDM interface to be used in project 
creation. After you define third-party DWDM interfaces, you can choose them when creating traffic 
demands. For more information on defining third-party interfaces, see Appendix D, “Third-Party 
DWDM Wavelength Interface Model”. 

Note If you create a network design with a third-party interface and need to share the design with other users, 
you must provide not only the saved network MPZ file but also the exported database file containing the 
third-party interface definition. To view this project, the other user first must import the database with 
the third-party interface values. 

Use the following procedure to define a third-party DWDM interface:

Step 1 Click Tools > DB Parts Mgmt. The DB Parts Manager dialog box appears.
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Note You cannot open the DB Parts Manager if a project is open or if you are using the Base Network 
Designer profile.

Step 2 Right-click Platform Parts and choose Expand from the shortcut menu. 

Step 3 Right-click Group and choose New Group from the shortcut menu. The new group appears under Group 
and in each system release under parts DB. 

Step 4 In the Group Editor dialog box, complete the following:

• Name of group—Enter the name of the new database.

• Note—(Optional) Enter a description of the group.

Step 5 In the parts DB for the desired system release, click the group that you created.

Step 6 In the Parts tab of the DB Parts Manager dialog box, right-click and choose Client and then Alien from 
the shortcut menu. A new row appears on the Parts tab for the client hardware. 

Step 7 Double-click the row to open the Alien dialog box (Figure 2-8). 

Figure 2-8 Alien Card Dialog Box
 

Step 8 In the General tab of the Alien dialog box, type the name of the card in the Name field and the enter the 
Label name. 

Step 9 Click the Istance tab and complete the following:

• Ansi PID—Enter the product identifier of the ANSI system, as needed. If you select BoM visible 
for this third-party interface with ANSI PID completed, the third-party interface is included in the 
BoM with the related product identifier.
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• Etsi PID—Enter the product identifier of the ETSI system, as needed. If you select BoM visible for 
this third-party interface with ETSI PID completed, the third-party interface is included in the BoM 
with the related product identifier.

• TAG—(Display only) For internal use.

• SYS. NAME ANSI—Not applicable for third-party interfaces.

• SYS. NAME ETSI—Not applicable for third-party interfaces.

• WL START—Choose the wavelength starting range that the third-party interface supports from the 
drop-down list.

• WL END—Choose the wavelength ending range that the third-party interface supports from the 
drop-down list.

Step 10 Click the Physical Ports tab and in the Label column, type a label for each port. 

The CTC Ports and TL1 Ports tabs are not applicable for third-party interfaces.

Step 11 Click Ok.

Step 12 In the Parts tab of the DB Parts Manager dialog box, right-click and choose Software and then Alien 
from the shortcut menu. A new row appears on the Parts tab for the client software. 

Step 13 Double-click the row to open the AlienSoft dialog box.

Step 14 In the General tab, complete the following:

• Name—Type the name in the Name field.

• Related Item—Choose the client card that you created in Step 7 to Step 11.

Step 15 Click the Default - OCh tab (Figure 2-9).
2-15
Cisco TransportPlanner DWDM Operations Guide, Release 8.5

78-18129-01



 

Chapter 2      Designing Networks with Cisco TransportPlanner
Setting Cisco TransportPlanner Options
Figure 2-9 AlienSoft Dialog Box, Default-OCh Tab

Step 16 Complete the following (see Tables 2-1 through 2-3 for supported value combinations):

• In the Rules area, choose the C- or L-band design rule from the Design Rule drop-down list.

• In the Technology area, complete the following: 

– Modulation Format—Choose NRZ (Non Return to Zero) or Duo Binary. 

– Transmitter Type—Choose MZ (Mach Zehnder), DML (Direct Modulated Laser), or 
EML (Electro-absorption Modulated Laser).

– Receiver Threshold—Choose Optimal (minimum BER) or Average (average received power).

– Regeneration Type—Choose 3R or 2R regeneration mode.

– FEC Mode—Choose FEC (Forward Error Correction), no FEC, or E-FEC (Enhanced FEC).

– Transmitter Stability—Choose the maximum wavelength error allowed (pm). The values are 
12.5, 25, 50, or 100 pm.

• Bit Rate—Choose the desired bit rate from the drop-down list.

• In the TX Power Range area, complete the following:

– TX Max Power—Enter the maximum power output level (dBm).

– TX Min Power—Enter the minimum power output level (dBm).

• In the Back to Back Receiver Sensitivity area, complete the following as needed to define the 
working interface area for Back to Back. Back to Back is a configuration where the receiver is placed 
in front of the transmitter and no other equipment exists between the two. Back to Back is used to 
measure characteristics of the TX and RX pair. Figure 2-10 shows the interface operative area.
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– Overload Power [ps/nm]—Enter the overload power level.

– OL_Power [dBm]—Enter the minimum power level in the OSNR-limited range.

– OL_OSNR [dB] on 0.5 nm RBW—Enter the minimum OSNR level in the OSNR-limited range 
(measured in 0.5 increments).

– PL_Power [dBm]—Enter the minimum power level in the power-limited range.

– PL_OSNR [dB] on 0.5 nm RBW—Enter the minimum power level in the OSNR-limited range 
(measured on 0.5 nm bandwidth).

• In the Chromatic Dispersion area, complete the following as needed:

– Customize CD Robustness—Check to enable the CD Robustness field, as needed. Chromatic 
dispersion (CD) refers to the broadening of a light pulse after traveling a distance in the fiber.

– CD Robustness [ps/(nm*km)]—If Customize CD Robustness is checked, choose the maximum 
positive dispersion, Dmax_pos [ps/(nm*km)], tolerable by the interface: 0dB, 1dB, 1.5dB, 2dB, 
or 3dB.

• Customize Penalties—Check to enable the Gaussian cross-talk Penalties, Single-Interfering 
Cross-Talk Penalties, and Scale Q factors fields as needed.

• If Customize Penalties is checked, enter the values to determine the Gaussian cross-talk Penalties in 
the A_GXt and B_GXt fields, as needed. Gaussian cross talk refers to random power that interferes 
with a signal. The A_GXt and B_GXt values are the coefficients for the exponential curves that 
estimate P-penalty (PL), P-penalty (OL), OSNR-penalty (PL), and OSNR-penalty (OL) for 
Gaussion cross-talk levels in the OL and PL regions of the interface model with dispersion margins 
added (see Figure 2-10). The formula is Penalty (GXt) = A_GXt * exp(B_GXt *GXt). 

• If Customize Penalties is checked, enter the values to determine the Single-Interfering Cross-Talk 
Penalties in the A_SIXt and B_SIXt fields, as needed. Single-interfering cross talk refers to 
interference caused by a single signal. The A_SIXt and B_SIXt values are the coefficients for the 
exponential curves that estimate P-penalty (PL), P-penalty (OL), OSNR-penalty (PL), and 
OSNR-penalty (OL) for single-interfering cross-talk in the OL and PL regions of the interface model 
with dispersion margins added (see Figure 2-10). The formula is Penalty (IXt) = A_SIXt* 
exp(B_SIXt* IXt).

• If Customize Penalties is checked, enter Scale Q values in the F-P(PL), F-P(OL), F-OSNR(PL), and 
F-OSNR(OL) fields, as needed. The scale factors measure how efficient a card is in recovering the 
signal distortion. The slope of the Q-factor curve versus OSNR or RX power determines how a BER 
increase could be recovered with an increase of OSNR, power, or both (depending in which 
OSNR/power working point the card is). In general, the scale factors are two values (one in OSNR 
and one in power) for each working point OL and PL of the interface model (see Figure 2-10). The 
the F-P(PL), F-P(OL), F-OSNR(PL), and F-OSNR(OL) values translate a Q-penalty (that is, a BER 
increase) into power and OSNR penalties. The formulas follow:

– P-penalty(PL) = Q-penalty * F-P(PL)

– P-penalty(OL) = Q-penalty * F-P(OL)

– OSNR-penalty(PL) = Q-penalty * F-OSNR(PL)

– OSNR-penalty(OL) = Q-penalty * F-OSNR(OL) 

F-P(PL) and F-OSNR(PL) are evaluated in the PL working region, while F-P(OL) and F-OSNR(OL) 
are evaluated in the OL working region of the curve with the dispersion margins added. 
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Figure 2-10 Interface Operative Area

Step 17 Click Ok. 

Table 2-1 lists the supported combinations for 40-Gbps third party interfaces.

Table 2-2 lists the supported combinations for 10-Gbps third party interfaces.
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Table 2-1 Supported Combination for 40-Gbps Third-Party Interface

Modulation 
Format TX Type

RX 
Threshold FEC

TX 
Stability 
[pm]

Chromatic Dispersion Penalties [dBm]

P-penalty 
(OL)

OSNR-
penalty (OL)

P-penalty 
(PL)

OSNR-
penalty (PL)

Duo Binary MZ Optimal E-FEC ± 12 0 1 0 1

Table 2-2 Supported Combinations for 10-Gbps Third-Party Interface

Modulation 
Format TX Type

RX 
Threshold FEC

TX 
Stability 
[pm]

Chromatic Dispersion Penalties [dBm]

P-penalty
(OL)

OSNR-
penalty (OL) P-penalty(PL)

OSNR-
penalty (PL)

NRZ MZ Optimal E-FEC ± 25 0 2 1 0

NRZ MZ Optimal FEC ± 25 0 1.5 1 0

NRZ MZ Average no FEC ± 25 2 0 2 0

NRZ EML Average no FEC ± 100 0 3 3 0
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Table 2-3 lists the supported combinations for 2.5-Gbps third party interfaces.

2.2.5 Exporting a File
Use the following procedure to export user options, price lists, maintenance contracts, and the parts 
database files. The export command creates a ZIP file that includes all of the created files.

Step 1 From the Tools menu, choose Export. The Export dialog box appears (Figure 2-11).

Figure 2-11 Export Dialog Box

Table 2-3 Supported Combinations for 2.5-Gbps Third-Party Interface

Modulation 
Format TX Type

RX 
Threshold FEC

TX 
Stability 
[pm]

Chromatic Dispersion Penalties [dBm]

P-penalty 
(OL)

OSNR-
penalty (OL)

P-penalty 
(PL)

OSNR-
penalty (PL)

NRZ DML Average FEC ± 25 0 2 2 0

NRZ DML Average no FEC ± 25 0 2 2 0

NRZ DML Average no FEC ± 25 3 0 3 0

NRZ DML Average no FEC ± 25 3 3 3 3

NRZ EML Average no FEC ± 25 0 2 2 0

NRZ DML Average no FEC ± 100 0 3 3 0
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Step 2 In the Export dialog box, enter a file path and name in the file name field. To export to an existing file, 
click the ... button and navigate to the desired directory and file. Click Select to choose the file. 

Step 3 To select the items to export, complete the following as needed:

• User Option—Check to export the user options set using the Tools > Options command. 

• PartsDB—Check the desired platforms. 

• PriceDB—Check All Price DB to export all price lists, or expand All Price DB and check the 
individual price lists that you want to export.

Step 4 Click Ok. 

2.2.6 Importing a File
Use the following procedure to import user options, price lists, maintenance contracts, and the parts 
database files. You can import a ZIP file of multiple exported items or an individual TXT file.

Step 1 From the Tools menu, choose Import. The Import dialog box appears (Figure 2-12).

Figure 2-12 Import Dialog Box

Step 2 In the Import dialog box, click the ... button and navigate to the desired directory and file. Click Select 
to choose the file to import.

Step 3 Click load. 

Step 4 If you selected a single TXT file, skip this step and go to Step 5. If you selected a ZIP file with multiple 
exported options, complete the following as needed:
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• User Option—Leave checked to import a file with the user options that were set with the Tools > 
Options command.

• PartsDB—Leave checked to import the parts database for the desired platform. 

• PriceDB—Leave All Price DB checked to import all price lists, or uncheck and check the desired 
individual price lists.

Step 5 Click OK. 

Step 6 In the confirmation dialog box, click OK. 

2.2.7 Resetting the Default Layout
Your graphical layout settings are saved when you exit Cisco TransportPlanner. The next time that you 
launch Cisco TransportPlanner, the layout appears as it did upon exiting. The default graphical layout 
includes items such as whether the panes are visible and/or docked.

To return to the Cisco TransportPlanner default layout, choose Default Layout from the View menu. To 
restore the user modified layout, choose My Default View from the View menu. 

2.2.8 Adding Plug-ins
Use the following procedure to add plug-ins to Cisco TransportPlanner. Plug-ins are released separately 
from Cisco TransportPlanner by Cisco Systems. Using plug-ins, you can customize the released version 
of Cisco TransportPlanner. 

Step 1 Copy the plug-in file into the Documents and Settings\username\Desktop\CTP_8.5.0\plugins folder.

Step 2 From the File menu, choose Exit, then click Yes or No to save the existing project. 

Step 3 Launch Cisco TransportPlanner. For more information, see the “2.1 Launching 
Cisco TransportPlanner” section on page 2-1.

Step 4 Choose Tools > Plug-In > View Plugin registry. The PlugIn Registry dialog box appears (Figure 2-13).
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Figure 2-13 PlugIn Registry Dialog Box

Step 5 In the PlugIn Tree, right-click the new plug-in folder and choose Expand from the shortcut menu.

Step 6 Two categories of plug-in are defined in the tool:

• Plug-in that cannot be deactivated-These plug-ins have the parameter “Can be deactivated = 
FALSE”. They are loaded at Cisco TransportPlanner startup and no action is available.

• Plug-in that can be deactivated - These plug-ins have the parameter “Can be deactivated = TRUE.” 
These plug-ins support two additional parameters:

– Can be suspended—When set to TRUE, an additional action on the plug-in allows you suspend 
or resume the plug-in within the current Cisco TransportPlanner running session.

– Can be stopped—When set to TRUE, the user decides if the plug-in will or will not run the next 
time Cisco TransportPlanner is started.

Step 7 Click the plug-in and set the desired action—Deactive, suspended, or stopped. 

Step 8 Close Cisco TransportPlanner and restart. The plug-in action set in the procedure to takes affect.

2.2.9 Managing Plug-ins
Use the following procedure to view and manage plug-ins. For information about adding plug-ins, see 
“2.2.8 Adding Plug-ins” section on page 2-21.

Step 1 Choose Tools > Plug-In > View Plugin registry. The PlugIn Registry dialog box appears (Figure 2-13 
on page 2-22). 

Step 2 In the PlugIn Tree, right-click the plug-in folder and choose Expand from the shortcut menu. 
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Step 3 Click a plug-in to view information about it. The right pane of the PlugIn Registry dialog box displays 
the plug-in information.

• The General area of the PlugIn Registry dialog box identifies the following information:

– Name—(Display only) Displays the name of the plug-in.

– Path—(Display only) Displays the location of the plug-in.

– Version—(Display only) Displays the version of the plug-in.

– Provider—Displays the name of the supplier of the plug-in.

– Text—(Display only) Displays a brief description of the plug-in.

– Exclusion—(Display only) Displays the exclusion label. The exclusion attribute is a tag that 
defines an exclusion rule for a plugin. No more that one plugin with a given exclusion tag can 
be run at the same time.

• The State area of the PlugIn Registry dialog box identifies the plug-in current state and restrictions:

– Current State—(Display only) Identifies the state of the plug-in.

– Can be stopped—(Display only) If TRUE, you can disable the plug-in during the current session 
of Cisco TransportPlanner. The plug-in will disappear from the File menu. To restart a plug-in 
that has been stopped, you must exit and relaunch Cisco TransportPlanner. If FALSE, you 
cannot stop the plug-in during an active Cisco TransportPlanner session. 

– Can be suspend—(Display only) If TRUE, you can disable the plug-in during the current session 
of Cisco TransportPlanner. The plug-in will disappear from the File menu. To restart a plug-in 
that has been suspended, you can choose Resume in the PlugIn Registry dialog box. It is not 
necessary to exit and relaunch Cisco TransportPlanner. If FALSE, you cannot suspend and 
resume this plug-in during an active Cisco TransportPlanner session.

• The Run Information area of the PlugIn Registry dialog box displays the Can be deactivated state. 
If TRUE, you can deactivate a plug-in but must exit and relaunch Cisco TransportPlanner for the 
deactivation to take effect. When you relaunch Cisco TransportPlanner, the plug-in will not appear 
in the File menu. If FALSE, you cannot deactivate this plug-in. 

Step 4 To disable or suspend a plug-in, right-click the plug-in and choose one of the following from the shortcut 
menu:

• Do not run at start—Choose to disable the plug-in the next time Cisco TransportPlanner is launched. 

• Suspend/Resume—Choose Suspend if you want to disable the plug-in immediately without 
restarting Cisco TransportPlanner. Choose Resume to enable a suspended plug-in.

Step 5 Click Ok.

Step 6 In the confirmation dialog box, click Ok. 

Step 7 If you chose Do not run at start, exit and relaunch Cisco TransportPlanner for the plug-in to be disabled.

2.2.10 Adding User Profiles
A user profile is a set of privileges used for running Cisco TransportPlanner. Each profile offers different 
capabilities. Cisco TransportPlanner is packaged with the Network Designer profile, but you can add 
other user profile types provided by Cisco. All the procedures in the Cisco TransportPlanner DWDM 
Operations Guide are written for users with Network Designer access.

Use the following procedure to add a user profile to Cisco TransportPlanner:
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Step 1 Close all open instances of Cisco TransportPlanner.

Step 2 Identify the directory where Cisco TransportPlanner is installed on your computer, see the 
“2.1 Launching Cisco TransportPlanner” section on page 2-1. 

Step 3 Create a profile folder; if profile folder already exists, go to Step 4. 

Step 4 Copy the profile JAR file provided by Cisco Systems into the profile folder. 

Step 5 Launch Cisco TransportPlanner. For more information, see the “2.1 Launching 
Cisco TransportPlanner” section on page 2-1. The new profile will appear in the Current Selected 
Profile drop-down list.

2.2.11 Running a Script
Use the following procedure to run a script. A script is a sequence of commands in a BSH file format 
that is used to provide additional Cisco TransportPlanner capabilities. Cisco provides valid scripts to 
help you customize your Cisco TransportPlanner software. 

Note You must have received a valid script from Cisco Systems before you can perform this procedure.

Step 1 From the Script menu, choose Run Script.

Step 2 In the Choose the script to run dialog box, click the desired script and click Open. The script runs.

Step 3 To run a script again, choose Run Again > script-name.

2.2.12 Refreshing the Script Menu
Common scripts, located in the Cisco TransportPlanner scripts directory, displayed in the Script > 
Common menu and can be run by any user. User scripts, located in the C:/Documents and 
Settings/user-home/CTP_version/scripts, are displayed in the Script> User menu. 

Any time you add or remove a script from one of these directories, you must choose Refresh Dirs so 
that the changes appear on the Script menu. The Remove Dirs command removes script names from the 
Script > Run Again menu and updates the Script > Common and User menus. 
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2.2.13 Understanding Sides Labeling
In Cisco TransportPlanner Software R8.5, the label for each supported site structure is different from the 
labels that have been used in the previous releases. Table 2-4 summarizes the labeling format of the sites 
in the previous releases and in Cisco Transport Planner Software R8.5.

2.3 Creating a Project
A project consists of a single network or multiple networks that you analyze and compare. In a project, 
you can have multiple copies of a single network with the same customer input data, but use different 
options in each to investigate multiple solutions. 

Use the following procedure to create a single network in a project. A new network is in the Design state. 
For more information about the different network states, see the “2.8 Managing the Network Design” 
section on page 2-120.

Note All options set by the Project Creation Wizard can be changed as needed, except Measurement Units and 
ANSI/ETSI, which can be changed.

Step 1 From the File menu, choose New. The Project Creation Wizard appears (Figure 2-14).

Table 2-4 Sides Labeling in Cisco Transport Planner Software R8.5 and in previous releases

Sites Labeling in Previous Releases
Labeling in Cisco Transport 
Planner Software R8.5

Terminal/Terminal+ Only one side is created and labeled, 
T.

Only A can be used for the 
existing side.

Line/Line+ Two sides are created and are 
labeled, West and East.

Only A and B can be used for the 
existing sides.

Multi-Degree with 
PP-MESH-4

— Only A, B, C, and D can be used 
for the existing sides.

Multi-Degree with 
PP-MESH-8

— Only label A, B, C, D, E, F, G, 
and H can be used for the 
existing sides.
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Figure 2-14 Project Creation Wizard 

Step 2 On the Project page, complete the following:

• Created By—Displays the user login name. You can edit this field (128 character maximum).

• Customer Name—Type the name of the customer (128 character maximum) requiring this network 
design. 

• Network Platform Layout—Choose ANSI (the North American standard) or ETSI (the international 
standard) from the drop-down list to indicate the platform type. ANSI networks will not allow you 
to define SDH (ETSI) service demands. ETSI networks will not allow you to define SONET (ANSI) 
service demands. 

• Span Measurement Units—Choose Km (kilometers) or Miles from the drop-down list to set the unit 
of measure used for span length.

• Price List—Choose the price list from the drop-down list. 

Step 3 Click Next.

Step 4 On the Platform page, check the desired platform and click Next.

Step 5 On the Release page, check the desired software release for the network design and click Next. The 
default is the latest release. This attribute defines the list of hardware parts that can be used in the design 
because they are supported in this release.

Step 6 On the Subnet page, complete the following (Figure 2-15):

• Traffic Mapping Algorithm Release 8.5—Check to select the ONS 15454 Software R8.5 version of 
the interface and the wavelength routing optimization algorithm to be used in the network design. 
Software R8.5 is backward compatible and can manage Software Releases 4.7, 5.0, 7.0, and 8.5.

• Design Design Rules Release 8.5—Check to select DWDM Design Rules Release 8.5.
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• Layout Release 8.5—Check to define the ONS 15454 Software R8.5 version of the algorithm used 
to generate the layout of each site within the subnetwork. Software R8.5 is backward compatible and 
can manage Software Releases 4.7, 5.0, 7.0, and 8.5.

Figure 2-15 Project Creation Wizard Subnet Page

Step 7 Click Next.

Step 8 Complete one of the following:

• To run the Network Creation wizard, check the Run the Network Wizard Now check box and click 
Finish. Continue with Step 9.

• To create an empty project to add sites and fibers manually, uncheck the Run the Network Wizard 
Now check box and click Finish. Project Creation wizard creates the project and an empty network 
and subnetwork under which you can manually add sites and fibers. Skip the remaining steps in this 
procedure. To add sites manually, see the “2.3.1 Adding Sites” section on page 2-34.

Step 9 In the Topology page of the Network Creation wizard (Figure 2-16), choose Ring or Linear from the 
Network-Topology drop-down list.

Step 10 To instruct Cisco TransportPlanner to automatically create a traffic subnet associated with the created 
network, check the Create Traffic Subnet check box. Cisco TransportPlanner creates (in addition to the 
Traffic_ALL), an additional traffic subnet (Traffic_Ring or Traffic_Linear), depending on the topology value 
you specify in the Network Creation wizard. 
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Figure 2-16 Network Creation Wizard Topology Page 

Step 11 Click Next. On the Configuration page, enter the number of sites in the Site Number field and click 
Next. The maximum number of sites per network design is 100 sites and the default is 3. The maximum 
number of locations where the optical service channel (OSC) can be terminated in a network is 40. The 
maximum number of Add/Drop locations (equipped with WSS, WXC, multiplexer/demultiplexer, or 
OADM cards traversed by an optical circuit is limited to 40.

Step 12 On the Sites Data page, select the topology for each site in the network Figure 2-17. Allowed values are:

Note The values allowed depend on the network topology selected in Step 9. The default site value for Ring 
Topology is Line. The default site value for Linear topology is Line, except for the two end sites which will 
be Terminal. Terminal and Terminal+ are not allowed for ring network topology or for linear network 
topology intermediate sites.

• Terminal—Site with one side facing one fiber span.

• Terminal +—Site with one side facing one fiber span that can provide multi-degree expansion 
capability through an MMU unit. 

• Line—Site with two sides facing two fiber span.

• Multi-degree—Nodes have more than two sides and face more than two fibre spans.

• Line + —Site with two sides facing two fiber spans that can provide multi-degree expansion 
capability through an MMU unit. 
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Figure 2-17 Network Creation Wizard- Site Data Page

Step 13 The Options page allows you to define C band and L band rules for the network design Figure 2-18.

• C-band rules—The C-band options appear in the following format: 80Ch. 50Ghz +1dBm. The 
channels available are 80, 72, 64, 40, 32, 20, 16, or 8; the reference per channel power options 
available are -1 dBm, +1 dBm, 2 dBm, -2dBm, +4dBm, 5 dBm, 7dBm and 8 dBm; and the spacing 
options available are 100GHz or 50GHz.

• L-band Rules— The L-band options appear in the following format: 32 Ch. 100Ghz +5dBm. The 
options available are: None, Expand, and channels available are 32; the reference per channel power 
available are 2 dBm and 5 dBm; and, the spacing options available is 100GHz.

Note If you use a Line+ or Multi-Degree site, you must select design rules based on 100 GHz channel spacing, 
and in the case of Line+, you must also select 32-channel rules. If these conditions are not met, 
Cisco TransportPlanner will provide an error message when you attempt to analyze the network. See 
Table 2-25 for additional details on site design rules.
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Figure 2-18 Network Creation Wizard Options Page

Step 14 On the Site page, complete the following (Figure 2-19):

• Shelf Management—Choose the shelf management configuration:

– Multi Shelf Integrated Switch—All the Multi Service Transport Platform (MSTP) optical cards 
(optical add/drop multiplexers [OADMs] and amplifiers) reside in different shelves connected 
by a LAN. The LAN is implemented with switches connected to the MSTP shelves. For this 
option, Multi-Shelf Integrated Switch Cards (MS-ISC) are used to support the multishelf 
configuration.

– Multi Shelf External Switch—All the MSTP optical cards (OADMs and amplifiers) reside in 
different shelves connected by a LAN. The LAN is implemented with switches external to the 
MSTP shelves (Cisco Catalyst 2950). For this option, two external Ethernet switch units are 
used to support the multishelf configuration.

– Individual Shelf—All the MSTP optical cards (OADMs and amplifiers) reside in the same shelf. 
For this option, multishelf management is not supported; every shelf is managed as an 
independent shelf.

• Node Protection—Choose Same Shelf (single shelf configurations) or Separated Shelves 
(multishelf configurations). Same Shelf configuration places all the OADM/ROADM units in a 
single shelf, and does not provide any protection at the shelf level in the node. Separated Shelves 
places OADM/ROADM units (west-facing and east-facing) in separate shelves in the node and it is 
selectable only if Multishelf management is selected. You can also set node protection for a 
multi-degree node. 

• Hybrid Site Config—Check to create all the nodes configured as hybrid MSTP/Multi Service 
Provisioning Platform (MSPP) nodes. Hybrid Node is only available if you chose Individual Shelf 
as the Shelf Management type.
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• OSMINE Compliant—Check this option to place the DWDM units in the shelves according to 
Operations Systems Modifications of Intelligent Network Elements (OSMINE) placement rules.

• DCC Chain—Check to put a TXP(P)_MR_2.5G card in Slot 12 on each shelf of each site to use 
DCC. 

• Max Shelves per Rack—Choose the maximum number (from 1 to 4) of ANSI or ETSI shelves 
(equipping optical cards or TXP/MXP cards) that can be placed in each rack in the site when 
generating the layout of the site. 

• Installation w/o M/P—Check this box to design a network that does not require the setup of 
configuration files (thresholds and setpoints). Installation without Cisco TransportPlanner is also 
known automatic node turn up. When this feature is enabled, the software in the node will configure 
itself with parameters; XML configuration files are not required to configure the node. When this 
option is selected at the end of EDFA and DCU placement, Cisco TransportPlanner will analyze the 
resulting network and verify that in each node, where the option “installation w/o Cisco 
TransportPlanner” is enabled, has:

– A preamplifier in each direction.

– All amplifiers working in gain control mode

– A flat node output spectrum; that is, the resulting channel tilt at the exit of the node is 0

– A feasible setpoint forced during simulation.

Figure 2-19 Network Creation Wizard Sites Page

Step 15 Click Next.

Step 16 On the Span page, complete the following (Figure 2-20):

• Span Label Tag—Enter the desired span label.
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• Span Fibre Type—Choose the fiber type for each span in the network.

• Span Length—Enter the span length. The displayed unit of measure is retrieved from the 
Span Measurements Units field.

• EOL Ageing Factor—Type the number to use when factoring fiber aging. This factor is multiplied 
by the SOL total span loss without connectors. 

• EOL Ageing loss [dB]—Type the EOL aging loss value. The EOL loss-per-span value is added at 
the end of life to each discrete fiber in the network (for example, to add an EOL margin for splicing).

Note Enter a value in either EOL Ageing Factor or EOL Ageing loss; you do not need to enter a 
value in both fields. Use one of the following formulas to calculate the fiber loss at SOL: 
SOL = km * dB/km + (2 * connector loss)
SOL = user entered loss + (2 * connector loss)
Use one of the following formulas to calculate the fiber loss at EOL:
EOL = km * dB/km * EOL Aging Factor + (2 * connector loss) + EOL Aging Loss
EOL = user entered loss * EOL Aging Factor + (2 * connector loss) + EOL Aging Loss

• Connector loss [dB]—Type the concentrated loss at the end of the span.

• CD factor [ps/mn/km]—Type the fiber chromatic dispersion (CD) factor. The default value is 
dependent on the selected fiber type. Any value that you enter in this field is lost whenever you 
change the fiber type. Chromatic dispersion is always entered in ps/nm/km. Fiber chromatic 
dispersion is defined for the middle of the wavelength band. C-band is defined at 1545.3 nm; L-band 
is defined at 1590.4 nm.

• PMD factor [ps/sqrt(km)]—Type the polarization mode dispersion (PMD) factor. The default value 
is dependent on the selected fiber type. Any value that you enter in this field is lost whenever you 
change the fiber type. PMD is always entered per kilometers. 

• Length Based Loss—If checked, the fiber loss is determined by Span Length * Loss Factor. If the 
check box is not checked, you must enter the total loss of the span.

• Loss factor [dB/km]—Type the value of the SOL fiber loss per kilometer that is used to calculate 
the loss of each span in the network. The fiber loss factor is always entered in dB/km.

• Tot SOL loss w/o conn [dB]—Type the start of life link fiber loss for each span, without the 
connector concentrated loss. The total SOL loss without connectors is equal to the loss factor 
multiplied by the length. In the Length Based model, this value is calculated automatically.

• DCN extension—Click the check box to use DCN extensions on each of the spans in the network. 
This implies that the OSC channel is not used to connect the two nodes. All nodes facing a span with 
the DCN Extension option enabled require a ITU-T G.709 generic communications channel (GCC) 
access that must be provided by the customer.
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Figure 2-20 Network Creation Wizard Span Page 

Step 17 Click Finish. Cisco TransportPlanner checks the validity of the fiber factor values. If the fiber factor 
values are within the valid range (Table 2-5), Cisco TransportPlanner creates a visual representation of 
the network. If the values are out of range, Cisco TransportPlanner issues a warning, asking you to 
confirm the input values.

Note All options set by the Network Creation Wizard can be changed as needed per site and per span. 

Table 2-5 Valid Ranges for Fiber Factor Values

Fiber Type Parameter

Min. 
Error 
Value

Min. 
Warning 
Value

Default 
Value

Max. 
Warning 
Value

Max. 
Error 
Value Unit

ITU-T 
G.652-SMF

Loss factor 0 0.2 — 0.4 10 dB/km

Chromatic 
dispersion factor 
at 1545.3 nm 
(C-band)

0 16.2 16.7 17.1 30 ps/nm/km

Chromatic 
dispersion factor 
at 1590.4 nm 
(L-band)

0 18.53 19.03 19.43 30 ps/nm/km

PMD factor 0 0.0 0.1 0.5 10
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2.3.1 Adding Sites 
Use the following procedure to add new sites to an existing network. A site is a customer premise 
location where any equipment can be co-located in a rack within a building. Cisco TransportPlanner 
supports up to 100 sites in a network. The number of racks and nodes in a site is independent of number 
of number of sites in the network. The maximum number of locations where the OSC can be terminated 
in a network is 40. When the number of locations where the OSC is terminated exceeds the maximum 
supported value, the tool completes the design, but in the summary report there will be an alarm to indicate 
this situation. The maximum number of add/drop locations in a network is 40. The maximum number of 
Add/Drop locations (equipped with WSS, WXC, multiplexer/demultiplexer, or OADM) traversed by an 
optical circuit is limited to 40.

Note Every new site added to a design is automatically configured as Multi-Shelf Integrated Switch with Same 
Shelf protection. To change this, you can edit the site properties after adding it to the network design. 
See the “2.7.3 Editing Site Parameters” section on page 2-83.

Step 1 Right-click the network folder in the Project Explorer and choose Expand from the shortcut menu.

Step 2 Right-click the Sites folder and choose New Site from the shortcut menu. The Site Creation wizard 
appears (Figure 2-21). As an alternative, if sites already exist in the network design and you have the 
NtView Name tab open, click the Create a new site icon in the toolbar. For more information about the 
Cisco TransportPlanner icons, see Appendix A, “GUI Information and Shortcuts.”

Step 3 Choose the interface type:

• Line—Two pairs of fibers are terminated at the node.

ITU-T 
G.655-E-LEAF

Loss factor 0 0.2 — 0.4 10 dB/km

Chromatic 
dispersion factor 
at 1545.3 nm

0 3.4 3.80 4.2 10 ps/nm/km

PMD factor 0 0 0.1 0.5 10

ITU-T 
G.655-True 
Wave

Loss factor 0 0.2 — 0.4 10 dB/km

Chromatic 
dispersion factor 
at 1545.3 nm

0 3.8 4.19 4.6 10 ps/nm/km

PMD factor 0 0 0.1 0.5 10

ITU-T 
G.652-DS 
(Dispersion 
shifted)

Loss factor 0 0.2 — 0.4 10 dB/km

Chromatic 
dispersion factor 
at 1590.4 nm 
(L-band)

0 2.43 2.83 3.23 30 ps/nm/km

PMD factor 0 0 0.1 0.5 10

Table 2-5 Valid Ranges for Fiber Factor Values (continued)

Fiber Type Parameter

Min. 
Error 
Value

Min. 
Warning 
Value

Default 
Value

Max. 
Warning 
Value

Max. 
Error 
Value Unit
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• Terminal—A single pair of fibers is terminated at the node.

• Line+—Two pairs of fibers are terminated at the node but the number of fibers can be increased. An 
MMU card (topology upgrade) must be installed.

• Terminal+—A single pair of fibers is terminated at the node but the number of fibers can be 
increased. An MMU card (topology upgrade) must be installed.

• Multi-degree—Nodes have more than two sides and face more than two fibre spans.

Step 4 Click Finish.

Figure 2-21 Site Creation Wizard

2.3.2 Adding Fiber Spans
Use the following procedure to manually add fiber spans between sites. A fiber span consists of a pair 
of fibers (one transmit and one receive) between two sites. A span is represented by a fiber duct in the 
NetViewName tab. Within a fiber duct, more than one fiber pair can exist.

Note The number of fiber spans that each site can support is defined in the site properties. See the 
“2.3.1 Adding Sites” section on page 2-34 or the “2.7.3 Editing Site Parameters” section on page 2-83.

Step 1 In the NtView Name tab, click the Create a new duct icon in the toolbar. For more information about the 
Cisco TransportPlanner icons, see Appendix A, “GUI Information and Shortcuts.”
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Step 2 Click one of the sites that you want to connect with a fiber span. This site will be the source site for later 
network analysis output. 

Step 3 Click the destination site. A fiber span appears between the two sites. This site will be the destination 
site for later network analysis output. 

For the first span, the source site is set as A and the destination site is set as B. Cisco TransportPlanner 
automatically adjusts East and West for additional spans.

2.3.3 Creating Traffic Subnet

Step 1 In the Project Explorer tab, scroll down to Traffic Subnets. Right-click Traffic Subnets, and select 
Create.

The Traffic Subnet Creation wizard appears. See Figure 2-22.

Figure 2-22 Traffic Subnet Creation Wizard

Step 2 Select the Topology for the subnet from the drop-down list (Ring, Linear, and Mesh), then click Next.

Note If Ring or Linear topology is selected for the subnet, the spans in the subnet must be adjacent and also 
ordered. 

Step 3 Click Press to build new subnet. The Traffic Subnet Builder Wizard appears (Figure 2-23).

Step 4 Select the ducts that should be a part of the subnet from the list displayed on the left handside, and click 
OK. This takes you back to the Traffic Subnet Creation Wizard.
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Step 5 Click Finish to complete the creation of the traffic subnet. The created subnet appears in Project 
Explorer under Traffic Subnets.

Figure 2-23 Traffic Subnet Builder Wizard

2.3.4 Creating a Point-to-Point Demand
Use the following procedure to add a point-to-point traffic demand:

Step 1 In the NtView Name tab, click the Create a new P2P demand icon in the toolbar. For more information 
about the Cisco TransportPlanner icons, see Appendix A, “GUI Information and Shortcuts.”

Step 2 Click the source site of the demand. 

Step 3 Click the destination site of the demand. The Point to Point Demand Creation Wizard appears 
(Figure 2-24).

Step 4 From the drop-down list, select Traffic Subnet ALL or any of the previously created traffic subnets to 
which this service demand should be part of, and proceed to Step 5. If you wish to create a new traffic 
subnet see “2.3.3 Creating Traffic Subnet” section on page 2-36.

Step 5 Click Next.
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Figure 2-24 Point to Point Demand Creation Wizard 

Step 6 On the General Parameters page, complete the following:

• Label—Type the name of the demand.

• Source—(Display only) Displays the source site name.

• Destination—(Display only) Displays the destination site name.

• Service Type—Choose the service type from the drop-down list. For a list of services, see the 
“1.2.5 Service Support” section on page 1-4.

• Present # ch—Enter the number of channels to be created. The Forecast # ch field automatically 
updates with the number entered in this field.

• Forecast # ch—Enter the number of channels to be installed at a later date. This value includes the 
Present # ch value. For example, if you entered 4 in the Present # ch value and want to add two 
channels in the future, enter 6.

Step 7 Click Next.

Step 8 On the Platform Parameters page, complete the following:

• Protection—Choose the protection type from the drop-down list: Y-Cable Protected, Client 1+1, 
Fiber Switched, or Unprotected. For more information on protection types, see the 
“1.2.4 Protection Scheme Support” section on page 1-3.

• Path—(Unprotected only) Choose the routing type from the drop-down list:

– Auto—Allows the highest degree of flexibility in routing the channels. Cisco TransportPlanner 
routes the channels with the lowest possible cost, given the other constraints.

– A—Select this for a Terminal or a Terminal+ site. 

– A or B—Select either of these for a Line or a Line+ site.
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– A, B, C, or D—Select either of these for a Multi-Degree site if four ducts are connected.

– A, B, C, D, E, F, G, or H—Select either of these for a Multi-Degree site if eight ducts are 
connected.

• Optical Bypass—(Unprotected only) Choose the site where the channels for the current demand will 
be optically bypassed. A channel in optical bypass is dropped on one side of the node and added on 
the other side of the same node to allow the future use of that node as an add/drop location. 

Step 9 Complete the following fields in the Interface Parameters area. The options available are based on the 
service type selected in Step 6.

• Transponder—Click to expand, then check the card type check box to select the card at the end sites 
of the service channels.

• Line Card—Click to expand, then check the card type check box to select the card at the end sites 
of the service channels.

• Alien Card—Appears only if you created a third-party interface as described in the “2.2.4 Defining 
Third-Party DWDM Interfaces” section on page 2-13. Click to expand, and then check the card type 
check box to select the card at the end sites of the service channels.

• Pluggable Card—Click to expand, then check the card type check box to select the card at the end 
sites of the service channels.

Step 10 In the Client Interface area, define the client interface type (SR, IR, or LR) for the source and destination 
from the Source and Destination drop-down lists. This option is available for transponder and 
muxponder interfaces that have pluggable client interfaces, and depends on the selected service type and 
card type. 

Step 11 Click Finish. The Edit Point to Point Demand dialog box appears listing the present and forecast 
channels. 

The demand appears in the NtView Name tab and in the Project Explorer tree in the 
Service Demands > Point To Point folders. A demand is a solid line when selected and a dotted line when 
not selected. The line has a number above it that indicates the number of channels that are present. 
Figure 2-25 shows a selected point-to-point demand with five channels between Sites 1 and 2. 

Note To make changes to the demand parameters, see the “2.7.6 Editing a Point-to-Point Demand” section 
on page 2-91, or click Cancel to close the Edit Point to Point Demand dialog box. 

Figure 2-25 Point-to-Point Demand Between Two Sites 

Note For each network, Cisco TransportPlanner automatically creates a default subnet that exactly matches 
the overall network topology. This cannot be deleted. 

Step 12 Click the Traffic tab of the Net1 tab to view all the circuits that have been created. For more information, 
see “2.4 Viewing Circuits in a Network” section on page 2-51.
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2.3.5 Creating a Protected Ring Demand
Use the following procedure to create a P-ring traffic demand.

Step 1 Create a ring network using either the procedures in the “2.3 Creating a Project” section on page 2-25 
or by manually placing sites into a ring configuration.

Step 2 In the Native Net# tab, click the Create a new P-Ring demand icon in the toolbar. The P-Ring Creation 
Wizard appears (Figure 2-26). For more information about the Cisco TransportPlanner icons, see 
Appendix A, “GUI Information and Shortcuts.”

Figure 2-26 P-Ring Creation Wizard 

Step 3 For each network, the tool automatically creates, a default subnet that exactly matches the overall 
network topology. This cannot be deleted. From the drop-down list, select any previously created traffic 
subnet with a ring topology that this circuit should be part of and proceed to Step 4. If you wish to create 
a new traffic subnet see 2.3.3 Creating Traffic Subnet, page 2-36.

Step 4 On the General Parameters page, complete the following:

• Label—Enter the name of the demand.

• Service Type—Choose the service type from the drop-down list. For a list of services, see the 
“1.2.5 Service Support” section on page 1-4.

• Present # ch—Enter the number of channels to be created. The Forecast # ch field automatically 
updates with the number entered in this field.

• Forecast # ch—Enter the number of channels to be installed at a later date. This value includes the 
Present # ch value. For example, if you entered 4 in the Present # ch value and want to add two 
channels in the future, enter 6.

Step 5 Click Next.
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Step 6 On the Sites Selection page, in the Protection Sites area, press Ctrl and click the sites that you want to 
add to the P-ring. A P-ring requires at least two sites. Click the right arrow button. To remove a site added 
to the list, click the site and click the left arrow button. 
In the Optical Bypass area, press Ctrl and click the sites that you want to add to the P-ring. Click the 
right arrow button. To remove a site added to the list, click the site and click the left arrow button.

Step 7 Click Next.

Step 8 On the WDM Client Selection page, complete the following interface parameters. The options available 
are based on the service type selected in Step 4.

• Transponder—Click to expand, then check the card type check box to select the card at the end sites 
of the service channels.

• Line Card—Click to expand, then check the card type check box to select the card at the end sites 
of the service channels.

• Alien Card—Appears only if you created a third-party interface as described in the “2.2.4 Defining 
Third-Party DWDM Interfaces” section on page 2-13. Click to expand, and then check the card type 
check box to select the card at the end sites of the service channels.

• Pluggable Card—Click to expand, then check the card type check box to select the card at the end 
sites of the service channels.

In the Client Interface area, define the client interface type (SR, IR, or LR) for the source and destination 
from the Source and Destination drop-down lists. This option is available for transponder and 
muxponder interfaces that have pluggable client interfaces, and depends on the selected service type and 
card type. 

Step 9 Click Finish. The Edit P-Ring Demand dialog box appears.

The demand appears in the NtView Name tab and in the Project Explorer tree in the 
Service Demands > P-Rings folders. A demand is a solid line when selected and a dotted line when not 
selected. The line has a number above it that indicates the number of channels present. Figure 2-27 
shows a selected one-channel P-ring between Sites 1, 2, 3, and 5 with an optical bypass of Site 4. 

Note To make changes to the demand parameters, see the “2.7.7 Editing a P-Ring Demand” section on 
page 2-93, or click Cancel to close the Edit P-Ring Demand dialog box. 
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Figure 2-27 P-Ring Demand

Step 10 Click the Traffic tab of the Net1 tab to view all the circuits that have been created. For more information, 
see “2.4 Viewing Circuits in a Network” section on page 2-51.

2.3.6 Creating a ROADM Demand
Use the following procedure to create ROADM traffic groups and demands:

Step 1 In the Project Explorer, under Nets, right-click the ROADM folder and choose New ROADM Group. 
The ROADM Group Creation Wizard appears.

Step 2 Select the desired traffic subnet from the Traffic Subnet field. You can create a new traffic subnet if 
desired using the “2.3.3 Creating Traffic Subnet” section on page 2-36.

Step 3 Type the ROADM traffic group name in the Group Name field. 

Step 4 Check the desired sites.

Step 5 Click Finish. The new ROADM traffic group appears under the ROADM folder in the Project Explorer.

Step 6 Right-click the new ROADM traffic group and choose Create new ROADM demand from the shortcut 
menu. The Create ROADM Demand dialog box appears (Figure 2-28).
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Figure 2-28 Create ROADM Demand Dialog Box 

Step 7 Enter a name for the demand in the Demand Name field. 

Step 8 Select a traffic pattern type (Hub or Meshed) from the Traffic Type drop-down list. If you select Hub, 
the First Site drop-down list becomes available. If you selected Meshed, proceed to Step 10.

Step 9 For Hub traffic types, select the originating site from the First Site drop-down list.

Step 10 Select a connectivity type from the Connectivity type drop-down list: Protected, Unprotected 
Minimum Hop, Unprotected Optimum Path, or Unprotected Subnet. Refer to the “1.5.3 ROADM 
Traffic Demands” section on page 1-9 for more information on the connectivity choices. If you chose 
Unprotected Subnet, continue with the next step; otherwise proceed to Step 12.

Step 11 If you chose Unprotected Subnet, choose the starting site and the direction the ring must be traversed 
from the drop-down lists. 

Step 12 In the Service Types list, check the boxes for one or more client service types for the ROADM demand. 
The client interfaces that support each service type appear in the table to the right of the Service Types 
list.

Step 13 To further define the client interfaces, complete the following options for each client interface listed in 
the table. Check boxes in gray are not available for selection.

• Yes/No—Check to select this card to implement the service type.

• Client Interface—(Display only) Displays the card type for the selected service type.

• Y Protected—Check to select Y-cable protection if the connectivity type is Protected.

• 1+1 Protected—Check to select 1+1 protection if the connectivity type is Protected.

• Fiber Switched—Check to select fiber-switching protection if the connectivity type is Protected.

• Supported Service—(Display only) Displays the service types supported for the card.

You can select more than one client interface to support the same service type. By default, 
Cisco TransportPlanner checks the best client interface to support each service. 

Step 14 Click Ok to create the demand.

Step 15 Click the Traffic tab of the Net1 tab to view all the circuits that have been created. For more information, 
see “2.4 Viewing Circuits in a Network” section on page 2-51.
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2.3.7 Creating Ethernet Aggregated Demand
An Ethernet aggregated demand is a collection of low rate Gigabit Ethernet/10Gigabit Ethernet services 
that can be aggregated on a single 10-Gbps Wavelength Division Multiplexing (WDM) trunk. It is 
supported only by the GE_XP and 10GE_XP cards when configured as an L2-Switch. The Ethernet 
Aggregation Creation wizard allows you to create one WDM transport channel at a time over a 
predefined traffic subnet, specify the wavelength to be used for the channel, and define a list of locations 
with add/drop VLAN circuit capability. You can also create a set of desired VLAN circuits on this WDM 
transport channel. The check functionality generates a report showing for each section of the subnet 
where the WDM transport channel is over allocated and then perform when the corrective action is 
required. The clone functionality creates an identical copy of the current WDM transport channel with 
the same add/drop sites and WDM channel configuration parameters. You can then start filling this 
channel with the desired circuits. 

Use the following procedure to create Ethernet aggregated demands:

Step 1 In the NtView Name tab, click the Create new Ethernet Aggregated demand icon in the toolbar. For more 
information about the Cisco TransportPlanner icons, see Appendix A, “GUI Information and Shortcuts.” 
The EthernetAggr Creation Wizard appears (Figure 2-29). 

Figure 2-29 Ethernet Aggregation Creation Wizard

Step 2 Select the desired traffic subnet from the Traffic Subnet drop-down list. You can create a new traffic 
subnet if desired using 2.3.3 Creating Traffic Subnet, page 2-36.

Step 3 Click Next.

Step 4 In the General Parameters page, complete the following:

• Label—Type the name of the demand. The default value is EthernetAggr1.
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• Present/Forecast—Check this box if this demand will be needed in the future; uncheck this box if 
this demand is needed now. This parameter will drive the list of pluggable port modules to be 
equipped on the card and will affect BoM reports.

Step 5 Click Next.

Step 6 On the site selection page, complete the following:

• In the Protection Sites area, press Ctrl and click the sites that you want to add to the ethernet 
aggregated demand. An Ethernet aggregated demand requires at least two sites. Click the right arrow 
button. To remove a site added to the list, click the site and click the left arrow button.

• In the Optical Bypass area, press Ctrl and click the sites that you want to add to Ethernet aggregated 
demand. Click the right arrow button. To remove a site added to the list, click the site and click the 
left arrow button. If the Present/Forecast check box is checked, then you cannot select Optical 
Bypass sites. A channel in optical bypass is dropped on one side of the node and added on the other 
side of the same node to allow the future use of that node as an add/drop location.

Step 7 On Node Configuration Selection page, complete the following:

• DWDM Trunk—Select the DWDM trunk type. You can specify the kind of WDM trunk interface 
for the card in each add/drop site allowed. Allowed values are: Auto, w/EFEC, w/FEC, and w/o 
FEC.

• Wavelength—This allows the user to force the current WDM transport channel wavelength. Allowed 
values are:

– Auto—This allows the tool to assign wavelength to the channel with the lowest possible cost, given 
the other set of constraints.

– Allowed wavelength bands—C band-32 ch.odd, L band- 32 ch.odd, C band- 40 ch, or C 
band- 80 ch. Wavelengths are listed based on the selected band. Choose a desired wavelength for 
the WDM transport channel. 

• In the New CFG field, select the desired card type for each site.

Step 8 Click Finish to complete the creation of WDM transport channel. This brings up a window that allows 
to add circuits to this WDM transport channel (see Figure 2-30). 

Step 9 Click Close. To add circuits to this channel, see the “2.7.9 Editing an Ethernet Aggregated Demand” 
section on page 2-95.

Step 10 If you wish to clone this demand, click the Clone button on the left corner of the screen. A new demand, 
which is a copy of this demand, will be created and will appear in the Project Explorer pane.

Step 11 Click the Traffic tab of the Net1 tab to view all the circuits that have been created. For more information, 
see “2.4 Viewing Circuits in a Network” section on page 2-51.
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Figure 2-30 EthernetAggr2 Demand Window, DWDM Channel Tab

2.3.8 Creating TDM Aggregated Demand
A TDM aggregated demand is a collection of low rate SONET and Gigabit Ethernet services that is 
aggregated on a single 10G WDM trunk. TDM aggregated demand is a specific service demand that is 
carried only by the ADM-10G card. It is possible to define Aggregated TDM Demand only for ANSI 
design and this demand is supported only on a ring traffic subnet. 

The TDM Aggr Creation wizard allows you to create one WDM transport channel at a time over a 
predefined traffic subnet, specify the wavelength to be used for the channel, and define a list of locations 
with add/drop STS circuit capability. You should create a set of STS circuits on this WDM transport 
channel to pass traffic. The check functionality will generate a report showing, for each section of the 
subnet, where the WDM transport channel is over allocated and then perform, when required, the 
corrective action. 

The total amount of bandwidth used by all the defined circuits in each section of the WDM transport 
channel cannot exceed the maximum channel capacity of STS-192c. Sections exceeding the maximum 
capacity are colored red in the report. Demands that fail the check will be flagged as invalid demands 
and the Analyzer will stop. 

The clone functionality allows you to create an empty copy of the current WDM transport channel, with 
same add/drop sites and WDM channel configuration parameters. You can then start filling this channel 
with the desired circuits. 

Use the following procedure to create TDM aggregated demands:

Step 1 In the NtView Name tab, click the Create new TDM Aggregated demand icon in the toolbar. For more 
information about the Cisco TransportPlanner icons, see Appendix A, “GUI Information and Shortcuts.” 
The TDMAggr  wizard appears (Figure 2-31).
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Figure 2-31 TDM Aggr Creation Wizard

Step 2 Select the desired traffic subnet from the Traffic Subnet drop-down list. You can create a new traffic 
subnet if desired using 2.3.3 Creating Traffic Subnet, page 2-36.

Step 3 Click Next.

Step 4 In the General Parameters page, complete the following:

• Label—Type the name of the demand. The default value is TDMAggr1.

• Present/Forecast—Check this box if this demand will be needed in the future; uncheck this box if 
this demand is needed now. This parameter will drive the list of pluggable port modules to be 
equipped on the card and will affect BoM reports.

Step 5 Click Next.

Step 6 In site selection area complete the following

• In the Protection Sites area, press Ctrl and click the sites that you want to add to the ethernet 
aggregated demand. An Ethernet aggregated demand requires at least two sites. Click the right arrow 
button. To remove a site added to the list, click the site and click the left arrow button.

• In the Optical Bypass area, press Ctrl and click the sites that you want to add to Ethernet aggregated 
demand. Click the right arrow button. To remove a site added to the list, click the site and click the 
left arrow button. If the Present/Forecast check box is checked, then you cannot select Optical 
Bypass sites. A channel in optical bypass is dropped on one side of the node and added on the other 
side of the same node to allow the future use of that node as an add/drop location.

Step 7 In Node Configuration selection, complete the following:

• DWDM Trunk—Select the DWDM trunk type to specify the kind of WDM trunk interface for the 
card in each allowed add/drop site. Allowed values are: Auto, w/EFEC, w/FEC, and w/o FEC.

• Wavelength—Allows you to force the current WDM transport channel wavelength. Allowed values 
are:
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– Auto—Allows Cisco TransportPlanner to assign wavelength to the channel with the lowest possible 
cost, given the other set of constraints.

– Allowed wavelength bands——C band-32 ch.odd, L band- 32 ch.odd, C band- 40 ch, or C 
band- 80 ch. Wavelengths are listed based on the selected band. Choose a desired wavelength for 
the WDM transport channel.

Step 8 Click Finish to complete the creation of WDM transport channel. The WDM Transport Channel 
Management Wizard appears (see Figure 2-32) that allows you add circuits to this WDM transport 
channel. 

Step 9 Click Close. To add circuits to this channel, see “2.7.10 Editing a TDM Aggregated Demand” section 
on page 2-99. 

Step 10 If you wish to clone this demand, click the Clone button on the left corner of the screen. A new demand, 
which is a copy of this demand, will be created and will appear in the Project Explorer pane.

Step 11 Click the Traffic tab of the Net1 tab to view all the circuits that have been created. For more information, 
see “2.4 Viewing Circuits in a Network” section on page 2-51.

Figure 2-32 TDMAggr Demand

2.3.9 Adding Notes to a Project
Use the following procedure to add a note to any item in the Project Explorer. Each network has a Notes 
folder in the Project Explorer. After you have created a note, it appears in the Notes folder for that 
particular network. 

Step 1 Right-click the desired item in the Project Explorer and choose Edit Note from the shortcut menu.
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Step 2 In the Edit Note creation box, enter the desired text. 

Step 3 To close the Edit Note creation box and to save the note, click the X in the upper right corner of the 
window.

Step 4 To view notes, double-click the Notes folder. The Notes window appears. Table 2-6 lists the columns in 
the Notes window.

Step 5 To close the Notes window, click the X in the upper right corner of the window.

2.3.10 Creating an Optical Subnet
An optical subnet is a collection of spans with certain associated, defined, common properties. You can 
define distinct optical subnets on the same network and can also set a list of associated properties on 
each of them.

The following properties are supported in an optical subnet:

• C-band Rules—Allows you to define rules for the C-band channels, the maximum per channel 
power, and the channel spacing for the design. 

• L-band Rules—Allows you to define, for the L-band channels, the maximum per channel power, and 
the channel spacing for the design.

When you create a new project (see the “2.3 Creating a Project” section on page 2-25), Cisco 
TransportPlanner automatically creates an optical subnet associated to the network. At least one optical 
subnet (even if empty) must exist for each network in a project. 

You can create an optical subnet using the Project Options (default) Optical Subnet property (Design 
Rules) values. To do this:

Step 1 Select the Optical Subnet folder in Project Explorer. The Optical Subnet Pane appears in the Task Pane 
on the right side of the screen (Figure 2-33).

Table 2-6 Notes Window

Column Description

Header Displays the note text. To view the entire note, click the plus (+) sign next to the header 
to expand the text.

Action Click Go to open the item in the Project Explorer where the note was created.

Source Displays the location of the note, for example, ProjectManager.Nets.Net2.Sites.Site2.W.
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Figure 2-33 Creating Optical Subnet 

Step 2 Click Create. The Create Optical Subnet dialog box appears (Figure 2-34). The default name, which 
is a combination of the user-created C-band and L-band rules, and the wizard-created default C-band and 
L-band rules are displayed.

Figure 2-34 Create Optical Subnet Dialog Box

Step 3 Select C-band and L-band design rules from the C Design Rule and L Design Rule drop-down lists for 
the new optical subnet that you want to create. 

Step 4 Click OK. A new optical subnet with the design properties you selected is created and placed in project 
explorer under the Optical Subnets folder. 

Note You cannot create more then one optical subnet with the same properties values and each span must be 
part of only one optical subnet.

Cisco TransportPlanner allows you to modify, edit, define an optical subnet as current, and to delete an 
optical network. To do these, select the optical subnet you want to change in Project Explorer and choose 
the appropriate Modify, Edit, Set as Current, or Delete options under Optical Subnets in the Tasks Pane.
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Note When you delete an optical subnet, all the spans contained in the deleted optical subnet are placed within 
the current optical subnet. In case the current optical subnet is deleted, all their spans will be 
automatically placed within the optical subnet with the greatest number of spans. When the current 
optical subnet is removed, the tool automatically defines as current the optical subnet with the greatest 
number of contained spans.

2.4 Viewing Circuits in a Network
You can view all the circuits that have been created in any of the Service Demands folders in the Traffic 
tab of the Net1 tab.

The following columns are displayed:

• SA—Indicates the system alarms that affect the circuit. This indication is available only after the 
network is analysed.

• AL— Indicates the optical alarms that affect the circuit.This indication is available only after the 
network is analysed.

• F—Indicates if the demand will be needed in the future.

• Demand —Displays the name of the demand.

• Group—Displays the demand group to which the circuit belongs.

• Label —Displays the label of the circuit.

• TMSubnet—Displays the name of the traffic subnet in which the circuit is defined.

• SrvType— Displays the service type value.

• Sites—Lists the add/drop site.

• Card/TrunkType—Displays the card type and trunk type.

• Protection type— Displays the protection type of the demand.

• Wavelength —Displays the assigned wavelength.

You can edit the circuits for any demand by double-clicking the circuit or by selecting the circuit and 
clicking the Edit button in the toolbar.

Use any one of the following options to group and order the circuits:

• Type\Demand\Group— The circuits are first grouped and ordered by demand name. Each set of 
circuits with the same demand name is then ordered by the group name.

• SrvType\Type\group—The circuits are first grouped and ordered by service type. Each set of circuits 
with the same service type is then ordered by the group name.

Note You can also select a set of fields in a particular order in the Group by dialog box to build a grouping 
rule to be applied to the table.
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2.5 Analyzing the Network
After you have created the desired sites, fiber spans, and service demands, you must analyze the network 
to determine network performance. The network must be in the Design, Install, or Upgrade state before 
you can analyze it. Cisco TransportPlanner automatically optimizes the design and summarizes the 
optical transmission performance. If there are problems with the design, Cisco TransportPlanner lists the 
problems and descriptions in the Analyzer Messages pane. 

Use the following procedure to analyze the network:

Step 1 Click the Networks Mgmt Tree tab, and click the network that you want to analyze.

Step 2 Click the Analyze Network icon in the toolbar. For more information about the Cisco TransportPlanner 
icons, see Appendix A, “GUI Information and Shortcuts.” As an alternative, click Analyze in the Tasks 
Pane. 

The Cisco TransportPlanner analysis status bar indicates when the network analysis is complete. 

Step 3 If any problems occur during the analysis, click the Analyzer tab to view the results on the Analyzer 
Messages pane. The Summary report appears. See the “2.6.1 Viewing the Summary Report” section on 
page 2-53 for more information. Warning and error messages help you identify problems with your 
current design. For a list of all system messages, see Appendix C, “System Messages.”

Step 4 If necessary, resolve the problems listed in the Summary report. After you resolve the problems in the 
network, you can analyze the network again. 

Note You can return a Design-Analyzed network to the design state to make further changes by clicking the 
network icon in the Networks Mgmt Tree and clicking Design in the Tasks Pane. 

2.6 Viewing Network Reports
Cisco TransportPlanner provides the reports listed in Table 2-7. Report availability depends on whether 
a network has been analyzed or whether it is in the Install or Upgrade state. Reports are also available 
by site. See Table 2-7 for report availability details.

Note Although the following procedures use the Tasks Pane to access reports, you can also access reports by 
clicking the desired report in the Project Explorer tree Reports folder.

Table 2-7 Report Availability

Report Network Availability Site Availability

NE Update Analyzed —

Installation Parameters Analyzed Analyzed 

Traffic Matrix Analyzed Analyzed

Layout Install, Upgrade, and Analyzed Install, Upgrade, and Analyzed

Link Availability Analyzed Analyzed
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For more information on the Bill of Materials report, see the “2.9 Generating a BoM” section on 
page 2-125. In addition, you can compare the following reports using the Reports Diff tool: Bill of 
Material, Internal Connections, and Installation Parameters. 

To complete the procedures in this section, you must have a project open and the network(s) loaded. See 
the “2.1.1 Opening a Project” section on page 2-2 and the “2.1.2 Loading and Unloading Networks” 
section on page 2-3.

2.6.1 Viewing the Summary Report
The Summary report summarizes design information, optical results, design cost, and analyzer 
messages. You can view it before or after you analyze a network. It automatically appears when you 
analyze a network. Use the following procedure to view the report at another time:

Step 1 Complete one of the following:

• To view the Summary report for a network, click the Networks Mgmt Tree tab and click the 
network.

• To view the Summary report for a site, click the NtView Name tab and click the site.

Step 2 In the Tasks Pane, click Summary. The Summary tab appears (Figure 2-35).

Internal Connections Analyzed —

Optical Results Analyzed Analyzed

Wavelength Routing Analyzed —

Summary Install, Upgrade, and Analyzed Install, Upgrade, and Analyzed

Bill of Material Install, Upgrade, and Analyzed Install, Upgrade, and Analyzed

Table 2-7 Report Availability (continued)

Report Network Availability Site Availability
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Figure 2-35 Summary Tab

Table 2-8 lists the categories in the Summary tab and their descriptions. 
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2.6.2 Saving the NE Update File
After Cisco TransportPlanner completes network analysis, you can create a configuration file. If the 
Optical Networking System (ONS) is Software Release 7.0 or later, a single XML file is created 
including all of the parameters for all the sites in the network; if the ONS is Software R4.7 or R5.0, a 
single TXT file is created for each site in the network. This file can be directly imported to a site using 
the NE Update feature in Cisco Transport Controller (CTC). CTC uses this file to preprovision a node. 

Each file is named with the site name string by default. The list of reported installation parameters 
depend on the system release selected for the designed network. You generally save this file after you 
analyze an Install network.

Use the following procedure to save the NE Update file:

Step 1 Click the Networks Mgmt Tree tab, and click the analyzed network.

Step 2 In the Tasks Pane, click NE Update. The Network Element Update File dialog box appears.

Table 2-8 Summary Tab Categories

Category Description

Design info Displays the following information:

• Version—Displays the Cisco TransportPlanner software release version.

• Customer name—Displays the name of the customer requiring this network 
design. 

• Created By—Displays the user login name. 

• Release—Displays the Cisco TransportPlanner software release number.

Optical results Indicates how many demands are included in the network, and identifies the number 
and severity of alarms for each demand. 

Design cost info Displays the following information:

• Price list—Displays the price list used.

• Currency—Displays the currency selected for the price list.

• BoM total discounted—Displays the total price of the products (excluding spare 
parts) in the network with the discount applied.

• Spare total discounted—Displays the total price of the spare parts in the 
network with the discount applied

• BoM + Spare total discounted—Displays the total price of the products 
(including spare parts) in the network with the discount applied.

Messages Displays any analyzer messages that occurred as a result of network analysis. 
Warning and error messages will help you identify problems with your current 
design. For a list of all system messages, see Appendix C, “System Messages.”
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Step 3 Check the Include wavelength parameters check box to include trunk wavelength preprovisioning in 
the NE Update XML file. Do not check this box if the network on which you import the NE Update file 
is using ONS Software R7.0.0. If this option is checked, trunk wavelength is preprovisioned in CTC for 
all the TXP and MXP units required to support present traffic demands. 

Note During project creation, selecting MSTP- Release 7.0 allows you to create projects for system 
releases 7.0.0 and 7.0.x. However, when importing the NE Update file on a node using system 
release 7.0.0, the node cannot read the NE Update XML file if Include wavelength parameters 
is checked.

Step 4 To save the file in a different directory than the Destination Folder, click Change and navigate to the 
desired directory. Click Save. 

Step 5 Click Finish.

Step 6 Click Cancel to close the window without saving a configuration setup file.

2.6.3 Viewing the Installation Parameters 
The Installation Parameters reports shows the values to be set (provisioned) at installation time on each 
site in the network. These parameters are exported when you save the NE Update file and are used to 
automatically provision a node using CTC. 

Use the following procedure to view the installation parameters after a network has been analyzed:

Step 1 Complete one of the following:

• To view the Installation Parameters report for a network, click the Networks Mgmt Tree tab and 
click the network.

• To view the Installation Parameters report for a site, click the NtView Name tab and click the site.

Step 2 In the Tasks Pane, click Installation Parameters. The Installation Parameters tab appears (Figure 2-36). 
The ANS view subtab appears by default. This tab displays the Automatic Node Setup information.
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Figure 2-36 ANS View Subtab in the Installation Parameters Tab 

Table 2-9 describes the columns on the ANS view tab of the Installation Parameters report. 

Step 3 Click the ANP view tab to view the Automatic Node Provisioning information. Table 2-10 describes the 
columns on the ANP view tab of the Installation Parameters report. 

Table 2-9 Installation Parameters Report ANS View Tab Columns

Column Description

Name Displays the name of the site. 

Side Displays the node interface: T (terminal), E (east), or W (west).

Position Displays the rack, shelf, and slot position of the card from which the patchcord 
originates.

Unit Displays the name of the card.

Port # Displays the port number from which the patchcord originates.

Port ID Displays the port ID.

Port Label Displays the name of the port.

Parameter Displays the name of the parameter to be set, such as RX Power Low.

Value Displays the name of the value to be set.

Measurement 
Unit

Displays the measurement unit for the related installation parameter value, such as 
dBm.

Manual Set Indicates with a Yes or No which parameters must be manually set using the CTC 
interface. This column only applies to alarms. It does not apply to threshold crossing 
alerts (TCAs).
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Step 4 Click the PP view tab to view the Provisioning Parameters information. Table 2-11 describes the 
columns on the PP view tab of the Installation Parameters report. 

Step 5 To close the Installation Parameters report, click the X on the top right of the Installation Parameters tab.

2.6.4 Viewing Internal Connections
Use the following procedure to view the network internal connections after a network has been analyzed.

You can also use this procedure to view the patchcord connections between transponders and the Y-Cable 
Protection modules. The Y-Cable Protection position is defined using the rack and shelf number. The 
slots are numbered from left to right on each of the four modules that can be placed in a shelf.

Step 1 Click the Networks Mgmt Tree tab, and click the analyzed network.

Step 2 In the Tasks Pane, click Internal Connections. The Internal Connections tab appears (Figure 2-37).

Table 2-10 Installation Parameters Report ANP View Tab

Category Description

Name Displays the name of the site. 

Shelf ID Displays the shelf identifier.

Rack number Displays the rack number.

Rack position Identifies the rack position in the shelf.

Slot position Identifies the slot position in the shelf for the card.

Equipment type Displays the card type.

Table 2-11 Installation Parameters Report PP View Tab

Column Description

Name Displays the name of the site. 

Shelf ID Displays the shelf identifier.

Slot position Displays the slot number for the card with the PPM.

Port position Displays the port number.

Ppm position Displays the PPM location on the card.

Pp name Displays the name of the PPM. 

value Displays the installation parameter value.
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Figure 2-37 Internal Connections Tab 

Table 2-12 lists the columns in the Internal Connections tab and their descriptions. Click a columns to 
sort the table information by that column.

• Click the Patchcord installation view subtab to view all the patchcord connections that the installer 
has to mechanically cable within the site between the different ports of the cards. 

• Click the SW Provisioning view subtab to view the patchcord representation on the local Cisco 
Transport Controller interface. This subtab contains all the connections to be manually set or 
removed with respect to the default connections that are automatically generated by the software 
running on the node. 

Table 2-12 Internal Connections Tab Columns

Column Name Description

Name Displays the name of the site. On the SW provisioning view subtab, this column 
indicates whether the connection should be manually set using the CTC interface or 
removed.

Position-1 Displays the rack, shelf, and slot position of the card from which the patchcord 
originates.

Unit-1 Displays the name of the card.
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Step 3 To export the information to an external file, click Export. In the Internal connections export dialog box, 
type the name of the file and navigate to the desired folder. Click Save.

Step 4 To close he Internal Connections tab, click the X in the upper right corner of the tab.

2.6.5 Viewing the Traffic Matrix Report
The Traffic Matrix report displays the point-to-point, P-ring, and ROADM channel data. Use the 
following procedure to view the traffic matrix report:

Step 1 Complete one of the following:

• To view the Traffic Matrix report for a network, click the Networks Mgmt Tree tab and click the 
network.

• To view the Traffic Matrix report for a site, click the NtView Name tab and click the site.

Step 2 In the Tasks Pane under Reports, click Traffic Matrix. The Traffic Matrix tab appears. A default query 
opens.

Port Num (SW provisioning view subtab only) Displays the port number where the patchcord 
terminates.

Port ID-1 (SW provisioning view subtab only) Displays the port ID.

Port label-1 Displays the name of the port.

Attenuator When indicated, this is the product ID of the bulk attenuator to be equipped on this 
connection. It also reports when an internal attenuator must be placed between the 
DC-TX and DC-RX ports on the preamplifier (when no DCU is equipped).

Position-2 Displays the rack, shelf, and slot position of the card where the patchcord 
terminates.

Unit-2 Displays the name of the card.

Port Num (SW provisioning view subtab only) Displays the port number where the patchcord 
terminates.

Port ID-2 (SW provisioning view subtab only) Displays the port ID.

Port Label-2 Displays the name of the port.

P/F Displays whether the connection relates to a present or forecast circuit.

Table 2-12 Internal Connections Tab Columns (continued)

Column Name Description
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Figure 2-38 Traffic Matrix Tab

Each row in the tab shows the performance of one optical path. Table 2-18 describes the information in 
the columns. The Traffic Matrix report displays separate rows for the TX and RX direction of the optical 
channels.

Note To add a column to the report, right-click a column and choose the column name from the 
shortcut menu. The column names with checks in the shortcut menu appear on the report. To 
remove a column, right-click and choose the column (checked) from the shortcut menu. 

Table 2-13 Traffic Matrix Tab Columns

Column Label Description

Service Demand Categorizes each demand type (Point-to-Point, P-ring, and ROADM). Click the 
plus (+) sign by a demand type to expand and show the optical channels.

Service Circuit Displays the optical channel label; for example, Site1-Site2.

OCH CC Source Displays the site name for the optical channel source.

OCH CC Source 
Position

Displays the rack, shelf, and slot identifiers for the source of the optical channel. 
The format of the field is Rack.Shelf.Slot.

OCH CC Source 
Unit

Displays the unit name for the optical channel source.

OCH CC Source 
Port

Displays the port for the source of the optical channel; for example, Client RX.

OCH CC Dst Displays the site name for the optical channel destination.

OCH CC Dst 
Position

Displays the rack, shelf, and slot identifiers for the destination of the optical 
channel. The format of the field is Rack.Shelf.Slot.

OCH CC Dst Unit Displays the product ID for the optical channel destination.
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Step 3 To create a new query, click New Query to open the Query Dialog (Figure 2-39). The Query Dialog 
allows you to filter the optical results using a variety of parameters and templates.

OCH CC Dst Port Displays the port for the destination of the optical channel; for example, Client 
TX.

A/D Source Displays the site name for the add/drop channel source.

A/D Source 
Position

Displays the rack, shelf, and slot identifiers for the source of the add/drop 
channel. The format of the field is Rack.Shelf.Slot.

A/D Source Unit Displays the unit name for the add/drop channel source.

A/D Source Port Displays the port for the source of the add/drop channel; for example, Client RX.

A/D Dst Displays the site name for the add/drop channel destination.

A/D Dst Position Displays the rack, shelf, and slot identifiers for the destination of the add/drop 
channel. The format of the field is Rack.Shelf.Slot.

A/DDst Unit Displays the product ID for the add/drop channel destination.

A/D Dst Port Displays the port for the destination of the add/drop channel; for example, Client 
TX.

Cl. Serv. Type Displays the client service type of the demand; for example, OC-48.

Protection Displays the protection type of the demand; for example, P-ring or Y-cable.

Wavelength Displays the wavelength of the optical channel.

Opt Bypass Identifies where the optical channel is dropped and reinserted when it is not 
terminated on a TXP or MXP card (optical bypass). If “none” appears in the Op 
Bypass column, no optical bypass is defined for the optical channel.

DWDM Interface 
Type

Identifies the DWDM interface type that is used for the optical channel:

• Transponder indicates that an MSTP transponder, an MSTP muxponder, or a 
DWDM pluggable port module is used for the optical channel.

• Line Card indicates that an ITU line card is used for the optical channel.

DWDM Card Type Identifies the type of transponder or line card used for the optical channel.

Table 2-13 Traffic Matrix Tab Columns (continued)

Column Label Description
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Figure 2-39 Query Dialog 

Step 4 To perform a query using individual parameters, select the desired parameters from the drop-down lists 
in the Query Definition area. The selected parameters appear in the Query Preview area at the bottom of 
the screen. Table 2-14 describes the fields in the Query Dialog.

Step 5 Choose one of the following, as needed:

• Click Run Query. The window closes, and the query results appear in the Traffic Matrix tab 
(Figure 2-38). The parameters of the query appear in the horizontal area just below the button bar.

Table 2-14 Query Dialog Fields

Field Label Description

Group Allows you to filter the report to include only the data in the selected group. You 
can also view groups in the Project Explorer view under the network folder.

Demand Allows you to filter the report to include only the data in the selected demand. 
The demand field is available only when you select a specific traffic group.

DWDM Card Type Allows you to filter the report to include only the data in the selected DWDM 
card type. 

Source Allows you to filter the report to include only the results of incoming/outgoing 
services to or from a specific source site.

Destination Allows you to filter the report to include only the results of incoming/outgoing 
services to or from a specific destination site.

Wavelength Allows you to filter the report to include only services using the specified 
wavelength.

Alarm Allows you to filter the report to include only services flagged with a green, 
yellow, orange, or red indicator.

P/F Allows you to filter the report to include only present services, only forecast 
services, or both.

Virtual Allows you to filter the report to include or exclude virtual channels in the 
Optical Results Table.
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• Click Reset Query to clear your selections in the Query Dialog. 

• Click Close to close the window without running a query.

Step 6 To close the Traffic Matrix report, click the X in the upper right corner of the tab.

2.6.6 Displaying the Layout 
Use the following procedure to view a graphical representation of each site in an analyzed network: 

Step 1 Click the NtView Name tab and click the desired site.

Step 2 In the Tasks Pane, click Layout. The Layout tab appears (Figure 2-40). To change sites, choose the 
desired site from the drop-down list.

Figure 2-40 Layout Report (Rack View)

Step 3 From the Site drop-down list, choose the site in the network to display in the layout report.

Step 4 In the tree view on the left of the tab, right-click a rack and choose Expand to view a list of all shelves 
and cards in the rack. 
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Step 5 Click the desired rack or shelf to view it in the layout graphic. Figure 2-41 displays the shelf view.

Figure 2-41 Layout Report (Shelf View)

Step 6 To view details about a card, double-click the card. The Details dialog box opens with client information:

• Label—Displays the name of the card.

• Product ID—Displays the product ID of the card.

• Service Category—Future use.

• Description—Provides a brief description of the card functionality.

• Price—Lists the price for the card based on the price list selected during project creation.

• ITU Channel—Identifies the ITU channel wavelength for the card.

For transponder and muxponder cards, click the Modules subtab in the Details dialog box to view which 
pluggable port modules are to be used for each TXP/MXP unit:

• P/F—P refers to pluggable port modules that support the present client demand, while F refers to 
pluggable port modules that support the future client demand.

• Module PID—Displays the pluggable port module product ID.

• Ch#—Displays the number of the port on the unit and identifies where the pluggable port module is 
to be installed. 

Click Close to close the Details dialog box.

Step 7 To filter the layout display, choose one of the following from the drop-down list:
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• Any—Displays all cards for both the present and forecast traffic demand.

• Present—Displays cards for only the present traffic demand.

• Locked & Unlocked—Highlights the locked and unlocked cards in the layout.

• Alarmed—Highlights the alarmed cards in the layout.

Step 8 After network analysis, all items are in locked mode. To unlock cards so that Cisco TransportPlanner can 
rearrange the layout to optimize slot usage during network analysis, right-click locked card in the rack 
tree and choose Unlock. 

Note You can unlock only on Upgrade networks in the Design state.

Step 9 To export the graphical representation of the layout in JPEG format, click Export. In the Layout export 
dialog box, type the name of the file and navigate to the desired folder. Click Save.

Step 10 To zoom the layout graphic in or out, click the Zoom In and Zoom Out icons. For more information about 
the Cisco TransportPlanner icons, see Appendix A, “GUI Information and Shortcuts.”

Step 11 To close the Layout report, click the X in the upper right corner of the tab.

2.6.7 Viewing Power Consumption from the Layout Report
Use the following procedure to view the power consumption for each unit of equipment in a site. Power 
consumption is available in report form from the Layout report.

Step 1 Click the NtView Name tab and click the desired site.

Step 2 In the Tasks Pane, click Layout. The Layout tab appears (Figure 2-40 on page 2-64). To change sites, 
choose the desired site from the drop-down list.

Step 3 Click the View layout as table icon in the report tool bar. The Layout Table report appears (Figure 2-42).
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Figure 2-42 Power Consumption 

Table 2-15 describes the information in the columns. 

Step 4 To export power consumption data, click Export. The Layout table export dialog box appears. Type the 
name of the file and navigate to the desired folder. Click Save.

Step 5 Click Close to close the Layout Table report.

2.6.8 Viewing the Link Availability Report 
Cisco TransportPlanner determines link availability based on unit failure rate and time to repair. Use the 
following procedure to view the Link Availability report:

Table 2-15 Layout Table (Power Consumption) Columns

Column Label Description

Name Lists the equipment at the site. 

Position Identifies the rack, shelf, or slot location for applicable units of equipment.

Description Describes each equipment type.

Max Power 
Consumption (W)

Displays the maximum power consumption for each unit of equipment. 

Note For transponder/muxponder cards with pluggable port modules, the 
maximum power consumption shown is for the board fully equipped with 
the maximum number of pluggable port modules.

Average Power 
Consumption (W)

Displays the average power consumption for applicable units of equipment.

Note For transponder/muxponder cards with pluggable port modules, the 
average power consumption shown is for the board fully equipped with 
the maximum number of pluggable port modules.
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Step 1 Complete one of the following:

• To view the Link Availability report for a network, click the Networks Mgmt Tree tab and click the 
network.

• To view the Link Availability report for a site, click the NtView Name tab and click the site.

Step 2 In the Tasks Pane, click Link Availability. The Link Availability tab appears (Figure 2-43).

Figure 2-43 Link Availability Report

Each row in the tab shows the performance of one optical path. Table 2-16 describes the information in 
the columns.

Step 3 Click New Query to open the Query Dialog (Figure 2-39 on page 2-63). The Query Dialog allows you 
to filter the link availability using a variety of parameters.

Step 4 To perform a query using individual parameters, select the desired parameters from the drop-down lists 
in the Query Definition area. The selected parameters appear in the Query Preview area at the bottom of 
the screen. Table 2-17 describes the fields in the Query Dialog.

Table 2-16 Link Availability Tab Columns

Column Label Description

Group Categorizes each demand type (Point-to-Point, P-ring, and ROADM). Click the 
plus (+) sign by a demand type to expand and show the optical channels.

Serv. Circuit Displays the optical channel label; for example, Site1-Site2.

P/F Identifies whether the channel is present and forecast (P/F) or forecast (F).

DWDM Card Type Identifies the type of transponder or line card used for the optical channel.

Protection Displays the protection type of the demand; for example, P-ring or Y-cable.

Cl. Serv. Type Displays the client service type of the demand; for example, OC-48.

Source Displays the site name for the optical channel source.

Destination Displays the site name for the optical channel destination.

Link Availability 
(% Complete)

Displays the link availability percentage. Link availability is calculated based on 
the failure rate and time to repair. 
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Step 5 Choose one of the following, as needed:

• Click Run Query. The window closes, and the query results appear in the Link Availability tab. The 
parameters of the query appear in the horizontal area just below the button bar.

• Click Reset Query to clear your selections in the Query Dialog. 

• Click Close to close the window without running a query.

Step 6 To close the Link Availability report, click the X in the upper right corner of the tab.

2.6.9 Viewing Optical Results
Use the following procedure to view the optical results of the network that you created and analyzed:

Step 1 Complete one of the following:

• To view the Optical Results report for a network, click the Networks Mgmt Tree tab and click the 
network.

• To view the Optical Results report for a site, click the NtView Name tab and click the site.

Step 2 In the Tasks Pane, click Optical Results. The Optical Results tab appears (Figure 2-44).

Table 2-17 Query Dialog Fields

Field Label Description

Group Allows you to filter the report to include only the data in the selected group. You 
can also view groups in the Project Explorer view under the network folder.

Demand Allows you to filter the report to include only the data in the selected demand. 
The demand field is available only when you select a specific traffic group.

DWDM Card Type Allows you to filter the report to include only the data in the selected DWDM 
card type. 

Source Allows you to filter the report to include only the results of incoming/outgoing 
services to or from a specific source site.

Destination Allows you to filter the report to include only the results of incoming/outgoing 
services to or from a specific destination site.

Wavelength Allows you to filter the report to include only services using the specified 
wavelength.

P/F Allows you to filter the report to include only present services, only forecast 
services, or both.
2-69
Cisco TransportPlanner DWDM Operations Guide, Release 8.5

78-18129-01



 

Chapter 2      Designing Networks with Cisco TransportPlanner
Viewing Network Reports
Figure 2-44 Optical Results Tab

Each row in the tab shows the performance of one optical path. Table 2-18 describes the information in 
the columns.

Table 2-18 Optical Results Tab Columns

Column Label Description

Name Displays the identification number automatically given to each path in the order 
that the channels were entered into the design.

Group Identifies the demand group for the optical channel.

Protect Displays the protection type of the channel. For a protected channel, both paths 
are shown. The path leaving the east side of the source is shown first.

SOL Displays the results summary of the analysis run with Start of Life fiber loss 
values. The indicator shows the optical performance for the each direction of the 
bidirectional OCH Trail. Green indicates success, yellow indicates success with 
a marginal failure risk (between 0 and 16 percent), orange indicates that the 
channel has a higher risk of failure (between 16 and 50 percent), and red indicates 
failure. 

EOL Displays the results summary of the analysis run with End of Life fiber loss 
values. The indicator shows the optical performance for the each direction of the 
bidirectional Optical Channel Trail (OCH Trail). The indicator shows the optical 
performance for the path at the end of the fiber’s life. Green indicates success, 
yellow indicates success with a marginal failure risk (between 0 and 16 percent), 
orange indicates that the channel has a higher risk of failure (between 16 and 50 
percent), and red indicates failure.
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SE Indicates a system-related error exists that may impact the analysis of the design.

If the indicator is red, review the messages reported at the end of the analysis or 
determine which units or sites are having a problem.

Regeneration Displays the status of the single channel nonlinear effect (NLE) alarm check. 
Green indicates check passed. Yellow indicates marginal NLE; orange indicates 
consistent NLE, and Red indicates failure. 

Multi-channel NLE 
Status

Displays the status of the multiple channel NLE alarm check. Green indicates 
check passed. Yellow indicates marginal NLE; orange indicates consistent NLE, 
and red indicates failure. 

Wavelength Displays the assigned wavelength of the optical path.

P/F Displays the present/forecast services indication.

Source Displays the name of the source site and side; for example, Site 1-E.

Destination Displays the name of the destination site and side; for example, Site 1-E.

Span (km) Displays the total span length (source -> destination) for this path in kilometers.

Tx Type Displays the type of DWDM unit or pluggable port module used for the specific 
OCH Trail.

BER target Displays the bit error rate (BER) target for this channel based on the capability 
of the channel’s optical interface. It is 1.0E-15 for the interfaces using forward 
error correction (FEC) and 1.0E-12 for interfaces without FEC.

SOL OSNR (dB) Displays the start of life average OSNR value at the receiver. OSNR refers to the 
selected resolution bandwidth (RBW) bandwidth.

EOL OSNR (dB) Displays the end of life average OSNR value at the receiver. OSNR refers to the 
selected RBW bandwidth.

SOL OSNR Margin 
(dB)

Displays the SOL OSNR margin calculation, which is the difference between the 
OSNR value at a certain power of the working point of the receiver client and the 
working area boundary.

EOL OSNR Margin 
(dB)

Displays the EOL OSNR margin calculation, which is the difference between the 
OSNR value at a certain power of the working point of the receiver client and the 
working area boundary.

SOL RX (dBm) Displays the SOL received average power at the destination site in dBm.

EOL RX (dBm) Displays the EOL received average power at the destination site in dBm.

SOL Power margin 
(dB)

Displays the SOL power budget margin at the receiver in decibels. It is defined 
as the offset between the receiver working point and the BER curve with margin. 
A positive value indicates no power problems.

EOL Power margin 
(dB)

Displays the EOL power budget margin at the receiver in decibels. It is defined 
as the offset between the receiver working point and the BER curve with margin. 
A positive value indicates no power problems.

SOL Overload (dB) Displays the SOL overload margin at the receiver in decibels. A positive value 
indicates no overload problems.

EOL Overload (dB) Displays the EOL overload margin at the receiver in decibels. A positive value 
indicates no overload problems.

RX atten Displays the attenuation at the input of the receiver.

Table 2-18 Optical Results Tab Columns (continued)

Column Label Description
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Step 3 Click New Query to open the Query Dialog (Figure 2-39 on page 2-63). The Query Dialog allows you 
to filter the optical results using a variety of parameters.

Step 4 To perform a query using individual parameters, select the desired parameters from the drop-down lists 
in the Query Definition area. The selected parameters appear in the Query Preview area at the bottom of 
the screen. Table 2-19 describes the fields in the Query Dialog.

Step 5 Choose one of the following, as needed:

• Click Run Query. The window closes, and the query results appear in the Optical Results tab. The 
parameters of the query appear in the horizontal area just below the button bar.

PMD (ps) Displays the calculated total PMD for each circuit. This total includes all the 
PMD components for the OCH Trail, including fiber and DWDM units on the 
path. If the overall PMD for the link overcomes the maximum allowed, the PMD 
value is colored red. The maximum allowed value depends on the client interface. 
For these special cases, the network must be manually resolved by contacting a 
Cisco optical sales engineer.

Latency Displays the latency time for the current circuit. This value includes all the 
latency components for the OCH Trail, including fiber and DWDM units on the 
path.

Filtering Penalty Displays the value of the penalties caused by the different filter types (OADM, 
ROADM, and arrayed waveguide grating, [AWG]).

Table 2-19 Query Dialog Fields

Field Label Description

Group Allows you to filter the report to include only the data in the selected group. You 
can also view groups in the Project Explorer view under the network folder.

Demand Allows you to filter the report to include only the data in the selected demand. 
The demand field is available only when you select a specific traffic group.

DWDM Card Type Allows you to filter the report to include only the data in the selected DWDM 
card type. 

Source Allows you to filter the report to include only the results of incoming/outgoing 
services to or from a specific source site.

Destination Allows you to filter the report to include only the results of incoming/outgoing 
services to or from a specific destination site.

Wavelength Allows you to filter the report to include only services using the specified 
wavelength.

Alarm Allows you to filter the report to include only services flagged with a green, 
yellow, orange, or red indicator.

P/F Allows you to filter the report to include only present services, only forecast 
services, or both.

Virtual Allows you to filter the report to include or exclude virtual channels in the 
Optical Results Table.

Table 2-18 Optical Results Tab Columns (continued)

Column Label Description
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• Click Reset Query to clear your selections in the Query Dialog. 

• Click Close to close the window without running a query.

Step 6 To close the Optical Results report, click the X in the upper right corner of the tab.

2.6.10 Viewing Wavelength Routing
Use the following procedure to view the wavelength routing map for the network that was analysed:

Step 1 Click the Networks Mgmt Tree tab, and click the analyzed network.

Step 2 In the Tasks Pane, click Wavelength Routing. The Wavelength Routing tab appears (Figure 2-45). Each 
wavelength supported by the platform is represented by a row. 

Note ROADM (Any-to-Any) demands are not shown in this report.

Figure 2-45 Wavelength Routing Tab 

Step 3 Choose one of the following from the Messages drop-down list: 

• Any (to view both forecast and present routing)
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When you select Any, forecast demands are shown with a grey background.

• Present (to view only the present routing)

• Forecast (to view only the forecast routing). 

Step 4 To view the routing map for a particular linear or ring subnet, select the subnet from the traffic subnet 
drop-down list.

Note In addition to the existing subnets, a linear subnet is created for every point-to-point demand. You can 
view all the routing maps in a particular subnet. It is not possible to view the routing maps for all the 
demands across subnets at the same time. 

Note The two ends of the circuit are indicated by the add/drop source and destination sites. See Table 2-20.

Table 2-20 lists and explains the circuit icons present in the routing map

Table 2-20 Circuit Icons in a Routing Map

Component Description

Indicates add/drop source or destination site.

Indicates add/drop source or destination site.

Indicates an express site.

Indicates alarms.

Indicates the side of the site through which the demand exits 
the subnet. For example, in Figure 2-46 a point-to-point 
demand is created from site 2 to site 4. The demand exits the 
subnet at site 1 on side C.
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Figure 2-46 Point-to -point Demand

To view the complete circuit in Figure 2-46, select the linear subnet from the traffic subnet drop-down 
list.

Table 2-21 describes the the columns in the Wavelength routing tab.

Table 2-21 Wavelength Routing Tab Columns

Column Label Description

wl Lists the wavelengths supported by the platform. 

Site # Represents a site in the network. The colors in the Site columns indicate for each 
side of the site the SOL/EOL channel status. Green indicates success, yellow 
indicates success with a marginal failure risk (between 0 and 16 percent), orange 
indicates that the channel has a higher risk of failure (between 16 and 50 
percent), and red indicates failure.

Duct # Represents a duct in the network.

A Represents a Terminal or a Terminal+ site.

A and B Represents a Line or Line+ site.

A, B, C, and D Represents a Multi-Degree site with PP-MESH-4.

A, B, C, D, E, F, G, 
and H

Represents a Multi-Degree site with PP-MESH-8.

Couple Represents a pair of fibers at a site.
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Note Tool tips are available on this report. Move the cursor over a Site column for circuit information, 
card name, and product ID. Move the cursor over a Duct/Couple column for loss, length, and 
fiber type.

Step 5 To export the graphical representation of the layout in JPEG format, click Export. In the Wavelength 
Routing export dialog box, type the name of the file and navigate to the desired folder. Click Save.

Step 6 To close the Wavelength Routing report, click the X in the upper right corner of the window.

2.6.11 Viewing Report Differences
You can compare the BoM, Internal Connections, and Installation Parameters reports for two networks. 
This is useful to see the differences between a baseline network and an Install or Upgrade network. 

• The BoM Diff report lists the units that were added and/or removed from the BoM.

• The Internal Connection Diff report lists changed connections. If at least one of the two endpoints 
of an internal connection is different, Cisco TransportPlanner reports that the internal connection 
has changed. The report shows all internal connections that were present in the baseline network but 
are not present in the final network, and all internal connections not present in the baseline network 
but present in the final network.

• The Installation Parameters Diff report lists changed parameters between the baseline network and 
the final network.

Use the following procedure to compare networks:

Step 1 Click the Reports Diff icon. For more information about Cisco TransportPlanner icons, see Appendix A, 
“GUI Information and Shortcuts.” The Reports Diff dialog box appears. Figure 2-47 shows the Reports 
Diff dialog box as it appears when at least two analyzed networks exist in a project. 

Figure 2-47 Reports Diff Dialog Box
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Step 2 In the Compare networks area, choose the baseline network from the drop-down list on the left. Choose 
the network to compare from the drop-down list on the right. 

Step 3 Click the report you would like to view. If you chose one non-analyzed network, you can view only the 
Bill of Material differences report.

• Bill of Material—(Figure 2-48 on page 2-77) For a description of the columns, see Table 2-22 on 
page 2-78.

• Installation Parameters—(Figure 2-49 on page 2-79) For a description of the columns, see 
Table 2-23 on page 2-79.

• Internal Connections—(Figure 2-50 on page 2-80) For a description of the columns, see Table 2-24 
on page 2-81.

Step 4 Click OK. 

Figure 2-48 shows the BoM Diff report. 

Figure 2-48 BoM Diff Report 

The upper section of the BoM Diff Report tab displays the following information for each network:

• BoM total discounted—Displays the price for the overall network (without spare parts) for each item 
in the BoM. If Use global discount is checked, the total includes the discount from the Global 
discount percentage field.

• Spare total discounted—Displays the price for all of the recommended spare parts in all of the 
maintenance centers for the overall network. It is the sum of each spare item using the discounted 
price. The total appears after you check the Spare Part Report check box.

• BoM + Spare total discounted—Displays the sum of the BoM total discounted price and spare total 
discounted price.

• Price List—Displays the name of the price list database selected for the project.

• Currency—Displays the value of the currency used for each of the price values as specified within 
the selected price list database.

Table 2-22 describes the information in the BoM Diff report columns. Click a column to sort the table 
information by that column.
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Figure 2-49 shows the Installation Parameters Diff report.

Table 2-22 BoM Diff Report Columns

Column Label Description

Name Displays the name of the site and equipment.

Difference Summary (not 
labeled)

Indicates a difference exists between the two network BoMs:

= (equal sign)—Indicates that no difference exists between the two 
networks.

 (not equal sign)—Indicates that the item is present on both 
networks, but the number per network is different.

1—Indicates that this item is present in the first network but not in the 
second network.

2—Indicates that this item is present in the second network but not in 
the first network.

PID Displays the ID string of the product. To view a PID, click on the 
plus (+) sign by the equipment name to expand it. 

Quantity Displays the number of specific products in the BoM. If the networks 
have a different quantity, Cisco TransportPlanner displays both 
numbers in red in the following format: 
first-network-quantity/second-network-quantity.

Unit Price Displays the price for each unit. To view a unit price, click on the 
plus (+) sign by the equipment name to expand it. 

Total Price Displays the total price of the products before applying the discount. 
If the networks have a different quantity, Cisco TransportPlanner 
displays both numbers in red in the following format: 
first-network-total price/second-network-total-price.

Discounted Total Price Displays the total price of the products after applying the discount. If 
the networks have a different quantity, Cisco TransportPlanner 
displays both numbers in red in the following format: 
first-network-discounted-total-price/second-network-discounted-
total-price.
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Figure 2-49 Installation Parameters Diff Report 

Table 2-23 describes the columns in the Installation Parameters Diff report. Click a column to sort the 
table information by that column.

Differences between networks appear in red and in the following format: 
baseline-network-value/final-network-value.

Table 2-23 Installation Parameters Diff Report Columns

Category Description

Name Displays the name of the site. 

(Diff Summary) Indicates a difference exists between the two network BoMs:

= (equal sign)—Indicates that no difference exists between the two networks.

 (crossed-out equal sign)—Indicates that the item is present on both networks, 
but the number per network is different.

1—Indicates that this item is present in the first network but not in the second 
network.

2—Indicates that this item is present in the second network but not in the first 
network.

Side Displays the node interface: T (terminal), E (east), or W (west).

Position Displays the rack, shelf, and slot position of the card from which the patchcord 
originates.

Unit Displays the name of the card.

Port # Displays the port number from which the patchcord originates.

Port ID Displays the port ID.

Port Label Displays the name of the port.

Parameter Displays the name of the parameter to be set, such as RX Power Low.

Value Displays the name of the value to be set.
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Figure 2-37 shows the Internal Connections Diff report.

Figure 2-50 Internal Connections Diff Report

Table 2-24 lists the columns in the Internal Connections Diff report and their descriptions. Click a 
column to sort the table information by that column. 

Differences between networks appear in red and in the following format: baseline network value/final 
network value.

Measurement 
Unit

Displays the measurement unit for the related installation parameter value, such as 
dBm.

Manual Set Indicates with a Yes or No which parameters must be manually set using the CTC 
interface.

Table 2-23 Installation Parameters Diff Report Columns (continued)

Category Description
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2.7 Editing a Project
Cisco TransportPlanner allows you to edit the a project either before or after network analysis. Error 
messages that occur during network analysis often cannot be resolved until you edit one or more network 
components.

To complete the procedures in this section, you must have a project open and the network(s) loaded. See 
the “2.1.1 Opening a Project” section on page 2-2 and the “2.1.2 Loading and Unloading Networks” 
section on page 2-3.

Table 2-24 Internal Connections Tab Columns

Column Name Description

Name Displays the name of the site. On the SW provisioning view subtab, this column 
indicates whether the connection should be manually set using the CTC interface or 
removed.

Difference 
Summary (not 
labeled)

Indicates a difference exists between the two network BoMs:

= (equal sign)—Indicates that no difference exists between the two networks.

 (not equal sign)—Indicates that the item is present on both networks, but the 
number per network is different.

1—Indicates that this item is present in the first network but not in the second 
network.

2—Indicates that this item is present in the second network but not in the first 
network.

Position Displays the rack, shelf, and slot position of the card from which the patchcord 
originates.

Unit Displays the name of the card.

Port label Displays the name of the port.

Attenuator When indicated, this is the product ID of the bulk attenuator to be equipped on this 
connection. It also reports when an internal attenuator must be placed between the 
DC-TX and DC-RX ports on the preamplifier (when no DCU is equipped).

Position Displays the rack, shelf, and slot position of the card where the patchcord 
terminates.

Unit Displays the name of the card.

Port Label Displays the name of the port.

P/F Displays whether the connection relates to a present (P/F) or forecast (F) circuit.
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2.7.1 Editing Project Parameters
Use the following procedure to edit project parameters:

Step 1 Click Project in the Project Explorer.

Step 2 In the Properties pane, complete the following as needed:

• Customer—Type the name of the customer (128 character maximum) requiring this network design. 

• Created by—Type the user name (128 character maximum).

• Units—Displays the span measurement unit: Km (kilometers) or Miles.

• Price List—Choose the price database from the drop-down list.

• Layout—Displays ANSI (the North American standard) or ETSI (the international standard) to 
indicate the platform type. ANSI networks will not allow you to define SDH (ETSI) service 
demands. ETSI networks will not allow you to define SONET (ANSI) service demands. 

2.7.2 Editing Network Parameters
Use the following procedure to edit network parameters:

Step 1 Click a network in the Project Explorer or Networks Mgmt Tree.

Step 2 In the Properties pane, complete the following as needed:

• Name—Type the network name (128 character maximum).

• Position—Type the object location in pixels. 

• Created by—Type the user name (128 character maximum).

• Status—Displays the state of the network (Design, Design-Analyzed, Install, etc.).

• Use MSM Bundles—Check to use the Multishelf Management Integrated Kit bundle when 
generating the BoM instead of the single items.

• Use Spare Parts—Check to determine the spare parts required by the network. If the network is in 
the Upgrade state, the parts required to support the implemented services and the newly added 
present services are included. To generate a spare parts report, you must associate the sites in a 
network with a maintenance center before network analysis. 

• Use Global Discount—Check to use the global discount for the entire network. The global discount 
is applied to all components in the BoM.

• Global Discount—Enter a new global discount in the form of a percentage.

• Service Level—Choose the service level (contract) identifier from the drop-down list.

• Service Length—Choose the maintenance service level length (in years) from the drop-down list.

• Include SW Licenses—Check to include software licenses in the BoM.

• Include Paper Documentation—Check to include paper documentation in the BoM.

• Include CD Documentation—Check to include CD documentation in the BoM.

• Hide Bom/price discount—Check to hide the global discount in the Unit Price column of the BoM.
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• Dimension—Type the network size in pixels.

• Background color—Click to choose a color for the network background.

• Background image—Displays the JPEG or GIF filename used as a background, if any. To choose a 
JPEG or GIF file as a background graphic for the network, click the down arrow and navigate to the 
desired directory. 

2.7.3 Editing Site Parameters
Editing the site parameters allows you to make changes to the current site configuration. A site folder in 
the Project Explorer displays the interface node information. Figure 2-51 shows a site in the Project 
Explorer before network analysis. Figure 2-52 shows a site in the Project Explorer after network 
analysis. 

Figure 2-51 Site in the Project Explorer
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Figure 2-52 Analyzed Site in the Project Explorer

A site folder for an analyzed network design also contains the following items, many of which you can 
edit:

• E, W, T—For a Line or Line+ site, two interface nodes appear in the Project Explorer under the Site 
folder, labeled W (West) and E (East). For a Terminal or Terminal+ site, only one interface node (T) 
appears. 

• C-Band or L-Band—Displays the supported band for the side (E, W, or T interface). 

• Amplifiers—Lists the amplifiers and all related cards for each band and for each side (E, W, or T 
interface). 

• Add/Drop—Displays all of the add/drop and related cards for the band and side (E, W, or T 
interface).

• Site Type Parameters—When selected, shows the site functionality and type in the Properties pane.

• Band Parameters—When selected, shows the output power in the Properties pane.

• Client—Lists the client cards. 

Use the following procedure to edit site parameters. To delete a site, see the “2.7.14 Deleting Sites” 
section on page 2-104.

Step 1 In the Project Explorer, right-click the network folder and choose Expand from the shortcut menu. 

Step 2 Click the desired Site folder. The site parameters appear in the Properties pane.
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Step 3 Complete the following to modify the site parameters in the Properties pane, as needed:

• Name—Enter the desired site name.

• Position—Enter the desired site pixel position; for example, an entry of 0,0 positions the Site icon 
in the upper left corner of the NtView Name tab. 

• Structure—Choose the structure type from the drop-down list: 

– Line—Two pairs of fibers are terminated at the node.

– Terminal—A single pair of fibers is terminated at the node.

– Line+—Two pairs of fibers are terminated at the node but the number of fibers can be increased 
when an MMU card (topology upgrade) is installed. This node is ready to scale to become a 
multi-degree node once MMUs are installed in this node.

– Terminal+—A single pair of fibers is terminated at the node but the number of fibers can be 
increased in if an MMU card (topology upgrade) is installed. This node is ready to scale to 
become a multi-degree node once MMUs are installed in this node.

– Multi-degree—Nodes have more than two sides and faces more than two fibre spans.

The following structure edits are allowed:

– Line to Line+

– Line+ to Line

– Terminal to Terminal+

– Terminal+ to Terminal

To make any other structure change (such as changing from Line to Terminal), you must delete and 
reinsert the site.

• MTTR (hours)—Enter the mean time to repair (MTTR) for all sites in the network. This will apply 
to every site in the network. If you change the MTTR value after creating sites, the new value will 
only apply to sites you create after the change.

• Maintenance Center—Choose the name of the maintenance center from the drop-down list. To 
create a maintenance center, see the “2.7.5 Creating a Maintenance Center” section on page 2-90.

• IP Address—Type the IP address of the node.

• Shelf Config—Choose the shelf configuration type from the drop-down list: 

– Multi Shelf Integrated Switch—All the MSTP optical cards (OADMs and amplifiers) reside in 
different shelves connected by a LAN. The LAN is implemented with switches connected to the 
MSTP shelves. For this option, Multi-Shelf Integrated Switch Cards (MS-ISC) are used to 
support the multishelf configuration.

– Multi Shelf External Switch—All the MSTP optical card (OADMs and amplifiers) reside in 
different shelves connected by a LAN. The LAN is implemented with switches external to the 
MSTP shelves. For this option, two external Ethernet switch units are used to support the 
multishelf configuration.

– Individual Shelf—All the MSTP optical cards (OADMs and amplifiers) reside in the same shelf. 
For this option, multishelf management is not supported; every shelf is managed as an 
independent shelf.

• Node Protection—Choose the node protection type from the drop-down list: Same Shelf or 
Separated Shelves. 

• DCC Shelves Management—When checked, indicates that a TXP(P)_MR_2.5G card is in Slot 12 
on each shelf at each site. 
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• TXP/MXP OSMINE placement—When checked, indicates that the transponder/muxponder cards 
are placed in the shelves according to OSMINE placement rules.

• Hybrid MSTP/MSPP Node—When checked, indicates that all the nodes are configured as hybrid 
MSTP/MSPP nodes.

• Max Number of Shelves/Bay—Choose the maximum number (from 1 to 4) of ANSI or ETSI shelves 
(that equip optical cards or transponder/muxponder cards) that can be placed in each rack in the site 
when generating the site layout. 

• Functionality—Choose the site functionality from the drop-down list. Table 2-25 summarizes the 
site design rules. The site icon changes depending on the functionality. For a description of the site 
icons, see Appendix A, “GUI Information and Shortcuts.”

– Auto—Allows the highest degree of flexibility in creating the network. Cisco TransportPlanner 
generates a design for the site with the lowest possible cost given the other constraints.

– Pass Through—Indicates that no equipment will be located at this site.

– Line amplifier—Prevents any add/drop traffic at this site.

– OSC site—Indicates that site is designated for network communication, providing the 
possibility to access the OSC for management of the MSTP network. By default, no amplifiers 
are included in this site. However, if Cisco TransportPlanner determines that an amplifier is 
required in the network, it can automatically place it at this location. Cisco TransportPlanner 
allows you to set (force) preamplifier and booster amplifiers for each direction on a OSC site 
node.

– Add/Drop—Indicates that this site has add/drop capability. Only point-to-point and P-ring 
circuits can be added/dropped at this site.

– Hub—Indicates that this site is equipped with filters for adding and dropping all the channels 
(on both West and East sides). All express paths are open in hub configurations.

– Gain equalizer—Indicates that this site uses WSS cards to control the generated tilt and extend 
unregenerated distances. The site is realized as an ROADM site without demultiplexer cards.

– R-OADM—Indicates that this site supports Any-to-Any and also Fixed (point-to-point and 
P-ring) traffic types.

– OXC—Indicates that this site uses OXC (optical cross connect) cards to control the generated 
tilt and extend unregenerated distances. This site is realized as an ROADM site without 
demultiplexer cards. 

– OIC—Indicates that this site uses OIC (optical inter connect) cards to control the generated tilt 
and extend unregenerated distances. This site is realized as an ROADM site without 
demultiplexer cards.

Note This functionality is available only for multi-degree sites. Also, if you choose the structure 
of a site as multi-degree and functionality as OXC, the Shelf Management option that you 
select should either be Integrated or External. Otherwise, the application displays an error 
message when analyzed. 

• Type—Choose the site type from the drop-down list (see Table 2-25):

– Auto—Allows the highest degree of flexibility in creating the network. Cisco TransportPlanner 
generates a design for the site with the lowest possible cost given the other set of constraints.

– Glass Through—Indicates a low-priority amplification site.

– Line—Indicates a high-priority amplification site.
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– OADM—Indicates that it is a site with add/drop channels using discrete channel filters (1, 2, 
4-ch 1, 4-band).

– 32-WSS—Indicates that it is a site equipped with 32DMX or 32DMX-O. This option allows you 
to force the use of specific ROADM units. 

Note 32-WSS is available as choice in system release 7.0.x and above.

– Mux/Demux—Indicates that this is a full multiplexer/demultiplexer (FMD) site that adds and 
drops all channels on both sides using the 32MUX-O and 32DMX-O cards. Optical bypass is 
allowed.

– 40-WXC w/PP-MESH-4—(Multi-degree OXC sites only) Indicates the mesh type that is 
provided for sites equipped with 40-WXC cards. If this type is selected, the site will be equipped 
to support up to 4 degrees independently of the number of fibers connected to the site. 

– 40-WXC w/PP-MESH-8—(Multi-degree OXC sites only) Indicates the mesh type that is 
provided for sites equipping 40-WXC cards units. If this type is selected, the site will be 
equipped support up to 8 degrees independently of the number of fibers connected to the site.

– WSS/DMX—Multi-degree OIC sites only.

• Anti ASE—Choose Yes to configure the site so that all the express channels on the site are optically 
dropped and reinserted. In addition, all the patch cords between the West and East sections are 
removed. Choose Auto to allow Cisco TransportPlanner to decide if the site should be configured 
as anti-amplified spontaneous emissions (anti-ASE). See Table 2-25 for a summary of the site 
design rules.

Table 2-25 Site Design Rules

Structure Functionality Type Card Options

C-Band 
32/16 Ch. 
100 GHz

C-Band 
8 Ch. 
100 GHz

C-Band 
64 Ch. 
50 GHz

L-Band 
32 Ch. 
100 GHz

Line Pass Through — — Yes Yes Yes Yes

Line amplifier Line amplifier — Yes Yes Yes Yes

Glass Through — Yes Yes Yes Yes

OSC Site — — Yes Yes Yes Yes

Add/Drop OADM
(Anti-ASE)

OADM cards Yes Yes No No

Mux/Demux — Yes Yes No No

Hub Mux/Demux — Yes Yes No No

WSS 32DMX-O Yes Yes Yes No

32DMX Yes Yes Yes Yes

Gain equalizer WSS 32DMX Yes No Yes Yes

ROADM WSS 32DMX-O Yes No Yes No

32DMX Yes No Yes Yes
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Step 4 To modify the band parameters, click C-Band or L-Band in the Project Explorer for the desired site 
interface. In the Properties pane, enter the desired Output power.

Step 5 To modify amplifier parameters, click C-Band Amplifiers or L-Band Amplifiers in the Project 
Explorer for the desired site interface. Choosing a value other than Auto will force a setting on the unit. 
For more information, see the “1.6 Auto, Forced, and Locked Parameters” section on page 1-11.

a. In the Properties pane From Fibre area, complete the following as needed:

• PRE—Choose the desired preamplifier from the drop-down list (None, Auto, 
OPT-PRE [C-band], OPT-AMP-C [C-band], or OPT-AMP-L [L-band]).

Line+ ROADM WSS 32DMX-O Yes No No No

32DMX Yes No No Yes

Hub WSS 32DMX-O Yes No No No

32DMX Yes No No Yes

Terminal Add/Drop OADM

(Anti-ASE)

OADM cards Yes Yes No No

Mux/Demux — Yes Yes No No

ROADM WSS 32DMX-O Yes Yes Yes No

32DMX Yes Yes Yes Yes

Terminal+ ROADM WSS 32DMX-O Yes No No No

32DMX Yes No No Yes

Multi- 
Degree

OXC PP MESH-4 Add: 32-WSS

Drop: 32-DMX Yes No No No

Add: 40-MUX-C

Drop: 40-MUX-C Yes No No No

Add: 40-WSS-C

Drop: 40-DMX-C Yes No No No

PP MESH-8 Add: 32-WSS

Drop: 32-DMX Yes No No No

Add: 40-MUX-C

Drop: 40-MUX-C Yes No No No

Add: 40-WSS-C

Drop: 40-DMX-C Yes No No No

OIC — Add: 32-WSS

Drop: 32-DMX Yes No Yes No

Add: 40-WSS-C

Drop: 40-DMX-C Yes No Yes No

Table 2-25 Site Design Rules (continued)

Structure Functionality Type Card Options

C-Band 
32/16 Ch. 
100 GHz

C-Band 
8 Ch. 
100 GHz

C-Band 
64 Ch. 
50 GHz

L-Band 
32 Ch. 
100 GHz
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• DCU 1/2—Choose the desired DCU from the drop-down lists.

• Attenuator—Choose the desired attenuator from the drop-down list.

• Output power—Enter the desired output power.

• Tilt—Enter the desired tilt value.

• Attenuator—Choose the attenuator from the drop-down list.

b. In the Properties pane To Fibre area, complete the following as needed:

• BST—Choose the desired booster from the drop-down list (None, Auto, OPT-BST [C-band], 
OPT-BST-E [C-band], OPT-AMP-L [L-band], or OPT-BST-L [L-band]).

• DCU 1/2—Choose the desired DCU from the drop-down lists.

• Output power—Enter the desired output power.

• Tilt—Enter the desired tilt value.

c. In the Properties pane General area, choose the OSC from the drop-down list (OSC-CSM or 
OSCM).

Step 6 To modify OADM parameters, click Add/Drop in the Project Explorer for the desired site interface. In 
the Properties pane, complete the following as needed:

• In the Line/OADM area, choose the desired attenuator from the drop-down list.

• In the Mux/Demux WSS area, complete the following as needed:

– Patch Panel—Choose the patch panel from this drop-down list.

– Demux—Choose the demultiplexer from this drop-down list.

– Mux—Choose the multiplexer from this drop-down list.

2.7.4 Editing Service Demand Association and Traffic Subnet
Use this procedure to change the association of a service demand from one traffic subnet to another. You 
can change the association if the destination subnetwork satisfies all of the add/drop requirements of the 
service demand.

You can edit a traffic subnet only in the Design mode; in Install and Upgrade mode, this feature is not 
supported. 

Step 1 In the Project Explorer Pane, right-click Traffic Subnets and choose View Demand Relationship from 
the shortcut menu. The Select Subnet dialog box appears (see Figure 2-53).

Step 2 Expand the Traffic Subnet folder to view the service demands associated with it. 

Step 3 Click the Move to Subnet row to see the list of destination traffic subnets where this service demand 
can be moved to. The list will only contain those Traffic Subnets that can satisfy the add/drop needs of 
this service demand.

Note Cisco TransportPlanner will check to see if each user-forced demand can be met at the destination traffic 
subnet. In case the check fails, a message shall be displayed asking the user to confirm if this operation 
should be continued. Click Yes to continue. All the unfeasible properties within each demands will be 
reset to the default value.
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Step 4 Select the desired destination traffic subnet and click Ok.

Step 5 To edit a defined traffic subnet, right-click Traffic Subnets in the Project Explorer pane and choose 
Edit. The Traffic Subnet Builder dialog box shown in Figure 2-53 appears. 

Step 6 From the Selected Ducts area, click the ducts you want to include the new the new traffic subnet and 
click OK. The selected ducts are added in the Choose Ducts area.

Step 7 Click OK. The properties of the original traffic subnet are updated with the selected options.

Note Later, when analyzing the network, if the tool discovers that the order of the add/drop sites in the 
destination traffic subnet has been modified, the analyzer will mark these traffic demands as invalid and 
will not proceed with the analysis. 

Figure 2-53 Select Subnet Dialog Box

2.7.5 Creating a Maintenance Center
Use the following procedure to add maintenance centers that will supply your network with spare parts 
in the event of a failure. This feature helps your customer determine the quantity of spares that should 
be purchased, depending on the number of maintenance centers and their availability. Maintenance 
centers appear in the Maintenance Center folder under a site in the Project Explorer.

Step 1 In the Project Explorer, right-click the network folder and choose Expand from the shortcut menu.

Step 2 Scroll down the Project Explorer, right-click the Maintenance Center folder, and choose New 
Maintenance Center from the shortcut menu. 

Step 3 Highlight the new maintenance center in the Project Explorer.

Step 4 In the Properties pane, complete the following as needed:

• Confidence Level—Choose the percentage that represents the required confidence level for finding 
needed spare parts in the maintenance center: 50, 75, 95, or 99 percent. 

• Restocking time (days)—Enter the time (including transportation) required to restock the part in the 
maintenance center.
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Step 5 To associate a maintenance center with a site, see the “2.7.3 Editing Site Parameters” section on 
page 2-83.

2.7.6 Editing a Point-to-Point Demand
Use the following procedure to edit a point-to-point demand:

Step 1 In the Project Explorer, right-click the network folder and choose Expand from the shortcut menu.

Step 2 In the Project Explorer, right-click the point-to-point demand circuit and choose Edit from the shortcut 
menu. The Edit Point to Point Demand dialog box appears (Figure 2-54). 

Figure 2-54 Edit Point to Point Demand Dialog Box

Step 3 To modify the information for each channel, complete the following as needed:

• Forecast—Check to change a present channel to a forecast channels. 

• Srv. Type—Choose the desired service type from the drop-down list. Changing the service type for 
one channel automatically changes the service type for all channels.

• Protection—Choose the desired protection type from the drop-down list. Changing the protection 
type for one channel automatically changes the protection for all channels.

• Path—Choose W (west-to-east) or E (east-to-west) from the drop-down list.

• Wavelength—Choose the desired wavelength type from the drop-down list. If you choose Auto, 
Cisco TransportPlanner assigns wavelength to the channels with the lowest possible cost given the 
other constraints.

• Optical Bypass—Choose the site for optical bypass from the drop-down list.

• WDM Intf. Type—Choose the desired card interface type from the drop-down list. 

• WDM Card Type—Choose the desired card type from the drop-down list. The available options 
depend on the card interface type that is selected. Changing the card type for one channel 
automatically changes the card type for all channels.

• Src. Client Intf.—Choose the desired source client interface from the drop-down list. The available 
options depend on the card type that is selected.

• Dst. Client Intf.—Choose the desired destination client interface from the drop-down list. The 
available options depend on the card type that is selected.

Step 4 To add a new channel, click the Create a new circuit icon on the right of the Edit Point to Point Demand 
dialog box. A new row appears. Repeat Step 3 as needed to complete the parameters for the new channel.
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Step 5 To delete an existing channel, select the row and click the Remove the selected circuit icon on the right 
of the Edit Point to Point Demand dialog box.

Step 6 To define more complex path constraints, click Edit path constraints icon on the right of the Edit Point 
to Point Demand dialog box. The Request Path Constraints dialog box appears (Figure 2-55).

Figure 2-55 Request Path Constraint Dialog Box

Step 7 Specify the following options as needed in the Working tab and the Protected tab:

• Output Node Interface—Select an interface for the site. The following options are available:

– A or B: This option forces the circuit to be routed on the span connected to the side labeled A 
or B of the source site. Only the sides connected to the spans on the selected Traffic Subnet are 
available.

– Auto: This option allows the highest degree of flexibility to the CTP in routing the circuits. The 
CTP routes the circuits with the lowest possible cost given the other set of constraints.

• Excluded Sites—This options allows to define a list of sites through which the circuit cannot be 
routed.

Step 8 Exclude Ducts—Define a list of spans through which the circuit cannot be routed.

Step 9 Click Ok. 
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2.7.7 Editing a P-Ring Demand
Use the following procedure to change the distribution of services in a P-ring service demand:

Step 1 In the Project Explorer, right-click the network folder and choose Expand from the shortcut menu.

Step 2 In the Project Explorer, right-click the P-ring demand and choose Edit from the shortcut menu. The Edit 
P-Ring Demand dialog box appears (Figure 2-56). 

Figure 2-56 Edit P-Ring Demand Dialog Box

Step 3 Complete the following as needed in the Edit P-Ring Demand dialog box to modify the P-ring:

• Service Type—Choose the desired service type from the drop-down list. 

• WDM Card Type—Choose the desired card type from the drop-down list. The available options 
depend on the service type selected. 

• WDM Interface—Choose the desired card interface type from the drop-down list. The available 
options depend on the card type selected.

In the Circuits area of the Edit P-Ring Demand dialog box, complete the following as needed:

• Ring—(Display only) Displays the name of the P-ring.

• Forecast—Check to change the present channels to forecast channels. 

• Wavelength—Choose the desired wavelength type from the drop-down list. If you choose Auto, 
Cisco TransportPlanner assigns wavelengths to the channels with the lowest possible cost given the 
other constraints.

In the Sections area of the Edit P-Ring Demand dialog box, complete the following as needed:

• Src—(Display only) Displays the source site name for a section.

• Dst—(Display only) Displays the destination site name for a section.

• Opt. Bypass—Choose the sites from the drop-down list where the channels for the current demand 
will be optically dropped. Only the sites between the source and destination sites along the path of 
this section are available as options. 

• Src. Client Intf.—Choose the desired source client interface from the drop-down list. The available 
options depend on the card type selected.
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• Dst. Client Intf.—Choose the desired destination client interface from the drop-down list. The 
available options depend on the card type selected.

Step 4 To add a new P-ring channel, click the Create a new P-Ring circuit icon on the left of the Edit Point to 
Point Demand dialog box. A new row appears. Repeat Step 3 as needed to complete the parameters for 
the new P-Ring.

Step 5 To delete an existing channel from the P-ring, select the row and click the Remove the selected P-Ring 
circuit icon on the left of the Edit P-Ring Demand dialog box.

Step 6 Click Ok to save the changes to the channels and close the Edit P-Ring Demand dialog box, or Cancel to 
close the dialog box without saving the changes.

2.7.8 Editing a ROADM Demand
Use the following procedure to change the distribution of services in a ROADM service demand:

Step 1 In the Project Explorer, right-click the network folder and choose Expand from the shortcut menu.

Step 2 Right-click the ROADM traffic group and choose Edit from the shortcut menu. The Edit ROADM 
Demand dialog box appears (Figure 2-57).

Figure 2-57 Edit ROADM Demand Dialog Box

Step 3 Select a traffic pattern type (Hub or Meshed) from the drop-down list. If you select Hub, the First Site 
drop-down button becomes available. If you selected Meshed, go to Step 5.

Step 4 For Hub traffic types, select the originating site from the First Site drop-down list.

Step 5 Select a connectivity type from the Connectivity type drop-down list. The choices are Protected, 
Unprotected Minimum Hop, Unprotected Optimum Path, and Unprotected Subnet. Refer to the 
“1.5.3 ROADM Traffic Demands” section on page 1-9 for more information about the connectivity type 
choices. 

Step 6 In the Service types pane, check the boxes for one or more client service types for the ROADM demand. 
The client interfaces that support each service type appear in the right pane.
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Step 7 To further refine the client interfaces, complete the following options for each row in the right pane. 
Check boxes in gray are not available for the client interface selection.

• Yes/No—Check to select this card to implement the service type.

• Client Interface—Displays the card type for the selected service type.

• Y-Cable—Check to select Y-cable protection if the connectivity type is Protected.

• 1+1 Protected—Check to select 1+1 protection if the connectivity type is Protected.

• Fiber Switched—Check to select fiber-switching protection if the connectivity type is Protected.

• Supported Service—Displays the service types supported for the card.

You can select more than one client interface to support the same service type. By default, 
Cisco TransportPlanner checks the best client interface to support each service. 

Step 8 Click Ok to save the changes to the demand.

2.7.9 Editing an Ethernet Aggregated Demand
Use the following procedure to edit Ethernet aggregated demand.

Step 1 In the Project Explorer, right-click the network folder and choose Expand from the shortcut menu.

Step 2 In the Project Explorer, right-click the Ethernet aggregated demand and choose Edit demand from the 
shortcut menu. The Ethernet Aggregated Demand dialog box appears (Figure 2-58).

Figure 2-58 Ethernet Aggregated Demand Dialog Box
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Step 3 Click Create a New Circuit icon on the toolbar to add a new circuit to the existing WDM transport 
channel. The New Request dialog box appears (see Figure 2-59).

Step 4 If a circuit already exists, to make a copy of it, right-click the circuit and click Copy Circuit. A new 
circuit will appear as a WDM traffic channel with the same parameters as the original circuit.

Step 5 To delete a circuit, right click the circuit and click Delete Circuit.

Figure 2-59 Adding Circuit to a WDM Transport Channel

Step 6 To modify the parameters of an existing circuit, double click the circuit. The Edit Request dialog box 
appears (see Figure 2-60).
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Figure 2-60 Edit Request Dialog Box for an Ethernet WDM Transport Channel 

Step 7 Change the following as needed in the Edit Request dialog box:

• The label for the circuit

• P/F flag as desired

• Path Forcing—Allows you to force the circuit routing on the traffic subnet associated with this 
demand. The following values are supported:

– Auto—This is the default value. When set to this, the tool automatically defines the trunk path. 

– Side <x> where Side <x> —Represents the label of side on the Src Site where the circuit is 
routed.

• Trunk Protection—Allowed values are Unprotected, UPSR.

• Client Protection—Allowed values are Unprotected, 1+1 APS.

• Circuit rate—Displays the allowed circuit rates.

• Src Site—Allowed values include the list of sites added in the WDM traffic channel. You can set it 
to Auto for the tool to select an appropriate value.

• Port CIR—This is the committed information rate, with 1 being the max and 0.1 being the lowest.

• Card Type—Allowed values are Auto, 10GE-XP, or GE-XP. Auto allows the tool to select a 
appropriate card type based on other constraints

• Port Num—Allowed values are Auto, 1, and 2. Auto allows the tool to select an appropriate port 
number based on other constraints.

• Portp Rate-Reach—Select the desired PPM for this port, or set it to Auto to allow the tool to select 
an appropriate value.

• Dest Site—Allowed values include the list of sites added in the WDM Traffic channel. You can set 
it to Auto for the tool to select an appropriate value.

• Card type—Allowed values are Auto, 10GE-XP, or GE-XP. Auto allows the tool to select an 
appropriate card type based on other constraints.
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• Port Num—Allowed values are Auto, 1, and 2. Auto allows the tool to select an appropriate Port 
number based on other constraints.

• SFP Lambda—Select the desired SFP/XFP for this port or set it to Auto to allow the tool to select 
an appropriate value.

Step 8 Click Ok to complete and to return to the New Request dialog box.

Step 9 Enter the number of circuits to be created in Quantity area.

Step 10 In the General area, enter the following:

• Label—Enter the label for the circuit. By default, VLAN_Circuit_x will be used.

• P/F flag—Check this box if this demand will be needed in the future; uncheck this box if this 
demand is needed now. This parameter will drive the list of pluggable port modules to be equipped 
on the card and will affect BoM reports.

• Client Protection—Allowed values are Unprotected, 1+1 APS.

• Trunk Protection—Allowed values are Unprotected, UPSR.

• Circuit rate—Displays the allowed circuit rates.

• Path Forcing—This option allows you to force the circuit routing on the traffic subnet associated 
with this demand. The following values are supported:

– Auto—This is the default value. When set to this, the tool automatically defines the trunk path. 

– Side <x> where Side <x> —Represents the label of side on the Src Site where the circuit is 
routed.

Step 11 In the Src area, complete the following:

• Site—Select the source site. Allowed values include the list of sites added in the WDM traffic 
channel.

• Card—Select the Card. Allowed values are Auto, 10GE-XP or GE-XP. Auto allows the tool to select 
an appropriate card type based on other constraints.

• Port Num—Select the port number. Allowed values Auto, 1, and 2. Auto allows the tool to select an 
appropriate port number based on other constraints.

• Port CIR—Select the CIR, with 1 being the max and 0.1 being the lowest.

• Port Rate-Reach—Select the desired PPM for this port, or set it to Auto to allow the tool to select 
an appropriate value.

Step 12 Under Dest area complete the following:

• Dest Site—Select the destination site. Allowed values include the list of sites added in the WDM 
traffic channel. 

• Port Num—Allowed values Auto are 1, and 2. Auto allows the tool to select an appropriate port 
number based on other constraints.

• Card—Allowed values, Auto, 10GE-XP, or GE-XP. Auto allows the tool to select an appropriate 
card type based on other constraints.

• Port CIR—This is the committed information rate, with 1 being the max and 0.1 being the lowest.

• Port Rate-Reach—Select the desired SFP/XFP for this port, or set it to Auto to allow the tool to 
select an appropriate value.

Step 13 Click Ok to complete the creation of the circuit.
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Step 14 Click the Check tab on the left corner of the window to generate a report showing the circuit path in the 
WDM traffic channel and to check any over-allocation of bandwidth (see Figure 2-61). The report shows, 
in a row, each of the site on the subnet, and each span in between.

Figure 2-61 Circuit Path View in a Ethernet Aggregated Demand

Step 15 You can add as many circuits as the available bandwidth of the WDM Transport channel allows. When 
you are finished, click Close.

2.7.10 Editing a TDM Aggregated Demand
Use the following steps to edit a TDM aggregated demand.

Step 1 In the Project Explorer, right-click the network folder and choose Expand from the shortcut menu.

Step 2 In the Project Explorer, right-click the TDM aggregated demand and choose Edit demand from the 
shortcut menu. The TDM Aggregated Demand dialog box appears (Figure 2-32).

Step 3 On the Traffic tab, click the create a new circuit icon. The New Request dialog box appears (see 
Figure 2-63).

Step 4 If a circuit already exists, make a copy of it by right-clicking the circuit and clicking Copy Circuit. A 
new circuit will appear under WDM Traffic channel with the same parameters as the original circuit.

Step 5 To delete a circuit, right-click the circuit and click Delete Circuit.

Step 6 To modify the parameters of an existing circuit, double-click the circuit. The Edit request dialog box 
appears (see Figure 2-62).
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Figure 2-62 Edit Request in a TDM WDM Transport Channel

Step 7 Change the following as needed in the Edit Request dialog box:

• The label for the circuit

• P/F flag as desired

• Path Forcing—This option forces the circuit routing on the traffic subnet associated to the 
aggregated demand. The following values are supported:

• Trunk Protection—Allowed values are Unprotected, UPSR.

• Client Protection—Allowed values are Unprotected, 1+1 APS.

• Circuit rate—Allowed values are STS1, STS3c, STS6c, STS9c, STS12c, STS18c, STS24c, STS36c, 
STS48c, and GE-STS24.

– Auto—This is the default value. When set to this, the tool automatically defines the trunk path.

– Side <x> —Where Side <x> represents the label of side on the source site where the circuit is 
routed.

• Site—Allowed values include the list of sites added in the WDM Traffic channel. You can set it to 
Auto for the tool to select an appropriate value.

• Port Rate-Reach—Select the desired PPM for this port or set it to Auto to allow the tool to select an 
appropriate value.

• Card—Allowed values are Auto, 10GE-XP, or GE-XP. Auto allows the tool to select an appropriate 
card type based on other constraints.

• Port Num—Allowed values are Auto, 1, and 2. Auto allows the tool to select an appropriate port 
number based on other constraints.

• Port CIR—This is the committed information rate, with 1 being the max and 0.1 being the lowest.
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• Dest Site—Allowed values include the list of sites added in the WDM traffic channel. You can set 
it to Auto for the tool to select an appropriate value.

• Port Rate-Reach—Select the desired SFP/XFP for this port or set it to Auto to allow the tool to select 
an appropriate value.

• Card—Allowed values are Auto and ADM. Auto allows the tool to select an appropriate card type 
based on other constraints.

• Port Num—Allowed values are Auto, 1, and 2and. Auto allows the tool to select an appropriate port 
number based on other constraints.

Step 8 Click Ok to complete the creation of the circuit and return to the New request dialog box.

Step 9 Enter the number of circuits to be created in the Quantity area.

Figure 2-63 TDM Point to point Circuit Creation in a WDM transport channel 

Step 10 In the General area, complete the following:

• Select the label for the circuit. By default, VLAN_Circuit1 will be used.

• P/F flag—Check this box if this demand will be needed in the future; uncheck this box if this 
demand is needed now. This parameter will drive the list of pluggable port modules to be equipped 
on the card and will affect BoM reports.

• Client Protection—Allowed values are Unprotected and 1+1 APS.

• Trunk Protection—Allowed values are Unprotected and UPSR.

• Circuit rate—Allowed values are STS1, STS3c, STS6c, STS9c, STS12c, STS18c, STS24c, STS36c, 
STS48c, and GE-STS24.
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• Path Forcing—This option forces the circuit routing on the traffic subnet associated to this 
aggregated demand. The following values are supported: 

– Auto—This is the default value. When set to this, the tool automatically defines the trunk path.

– Side <x>—Where Side <x> represents the label of side on the source site where the circuit is 
routed.

Step 11 In the Src area, complete the following:

• Site—Select the source site. Allowed values include the list of sites added in the WDM traffic 
channel.

• Port Rate-Reach—Select the desired PPM for this port or set it to Auto to allow the tool to select an 
appropriate value.

• Card—Select the card. Allowed values are Auto and ADM. Auto allows the tool to select an 
appropriate card type based on other constraints.

• Port Num—Select the port number. Allowed values are Auto, 1, and 2. Auto allows the tool to select 
an appropriate port number based on other constraints.

Step 12 In the Dest area, complete the following:

• Site—Select the destination site. Allowed values include the list of sites added in the WDM traffic 
channel. 

• Port Rate-Reach—Select the desired PPM for this port or set it to Auto to allow the tool to select an 
appropriate value.

• Card type—Allowed values are Auto and ADM. Auto allows the tool to select an appropriate card 
type based on other constraints.

• Port Num—Allowed values Auto and 1 through 16. Auto allows the tool to select an appropriate port 
number based on other constraints.

Step 13 Click OK to complete the creation of Circuit. On the Traffic tab, you can see the created circuit 
(Figure 2-64). 

Figure 2-64 TDM Circuit in a TDM Aggr Demand
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Step 14 Click the Check tab on the left corner of the window to generate a report showing the circuit path in the 
WDM traffic channel and to check any over-allocation of bandwidth (see Figure 2-65). The report shows, 
in a row, each of the site on the subnet, and each span in between.

Step 15 You can add as many TDM circuits as the bandwidth of the WDM transport channel allows. After you 
complete adding circuits, Close.

Figure 2-65 TDM Aggr Demand Window, Report Tab

2.7.11 Deleting a Fiber Span
Use the following procedure to delete a fiber span from the network design:

Step 1 In the Project Explorer, right-click the network folder and choose Expand from the shortcut menu.

Step 2 In the Project Explorer, right-click the duct that you want to delete and choose Delete from the shortcut 
menu. As an alternative, you can click Delete in the Tasks Pane.

Step 3 Click Yes to confirm the fiber deletion.

2.7.12 Deleting a Network
To delete a network from a project, in the Network Mgmt Tree tab click the network and choose Delete 
from the Tasks Pane. You cannot delete a network if it is the only network in a project.
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2.7.13 Deleting Notes
Use the following procedure to delete a note from any item in the Project Explorer:

Step 1 Double-click the Notes folder.

Step 2 In the Notes window, click Go in the Action column for the note that you want to delete. The item is 
highlighted in the Project Explorer. 

Step 3 Right-click the item in the Project Explorer and choose Delete Note from the shortcut menu.

2.7.14 Deleting Sites 
Use the following procedure to delete sites from a network. You can delete a site if the site is in the 
Unlocked state and does not have a traffic demand set up on it. You can delete sites from a network in 
the Design state only.

Step 1 Verify that the site is in the Unlocked state in the Project Explorer pane. For more information, see the 
“2.8.4 Unlocking Parameters in the Network Design” section on page 2-123.

Step 2 Delete any traffic demands. For more information, see the “2.7.15 Deleting a Traffic Demand” section 
on page 2-104.

Step 3 On the NtView Name tab, click the Site icon and choose Delete from the Tasks Pane. For more 
information about the Cisco TransportPlanner icons, see Appendix A, “GUI Information and Shortcuts.” 
As an alternative, you can click Delete in the Tasks Pane. A confirmation message appears, asking you 
to confirm the deletion of the site.

Step 4 Click Yes to delete the site. 

2.7.15 Deleting a Traffic Demand
A traffic demand must be in the Unlocked state before you can delete it. Use the following procedure to 
delete a traffic demand:

Step 1 In the Project Explorer, right-click the network folder and choose Expand from the shortcut menu.

Step 2 Verify that the demand is in the Unlocked state. For more information, see the “2.8.4 Unlocking 
Parameters in the Network Design” section on page 2-123.

Step 3 Right-click the demand that you want to delete in the Project Explorer and choose Delete from the 
shortcut menu. As an alternative, you can click Delete in the Tasks Pane.

2.7.16 Deleting a Traffic Subnet
Use the following procedure to delete a created traffic subnet. The Traffic Subnet ALL cannot be deleted. 
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Step 1 In the Project Explorer, click the Net > Traffic Subnets folder to expand it. 

Step 2 Right-click the traffic subnet to be deleted and select Delete to delete the subnet. 

Step 3 If the traffic subnet being deleted is associated with demands, a dialog box will appear listing all the 
demands associated with this subnet. These associations will be removed and the demands will be moved 
to the Traffic Subnet ALL demand. Upon confirmation, the traffic subnet will be deleted. 

Note Demands moved under Traffic Subnet All will be marked invalid and the network will not be analyzed, 
until the user associates the demands with either a Ring or Linear subnet. 

2.7.17 Editing Fiber Span, Pair, and Fiber Parameters
Using the Properties pane, you can manage a fiber span, a fiber pair, and individual fibers. A fiber pair 
consists of two different fibers (clockwise and counter-clockwise). Table 2-26 lists the properties that 
you can modify for a fiber span, pair, or fiber.

Use the following procedure to edit fiber span, pair, and fiber parameters:

Step 1 In the Project Explorer, right-click the Fibers folder and choose Expand from the shortcut menu.

Step 2 In the Project Explorer tree, click one of the following. The options available for editing in the Properties 
pane change depending on your selection.

• To edit a fiber span, click the duct identifier. 

• To edit a fiber pair, click the fiber pair identifier. 

• To edit an individual fiber, click the fiber identifier. 

Step 3 In the Properties pane, edit the following parameters, as necessary. See Table 2-26 for the properties that 
you can change for a fiber span, fiber pair, or individual fiber.

• Name—Type the desired name for the fiber span, pair, or fiber.

Table 2-26 Editable Fiber Properties

Property Fiber Span Fiber Pair Fiber 

Name Yes Yes No

Ageing loss Yes No No

Ageing factor Yes No No

Fiber type Yes Yes No

Fiber length Yes Yes Yes

Length-based loss Yes Yes Yes

Connector loss (per site) Yes Yes Yes

Absolute loss without connectors Yes Yes No

CD factor Yes Yes No

PMD factor Yes Yes No

Loss Yes Yes Yes
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• Ageing loss—Type the EOL aging loss value. The EOL loss per span value is added at the end of 
life to each discrete fiber in the network (for example, to add an EOL margin for splicing). If you 
set the ageing factor, you do not need to set the ageing loss.

• Ageing factor—Type the number to factor fiber aging. This factor is multiplied by the SOL total 
span loss without connectors. If you set the ageing loss, you do not need to set the ageing factor.

• Type—Choose the type of fiber for each span in the network.

• Length—Type the span length. The displayed unit of measure is retrieved from the 
Span Measurements Units field.

• Length Based Loss—Check to define if the fiber loss is specified as an absolute value or leave 
unchecked if fiber loss is derived from the span length.

• Connector loss [Site 1]—Type the concentrated connector loss at the end of the span.

• Connector loss [Site 2]—Type the concentrated connector loss at the end of the span.

• Abs loss w/o conn [dB]—Type the start of life link fiber loss for each span, without the connector 
concentrated loss. The total SOL loss without connectors is equal to the loss factor multiplied by the 
length. In the Length Based model, this value is calculated automatically.

• CD—Type the fiber CD factor. The default value is dependent on the selected fiber type. Any value 
that you enter is lost whenever you change the fiber type. Chromatic dispersion is always entered in 
ps/nm/km. Fiber chromatic dispersion is defined for the middle of the wavelength band. C band is 
defined at 1545.3 nm; L band is defined at 1590.4 nm.

• PMD—Type the PMD factor. The default value is dependent on the selected fiber type. Any value 
that you enter is lost whenever you change the fiber type. PMD is always entered in ps/nm/km. 

• Loss—Type the value of the SOL fiber loss per kilometer used to calculate the loss of each span in 
the network. The fiber loss factor is always entered in dB/km.

Step 4 As needed, view the following totals for a fiber span, fiber pair, or individual fiber on the Properties pane:

• Loss BOL—(Display only) Displays the total loss beginning of life (BOL) calculation. 

Note BOL is also referred to as SOL.

• Loss EOL—(Display only) Displays the total loss EOL calculation.

• CD—(Display only) Displays the total chromatic dispersion.

• PMD—(Display only) Displays the total polarization mode dispersion.

2.7.18 Editing Fiber Spans, Pairs, and Fibers Using the Fibres Dialog Box
The Fibres Dialog lists all fiber spans, pairs, and fibers in the network. Use the following procedure to 
view and edit fiber parameters from the Fibres Dialog box.

Step 1 In the Project Explorer tree, right-click the Fibres folder in the desired network and choose Fibres 
Dialog from the shortcut menu. The Fibres Dialog appears (Figure 2-66).
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Figure 2-66 Fibres Dialog

Table 2-27 describes the columns on the Fibres Dialog.

Step 2 To edit a fiber span, pair, or fiber, click the desired item in the Fibres Dialog. The Properties pane in the 
right area of the Fibres Dialog displays the properties for the selected item.

Table 2-27 Fibres Dialog Columns

Column Description

Name Displays the name of the fiber span (Duct), pair (Couple), or fiber. Click the plus (+) 
sign by a Duct name to expand the list and show the Couple names. Click the plus 
(+) sign by a Couple name to expand the list and show the individual fiber names.

Src. Displays the name of the source site or interface for the fiber span, pair, or fiber.

Dst. Displays the name of the destination site or interface for the fiber span, pair, or fiber.

Type Displays the type of fiber for each span in the network.

Length Displays the span length. The displayed unit of measure is retrieved from the 
Span Measurements Units field.

Loss SOL Displays the total loss SOL calculation.

Loss EOL Displays the total loss EOL calculation.

CD C-Band Displays the total chromatic dispersion for the C-band.

CD L-Band Displays the total chromatic dispersion for the L-band.

PMD Displays the total polarization mode dispersion (PMD).

QD C-Band Displays the secondary order dispersion for C-band.

QD L-Band Displays the secondary order dispersion for L-band.

RD Displays the random dispersion value.
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Step 3 In the Properties pane, edit the following parameters, as necessary. See Table 2-26 for the properties that 
you can change for a fiber span, fiber pair, or individual fiber.

• Name—Type the desired name for the fiber span, pair, or fiber.

• Ageing loss—Type the EOL aging loss value. The EOL loss per span value is added at the end of 
life to each discrete fiber in the network (for example, to add an EOL margin for splicing). If you 
set the ageing factor, you do not need to set the ageing loss.

• Ageing factor—Type the number to factor fiber aging. This factor is multiplied by the SOL total 
span loss without connectors. If you set the ageing loss, you do not need to set the ageing factor.

• Type—Choose the type of fiber for each span in the network.

• Length—Type the span length. The displayed unit of measure is retrieved from the 
Span Measurements Units field.

• Length Based Loss—Check to define if the fiber loss is specified as an absolute value or leave 
unchecked if fiber loss is derived from the span length.

• Connector loss [Site 1]—Type the concentrated connector loss at the end of the span.

• Connector loss [Site 2]—Type the concentrated connector loss at the end of the span.

• Abs loss w/o conn [dB]—Type the start of life link fiber loss for each span, without the connector 
concentrated loss. The total SOL loss without connectors is equal to the loss factor multiplied by the 
length. In the Length Based model, this value is calculated automatically.

• CD—Type the fiber CD factor. The default value is dependent on the selected fiber type. Any value 
that you enter is lost whenever you change the fiber type. Chromatic dispersion is always entered in 
ps/nm/km. Fiber chromatic dispersion is defined for the middle of the wavelength band. C band is 
defined at 1545.3 nm; L band is defined at 1590.4 nm.

• PMD—Type the PMD factor. The default value is dependent on the selected fiber type. Any value 
that you enter is lost whenever you change the fiber type. PMD is always entered in ps/nm/km. 

• Loss—Type the value of the SOL fiber loss per kilometer used to calculate the loss of each span in 
the network. The fiber loss factor is always entered in dB/km.

Cisco TransportPlanner updates the Fibres Dialog box with the new value.

Step 4 As needed, view the following totals for a fiber span, fiber pair, or individual fiber on the Properties pane:

• Loss BOL—(Display only) Displays the total loss BOL calculation. 

Note BOL is also referred to as SOL.

• Loss EOL—(Display only) Displays the total loss EOL calculation.

• CD—(Display only) Displays the total chromatic dispersion.

• PMD—(Display only) Displays the total polarization mode dispersion.

Step 5 Click OK.

2.7.19 Modifying Site Structure, Functionality, and Type
You can edit a site after you have created it using the Network Creation Wizard. To create a site, see the 
“2.3 Creating a Project” section on page 2-25. The following properties of a site can be modified:
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• Site Structure

• Functionality

• Type 

To edit the properties of a site:

Step 1 In the Project Explorer tree, click the Sites folder. The list of sites included in the network appears 
(Figure 2-67).

Figure 2-67 Sites List

Step 2 Right-click the site you want to have the properties modified and select Edit. The Edit dialog box 
appears (Figure 2-68).

Figure 2-68 Sites Edit Dialog

Step 3 Select the new Structure, C-Band rules, and L-Band rules from General, C-Band Odd, and L-Band Odd 
groups respectively. For details on site design rules, see Table 2-25 on page 2-87. 

Step 4 Select the lock/unlock rules on the right side of the Edit dialog. For details on site modification unlock 
instances/parameters, see Table 2-29 on page 2-110. 
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Step 5 Click Apply. The selected changes are applied to the site. 

Step 6 Click OK to save the changes and exit the Edit dialog box.

Note When you modify a site, Cisco TransportPlanner does not allow you to decrease the number of node 
sites. For example, it would not be possible to change a Multi-degree site (created using the Network 
Creation Wizard) to a Line+ site; but, a Line site can be changed to a Multi-Degree. 

Table 2-28 shows the structure modifications that you can make using Cisco TransportPlanner.

When you modify the properties of a site, Cisco TransportPlanner checks the compatibility between the 
original site properties and the new configurations that you make on each site. It also checks for 
consistency in the add/drop section and/or in the amplifier/DCU section and displays a warning message 
in case of inconsistency. Cisco TransportPlanner then unlocks the related unit instances and/or 
parameters for you to make modifications. If the units were forced, Cisco TransportPlanner removes the 
forcing to perform the required modifications.

If the starting instances/parameters are consistent, even if not optimal for the ending configuration, Cisco 
TransportPlanner will warn the user about possible sub-optimization, but the related unit/parameter will 
be kept Locked (with its Layout property).

Site modifications that require unlocking of some instances/parameters are provided in Table 2-29.

Table 2-28 Permitted Structure Modifications

Starting Structure Ending Structure

Terminal or Terminal+ Line, Line+, Multi-Degree

Line or Line+ Multi-Degree

Table 2-29 Site Modification Unlock Instances/Parameters

Starting Configuration Ending Configuration Mandatory Unlock Suggested Unlock

Line, PT Line, OLA All amplifiers/DCU 
section

-

Line, OSC-site Line, OLA All amplifiers cards. -

Line, OLA Line, A/D None. All amplifier cards

Line, OLA Line, ROADM None. All amplifier cards

Line, A/D, OADM-xc Line, ROADM All OADM-xc cards. All amplifier cards

Line, HUB, WSS Line, ROADM None. All amplifier cards

Term, ROADM, WSS Line, ROADM, WSS None. All amplifier cards

Term, ROADM, WSS Multi-degree, WSS 32-DMX-O (if present) All amplifier cards
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2.7.20 Adjusting Site Layout
Site layout adjustment is a feature that allows you to move a selected card from its current slot to another 
slot in the chassis. This feature helps you customize the site layout based on your requirements. You can 
move both present and forecast cards. Cisco Transport Planner automatically changes the card position 
values and cable lengths in the Traffic Matrix report, Aggregated TDM /Ethernet report, Internal 
Connection report, and BoM report. You can view the modified reports by reopening the report. Shelf 
movement is possible for the PP-Mesh, Patch Panel, and DCU shelf. DCU cards can also be moved. Shelf 
movement is not possible for PDP, EAP, Air Ramp, Fan Tray, Flex Shelf and External Switch.

Site layout adjustments can only be done on a network that has been analyzed and is in any 
administrative state (Design, Upgrade, or Installation). 

Use the following procedure to move a card to a new position:

Step 1 Right-click on the site for which you want to move the cards in the rack and choose Layout. (See 
Figure 2-69). The Details dialog box appears (See Figure 2-70).

Line, ROADM, WSS Multi-degree, WXC, 
PP-MESH-4

32-DMX-O (if present) WSS cards, 40-MUX-C 
is the default; all 
amplifier cards

Line, ROADM, WSS Multi-degree, WXC, 
PP-MESH-8 

32-DMX-O (if present), 
AMP-17 cards (if 
present) 

WSS units (40-MUX-C 
is the default), all 
amplifier cards

Table 2-29 Site Modification Unlock Instances/Parameters

Starting Configuration Ending Configuration Mandatory Unlock Suggested Unlock
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Figure 2-69 Selecting the Layout View

Figure 2-70 Details Dialog Box

Step 2 Select Locked & Unlocked Mode from the drop-down list for Layout.
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Step 3 Choose Draw Mode and then click the card and move it to the desired slot in the shelf. 

Step 4 Click Confirm All to confirm the changes made. When you confirm all site adjustments, 
Cisco Transport Planner automatically unlocks both the source and destination slot positions.

Note The destination slot position must be within an existing shelf on the existing rack. A destination slot can be 
any empty slot or any other slot containing a client/OTS card. It cannot be a slot the user has already defined 
as destination for another position change (in the current layout adjustment session). 

The following constraints are applicable to card layout adjustment:

• When the network is moved to design mode all the reports are deleted. When the network is analyzed 
again the reports are regenerated. Hence the cards are placed in the default positions. To avoid this, 
upgrade the network, add the services and then analyze the network so that the cards are retained in 
the same position. In some cases you may need to unlock the site, according to the scenario.

• Only OSCM cards can be moved to slots 8 or 10.

• MS-ISC, Blank, TCC, AIC cards cannot be moved. Cards cannot be moved to slots 6 or 12 if 
MS-ISC cards are present in those slots.

• In DCC shelf management, TXP-MR-2.5G or TXPP-MR-2.5G cards in slot 12 cannot be moved.

Table 2-30 lists the allowed site layout adjustments.

Table 2-30 Allowed Site Layout Movements

From/To OTS

Unprote
cted
Fiber 
Switche
d 
TXP-MX
P

Unprotecte
d
Fiber 
Switched 
LC

1+1 TXP - 
MXP 1+1 LC

Y - 
Cable 
MXP

Y - 
Cabl
e 
MX
P 
Trun
k

Y - 
Cable 
and 
1+1 
Trunk 1+1 Multitrunk

OTS Yes1 Yes No Yes No No No No Yes

Unprote
cted/Fib
er 
Switche
d 
TXP-M
XP

Yes Yes No Yes for 
same 
shelf 
protectio
n; Yes for 
separated 
shelves 
protectio
n

No No No No Yes for same 
shelf 
protection; Yes 
for separated 
shelves 
protection

Unprote
cted/Fib
er 
Switche
d LC

No No Yes No No for 
differen
t 
shelves
; Yes 
for 
same 
shelf

No No No No
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1+1 
TXP-M
XP

Yes Yes No Yes for 
same 
shelf 
protectio
n; Yes for 
separated 
shelves 
protectio
n

No No No No Yes for same 
shelf 
protection; Yes 
for separated 
shelves 
protection

1+1 LC No No Yes No Yes No No No No

Y- Cable 
TXP

Yes Yes No Yes for 
same 
shelf 
protectio
n; Yes for 
separated 
shelves 
protectio
n

No Yes Yes No Yes

Y- Cable 
MXP / 
Multitru
nk

Yes Yes No Yes for 
same 
shelf 
protectio
n; Yes for 
separated 
shelves 
protectio
n

No Yes Yes No Yes

Table 2-30 Allowed Site Layout Movements

From/To OTS

Unprote
cted
Fiber 
Switche
d 
TXP-MX
P

Unprotecte
d
Fiber 
Switched 
LC

1+1 TXP - 
MXP 1+1 LC

Y - 
Cable 
MXP

Y - 
Cabl
e 
MX
P 
Trun
k

Y - 
Cable 
and 
1+1 
Trunk 1+1 Multitrunk
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The following constraints are applicable to shelf layout adjustments:

• You can move only Patch Panel, PP-Mesh, DCU shelves and DCU cards.

• You can do site adjustments in only one site before confirming the changes. 

• There can be only one shelf movement before the Confirm All button is clicked. If you try to do 
more movements with an already committed shelf movement, Cisco TransportPlanner displays an 
error message.

• You can perform multiple DCU card movements.

• When you click a shelf to move it to another place, it is always placed below the destination shelf 
selected. For example, if a DCU shelf is moved below the Patch Panel, the DCU shelf is placed under 
the PP=80-LC-D shelf after the Confirm All button is clicked. 

• When you move a shelf from one rack to another and both racks are full, you need to confirm if you 
want to swap the shelves. This is possible only if the shelves have the same Rack Unit (RU).

• DCU cards are allowed to move only to empty locations in another DCU shelf. You can also swap 
a DCU card with another DCU card in another location. You cannot create new shelves to 
accommodate a DCU. 

• If you try to move a Patch Panel, PP-Mesh or a DCU shelf to a PDP, EAP, Flex Shelf or External 
Switch, where PDP, EAP or FLex Shelf have any of the above shelf types already present below it, 
Cisco Transport Planner displays an error message.

Y- Cable 
and 1+1 
Multitru
nk 

Yes Yes No Yes for 
same 
shelf 
protectio
n; Yes for 
separated 
shelves 
protectio
n

No No No No No

1+1 
Multitru
nk 

Yes Yes No Yes for 
same 
shelf 
protectio
n; Yes for 
separated 
shelves 
protectio
n

No No No No Yes for same 
shelf 
protection; Yes 
for separated 
shelves 
protection

1. For all site movements marked as ‘Yes,’ Cisco Transport Planner create sa reverse link. For example, when a Y cable 
protected TXP is moved to an OTS card, a reverse link, that is, a link between the OTS card and the Y cable protected TXP 
is created automatically. 

Table 2-30 Allowed Site Layout Movements

From/To OTS

Unprote
cted
Fiber 
Switche
d 
TXP-MX
P

Unprotecte
d
Fiber 
Switched 
LC

1+1 TXP - 
MXP 1+1 LC

Y - 
Cable 
MXP

Y - 
Cabl
e 
MX
P 
Trun
k

Y - 
Cable 
and 
1+1 
Trunk 1+1 Multitrunk
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For any other kind of forced position, Cisco Transport Planner does not prevent you from forcing any 
destination position even if they do not match some of the layout recommended constraints (for example, 
OSMINE or TXP/MXP 1+1 Client protection). 
You need to ensure that the following conditions are met when doing layout adjustments:

• Site layout adjustments can only be done on a network that has been analyzed and is in any 
administrative state (Design, Upgrade, or Installation).

• A pair of TXP/MXP cards that are a part of a Y-cable protection group must stay within the same 
shelf.

• A pair of ADM-10G cards that are a part of the same ADM peer group must stay within the same 
shelf.

• A pair of line cards that are a part of a protection group must stay within the same shelf.

• A pair of line cards in a site that are a part of a P-Ring circuit must stay within the same shelf.

• It is recommended that you should not do more than five movements before clicking the Confirm 
All button.

2.7.21 Exporting the Fiber Spans, Pairs, and Fibers in a Network
Use the following procedure to export all spans, pairs, and single fibers in a network in XLS format:

Step 1 In the Project Explorer tree, right-click the Fibres folder in the desired network and choose Fibres 
Dialog from the shortcut menu. The Fibres Dialog appears (Figure 2-66).

Step 2 Click Export. The Fibres Export dialog box appears.

Step 3 Navigate to the desired directory, type the XLS filename, and click Save.

2.7.22 Arranging Sites
Sites can be arranged into four different configurations. Use the following procedure to arrange the sites 
into a configuration or to move all of the sites so that they appear in the Cisco TransportPlanner window:

Step 1 Click the NtView Name tab.

Step 2 Click the Arrange Sites drop-down list, and choose one of the following:

Note All shapes are approximations.

• Fit to visible rectangle view—Zooms to display all sites in the NtView Name tab.

• Arrange to an ellipse—Rearranges all sites in an ellipse form (Figure 2-71).
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Figure 2-71 Ellipse Shape

• Arrange to a square—Rearranges all sites in a square form so that the sites appear clockwise around 
the square (Figure 2-72). To complete a full square, this arrangement requires at least four sites.
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Figure 2-72 Square Shape

• Arrange to a snake—Rearranges all sites so that they cross the NtView Name tab from right to left 
and then left to right in a serpentine, linear format (Figure 2-73).

Figure 2-73 Snake Shape
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• Arrange to a double ring—Rearranges the sites into a dual ring format (Figure 2-74).

Figure 2-74 Double Ring Shape

• Arrange to Fit to Maximum Rectangle View—Arranges sites in proportion, using all network map 
area (Figure 2-75). 
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Figure 2-75 Fit to Maximum Rectangle View Shape

2.8 Managing the Network Design
After creating and analyzing a network design, you must prepare the design for installation at a customer 
site. After a network has been installed, you can reanalyze to correct any problems.

Network designs have several possible states:

• Design—The initial state for any new network design. You can add, delete, or change any aspect of 
the network design. In the Design state, no locks exist. After analyzing a design, you can put it back 
into the Design state to modify it by choosing Design in the Tasks Pane.

• Design-Analyzed—The state of the network design after you run the network analyzer. All reports 
are available and updated. You cannot change any aspect of the network design. You can modify the 
BoM, such as changing global discounts and spare parts. You can return to the Design state after 
analyzing the network by choosing Design in the Tasks Pane.

• Copy—A copy of a network. You can create a copy of a network in any state. A copy is useful for 
testing different design options. You can copy a network before or after analyzing it. A copied 
network inherits the set of project options defined in the original network. For more information, 
see the “2.8.1 Creating a Copy of the Network” section on page 2-121.

• Install—A network is initially designed with theoretical fiber values (such as loss, length, etc.). 
When a network is installed in the field, you can move the network into the Install state so that you 
can enter and check the real fiber parameter values. You can create an Install network from a network 
in the Design-Analyzed or Upgrade-Analyzed state. A network in the Install state inherits the set of 
project options defined in the analyzed network. All sites in an Install network are locked. You 
cannot modify any aspect of the network design except the span parameters and (on unlocked sites) 
amplifiers. You can, however, modify the BoM. All routed circuits are fixed, and cannot be changed 
while in this state. For more information, see the “2.8.2 Creating a Network in the Install State” 
section on page 2-121.
2-120
Cisco TransportPlanner DWDM Operations Guide, Release 8.5

78-18129-01



 

Chapter 2      Designing Networks with Cisco TransportPlanner
Managing the Network Design
• Install-Analyzed—The state of the Install network design after you run the network analyzer. All 
reports are available and updated. Cisco TransportPlanner locks all sites, spans, demands, and 
equipment when a network is in the Install-Analyzed state. 

• Upgrade—During network design, you define a number of the channels to be implemented at the 
present time and a number of channels to be implemented in the future (forecast). After installing 
the network, you might decide to implement the forecast circuits. To do this, you create an Upgrade 
network and then select the forecast or traffic demand services that you want to implement. You can 
create an Upgrade network from a network in the Design-Analyzed or Install-Analyzed state. You 
can unlock specified parameters to alter the design to include forecasted channels and traffic 
demands. A network in the Upgrade state inherits the set of project options defined in the analyzed 
network. For more information, see the “2.8.3 Creating an Upgrade Network” section on 
page 2-122.

• Upgrade-Analyzed—The state of the Upgrade network design after you run the network analyzer. 
All reports are available and updated. Cisco TransportPlanner locks all sites, spans, demands, and 
equipment when a network is in the Upgrade state. 

To complete the procedures in this section, you must have a project open and the network(s) loaded. See 
the “2.1.1 Opening a Project” section on page 2-2 and the “2.1.2 Loading and Unloading Networks” 
section on page 2-3.

2.8.1 Creating a Copy of the Network
To create a copy of a network in any state, right-click the network and choose Copy from the shortcut 
menu. A new copy appears in the Network Mgmt Tree tab.

2.8.2 Creating a Network in the Install State
Use the following procedure to create a network in the Install state:

Step 1 If the network is not analyzed, complete the “2.5 Analyzing the Network” section on page 2-52.

Step 2 Click the Networks Mgmt Tree tab. 

Step 3 Right-click the network and choose Install from the shortcut menu. A new network appears in the 
Networks Mgmt Tree in the Install state. All results from the analyzed network are imported into the 
Install network and are placed in the Locked mode.

Step 4 Make the necessary changes to the Install network. You can edit the following fiber parameters: fiber 
loss value, fiber CD, fiber PMD, and fiber length. See the “2.7.17 Editing Fiber Span, Pair, and Fiber 
Parameters” section on page 2-105. Cisco TransportPlanner also allows you to unlock site parameters 
for modification. To change site parameters, see the “2.7.3 Editing Site Parameters” section on 
page 2-83.

Step 5 In the Networks Mgmt Tree view, click the Analyze Network icon in the toolbar. For more information 
about the Cisco TransportPlanner icons, see Appendix A, “GUI Information and Shortcuts.” The 
TransportPlanner Analyzer status window appears to indicate the progress. As an alternative, click 
Analyze in the Tasks Pane. The Cisco TransportPlanner analysis status bar indicates when the network 
analysis is complete. The network now appears in the Install-Analyzed state.
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Note If you have changed parameters that are inconsistent with the present network layout (for 
example, if you set an output tilt value that the amplifier cannot reach), during network analysis 
an error message on the Analyzer Messages pane identifies which parameter is causing the 
problem. Warning and error messages help you identify problems with your current design. For 
a list of all system messages, see Appendix C, “System Messages.”

Step 6 When you have analyzed the network and are satisfied with the results, import the new generated 
installation parameters to each site of the network. For more information, see the “2.6.2 Saving the NE 
Update File” section on page 2-55. 

2.8.3 Creating an Upgrade Network
In an Upgrade network, you can perform the following tasks:

• Modify the fiber span properties (such as length, dispersion, PMD coefficient, excess losses, and 
aging).

• Add or delete traffic.

• Convert forecasted traffic to present traffic.

• Convert ROADM traffic to present traffic.

• Modify the type of a node.

• Force the presence or the absence of a card or a module (this includes amplifiers, OSC modules, 
OADM cards, and DCU modules).

In an Upgrade network, you can force certain installation parameters:

• Amplifier per-channel output power setpoint

• Amplifier output tilt setpoint

• OADM card aggregate output power setpoint

• Full multiplexer/demultiplexer or ROADM output power setpoint

You cannot change the following parameters when in Upgrade state:

• Node input channel fail threshold

• Node OSC channel fail threshold

• Preamplifier input power threshold

• OADM card aggregate input power setpoint

• Full muxponder/demuxponder or ROADM input power setpoint

• Channels drop power

When upgrading a network that has a point-to-point demand, you can:

• Move Future circuits to become Present. This can be done without unlocking the circuit.

• Open a optical-bypass channel. This can be done without unlocking the circuit.

• Add new, present, or future point-to-point services to the existing demand.

• Delete any present or future channel originally defined in the baseline network.
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• Change any unlocked point-to-point circuit or unlocked point-to-point service demand parameter.

When upgrading a network that has a any-to-any demand, you can:

• Move any of the Any-to-Any (future) services to the Present. This can be done without unlocking 
the circuit.

• Create a new Any-to-Any demand on an already existing Any-to-Any group.

• Create a new Any-to-Any group.

• Delete an existing Any-to-Any demand from an Any-to-Any group.

• Delete an Any-to-Any Group with all its Any-to-Any demand.

Note Any-to-Any services that have been moved to Present will be represented as Point-to-Point services.

Use the following procedure to put a network in the Upgrade state:

Step 1 If the network is not analyzed, complete the “2.5 Analyzing the Network” section on page 2-52.

Step 2 Click the Networks Mgmt Tree tab. 

Step 3 Right-click the analyzed network and choose Upgrade from the shortcut menu. A new Upgrade network 
appears in the Networks Mgmt Tree tab. All results from the analyzed network are imported into the 
Upgrade network. 

Step 4 Make the necessary changes to the Upgrade network. For more information, see the “2.7.17 Editing 
Fiber Span, Pair, and Fiber Parameters” section on page 2-105 and the “2.7.3 Editing Site Parameters” 
section on page 2-83.

Step 5 In the Networks Mgmt Tree view, click the Analyze Network icon in the toolbar. For more information 
about the Cisco TransportPlanner icons, see Appendix A, “GUI Information and Shortcuts.” The 
TransportPlanner Analyzer status window appears to indicate the progress. As an alternative, click 
Analyze in the Tasks Pane in any view. The Cisco TransportPlanner analysis status bar indicates when 
the network analysis is complete. The network now appears in the Upgrade-Analyzed state.

Note If you have changed parameters that are inconsistent with the present network layout (for 
example, if you set an output tilt value that the amplifier cannot reach), during network analysis 
an error message on the Analyzer Messages pane identifies which parameter is causing the 
problem. Warning and error messages help you identify problems with your current design. For 
a list of all system messages, see Appendix C, “System Messages.”

2.8.4 Unlocking Parameters in the Network Design
The Locked state occurs when you did not set (force) any value for a parameter and instead chose Auto. 
During network analysis, Cisco TransportPlanner assigns a value for each parameter set with Auto and 
puts them in the Locked state. The Locked state indicates that the next time the network is analyzed, the 
analyzer cannot change the value. Locking a site forces the presence or absence of all preamplifiers, 
boosters, add/drop filters, and DCU cards required by the site/network as a result of running the analyzer 
previously. Locked elements are indicated by a closed padlock icon in the Project Explorer 
(Figure 2-76). For more information on the Auto, forced, and locked states, see the “1.6 Auto, Forced, 
and Locked Parameters” section on page 1-11.
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Figure 2-76 Locked Sites in the Project Explorer View

To unlock network components to edit parameters, right-click the desired element in the Project Explorer 
and choose Unlock from the shortcut menu.

2.8.5 Creating a JPEG of the Network Design
Use the following procedure to create a snapshot of your network design in JPEG format:

Step 1 Click the NtView Name tab.

Step 2 Complete the “2.7.22 Arranging Sites” section on page 2-116 as necessary so that the sites in the 
network appear in the tab in the desired arrangement.

Step 3 Click the Save network view image icon in the toolbar. 

Step 4 In the Save network view image dialog box, navigate to the desired directory.

Step 5 Enter the file name in the File Name field and click Save.

2.8.6 Upgrading a Release from 7.0 to 8.5
Use the following steps to upgrade a release saved as a Cisco TransportPlanner ONS Software R7.0 
project to release 8.5.

Step 1 From the File menu, click Open to load the saved Cisco TransportPlanner 7.0 project. 

Step 2 Right-click on the network loaded on the Project Explorer and select Release Upgrade. 
Cisco TransportPlanner automatically creates a copy of the initially loaded network and updates the 
system release to ONS Software Release 8.5. The newly created network copy will be moved into the 
Upgrade administrative status. 

Note The tool allows you to manually enter the details of a deployed network even if the 
Cisco TransportPlanner design file is not available. You can perform a release upgrade only on a network 
that has been analyzed. Also, a release upgrade can be performed only on a loaded network that has been 
designed and saved with the current Cisco TransportPlanner release and with the ONS Software Release 
that is the last supported by Cisco TransportPlanner.
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2.9 Generating a BoM 
You can generate a BoM when a network is in the Install or Upgrade state, or after you have successfully 
analyzed your network design. The price database selected during project creation is used to generate 
the BoM.

To complete the procedures in this section, you must have a project open and the network(s) loaded. See 
the “2.1.1 Opening a Project” section on page 2-2 and the “2.1.2 Loading and Unloading Networks” 
section on page 2-3.

2.9.1 Viewing BoM Report Totals
Use the following procedure to view the BoM report totals:

Step 1 Click the Networks Mgmt Tree tab and click the network.

Step 2 In the Tasks Pane, click Bill of Material. The Bill of Material tab appears. As an alternative, you can 
access this report by choosing Bill of Materials from the Reports folder in the Project Explorer tree.

The upper section of the BoM tab (in the Net view, Site view, and Spare subtabs) displays the following 
information:

• BoM total discounted—Displays the price for the overall network (without spare parts) for each item 
in the BoM. If Use global discount is checked, the total includes the discount from the Global 
discount percentage field.

• Spare total discounted—Displays the price for all of the recommended spare parts in all of the 
maintenance centers for the overall network. It is the sum of each spare item using the discounted 
price. The total appears after you check the Spare Part Report check box.

• BoM + Spare total discounted—Displays the sum of the BoM total discounted price and spare total 
discounted price.

• Price List—Displays the name of the price list database selected for the project.

• Price List last update—Displays the date that the selected price list was last updated.

• Currency—Displays the value of the currency used for each of the price values as specified within 
the selected price list database.

Step 3 To use the Multishelf Management Integrated Kit bundle when generating the BoM instead of the single 
items, check Use MSM bundle. 

Step 4 Check Spare Part Report to include the spare parts in the report totals.

Note You can only check the Spare Part Report check box if the network is in Design mode.

Step 5 The Global discount percentage field shows the percentage from the Global Discount Percentage option 
in the Default Project Options window. To change the global discount for the entire network, check 
Use global discount and enter a new global discount in the form of a percentage in the Global discount 
percentage field. The global discount is applied to all components in the BoM and will overwrite any 
discount specified in the Global Price List.
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2.9.2 Generating a Network BoM
Use the following procedure to generate a BoM for the network:

Step 1 Click the Networks Mgmt Tree tab and click the network.

Step 2 In the Tasks Pane, click Bill of Material. The Bill of Material tab (Figure 2-77) appears. The Net View 
subtab is selected by default. Items that are not found appear in yellow in the BOM.

Figure 2-77 Bill of Material Tab, Net View Subtab

Table 2-31 describes the Net view subtab columns. See the “2.9.1 Viewing BoM Report Totals” section 
on page 2-125 for a description of the data, check boxes, and fields at the top of the window. 

Table 2-31 BoM Net View Columns

Column Label Description

Product ID Displays the ordering code used to order the BoM from Cisco.

Description Displays a description of the product.

Quantity Displays the number of specific products in the BoM.

Unit price Displays the price for each unit. If the price does not appear, Invalid will 
display. This occurs when the price list reports “NaN” (Not a Number) for the 
item because the price list has never been updated. Invalid items appear in the 
list in red. Items that have not been updated from CCO appear in yellow.

Unit Discount Displays the per-unit discount amount that you assigned in the Global Discount 
Percentage field. If you leave the field blank, the field displays the default 
value from the Price List database.
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Step 3 To close the Bill of Material report, click the X in the upper right corner of the Bill of Material tab.

2.9.3 Generating a Site BoM
A site BoM lists all of the hardware and software parts required for the system to work as designed at a 
given site. Use the following procedure to generate a BoM for a site:

Step 1 Click the NtView Name tab and click the site.

Step 2 In the Tasks Pane, click Bill of Material. The Site view subtab is selected by default (Figure 2-78). Items 
that do not appear in the price list appear in red.

Figure 2-78 Bill of Material Tab, Site View Subtab

Total price Displays the total price of the products before applying the discount.

Discounted Total 
Price

Displays the total price of the products after applying the discount.

Site # Displays the number of products to be assigned to a particular site. The number 
of Site columns is the same as the number of sites in the network.

Table 2-31 BoM Net View Columns (continued)

Column Label Description
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Table 2-32 describes the Site view subtab columns. See the “2.9.1 Viewing BoM Report Totals” section 
on page 2-125 for a description of the data, check boxes, and fields at the top of the window. 

Step 3 To close the Bill of Material report, click the X in the upper right corner of the Bill of Material tab.

2.9.4 Generating a Spare Parts Report
After you generate the BoM, use the following procedure to determine the spare parts required by the 
network. If the network is in the Upgrade state, the report includes the parts required to support the 
implemented services and the new additional present services. To generate a spare parts report, you must 
associate a site with a maintenance center before network analysis. For more information, see the 
“2.7.3 Editing Site Parameters” section on page 2-83.

Step 1 Click the Networks Mgmt Tree tab and click the network.

Step 2 In the Tasks Pane, click Bill of Material. Click the Spare subtab (Figure 2-79). 

Table 2-32 BoM Site View Columns

Column Label Description

Name Displays the site name. Click the plus (+) sign to expand the site and display 
the categories. Click the plus (+) sign to expand each category to view the 
items in the BoM.

Product ID Displays the ordering code used to order the BoM from Cisco.

Quantity Displays the number of that specific item in the BoM.

Unit price Displays the price for each unit. If the price does not appear, Invalid will 
display. This occurs when the price list reports “NaN” (Not a Number) for the 
item because the price list has never been updated. Invalid items appear in the 
list in red. Items that have not been updated from CCO appear in yellow.

Unit Discount Displays the per-unit discount amount that you assigned in the Global Discount 
Percentage field. If you leave the field blank, the field displays the default 
value from the Price List database.

Total Price Displays the total price of the products before applying the discount.

Discounted Total 
Price

Displays the total price of the products after applying the discount.
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Figure 2-79 Bill of Material Tab, Spare Subtab

Table 2-33 describes the Spare subtab columns. See the “2.9.1 Viewing BoM Report Totals” section on 
page 2-125 for a description of the data, check boxes, and fields at the top of the window. 

Table 2-33 BoM Spare Subtab Columns

Column Label Description

Name Displays the name of the item at the site. Right-click the maintenance center 
and choose Expand All from the shortcut menu to view all spare parts.

Product ID Displays the ordering code used to order the BoM from Cisco.

Quantity Displays the number of specific items in the BoM.

Unit price Displays the price for each unit. If the price does not appear, Invalid will 
display. This occurs when the price list reports “NaN” (Not a Number) for the 
item because the price list has never been updated. Invalid items appear in the 
list in red. Items that have not been updated from CCO appear in yellow.

Unit Discount Displays the per-unit discount amount that you assigned in the Global Discount 
Percentage field. If you leave the field blank, the field displays the default 
value from the Price List database.

Total Price Displays the total price of the parts before applying the discount.

Discounted Total 
Price

Displays the total price of the parts after applying the discount.
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Step 3 To close the Bill of Material report, click the X in the upper right corner of the Bill of Material tab.

2.9.5 Exporting a BoM
Use the following procedure to export the BoM to an external file in XML, Excel spreadsheet, HTML, 
or text format:

Step 1 Click the Networks Mgmt Tree tab and click the network.

Step 2 In the Tasks Pane, click Bill of Material. The Bill of Material tab appears. 

Step 3 Click Export. The BoM export dialog box appears.

Step 4 In the BoM export dialog box, type the name of the file, choose the file type (.xls and .html) from the 
drop-down list, and navigate to the desired folder. Click Save.

2.10 Managing the Price List
A price list is defined for each project and is used to generate a BoM. Cisco TransportPlanner can 
manage multiple price lists. You can even change a project price list after a project has been established. 
The Master Price list is the Global Price List in US dollars. You can download new price lists from Cisco 
Connection Online (CCO).

Only the selected price value is saved with a project; the actual price database is not saved with the 
project. When opening a saved project (for example, a project received from another designer), the 
associated price database might not be available. If this is the case, Cisco TransportPlanner notifies you 
that the Master Price list will be used. 

To save memory, Cisco TransportPlanner automatically loads only the price list selected for the current 
project. 

2.10.1 Creating a New Price List
Use the following procedure to download a price list from CCO. You can download price lists from CCO 
if no projects are currently open. 

Step 1 If a project is open, close the project. See the “2.1.5 Closing a Project” section on page 2-6.

Step 2 From the Tools menu, choose Price List Mgmt. The Price Manager dialog box appears (Figure 2-80).
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Figure 2-80 Price Manager Dialog Box

Step 3 In the Price Manager dialog box, right click PriceDBManager and choose New Price DB from the 
shortcut menu.

Step 4 In the Create a New Price DB dialog box, enter the price list name. 

Step 5 From the drop-down list, choose the desired CCO price list. 

Step 6 Click OK.

Step 7 Click OK to update from CCO.

Step 8 In the CCO User Name/Password dialog box, type your user name and password, and click OK. 
Cisco TransportPlanner downloads the CCO price list. 

Step 9 When the update is complete, click OK to close the confirmation dialog box. The new price list appears 
in the PriceDBManager tree. 

Step 10 Click Close to close the Price Manager dialog box.

2.10.2 Viewing a Price List
Use the following procedure to view and filter a price list:

Step 1 From the Tools menu, choose Price List Mgmt. The Price Manager dialog box appears (Figure 2-80 on 
page 2-131). 
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The PriceDB Manager tree lists all of the created price lists. To save memory, Cisco TransportPlanner 
automatically loads only the price list selected for the current project (unless the user requests 
otherwise). An L indicates that the price list is loaded in memory and is available. A U indicates that a 
price list is currently not loaded in memory and is not available. 

Step 2 To load or unload a price list, right-click a price list and choose Load or Unload from the shortcut menu.

Step 3 Click PriceList under the desired price list identifier in the PriceDBManager tree. The list displays in 
the right pane of the Price Manager dialog box. The properties of the price list appear in the bottom left 
corner of the Price Manager dialog box:

• Last update—Indicates the date of the last download from CCO for this price list. If Never appears, 
this indicates that the user created a price list without downloading from CCO.

• Updated by—Identifies the way in which the price list was updated.

The price list displays the following columns:

• Price List ID—For internal use.

• Major Parent ID—Lists the platform.

• Minor Parent ID—Lists the equipment type.

• Product ID—Identifies the ordering code for the specific unit.

• Description—Provides detail about the item.

• Service Category—For future use.

• List Price—Indicates the price of the item. If NaN (Not a Number) appears in the field, the list has 
not been updated.

• Major ID—For internal use.

• Minor ID— For internal use.

• Update Status—Identifies how the last update was made to an item:

– None—Indicates that the price list has never been updated.

– local_file—Indicates that the price list has been updated from a local file.

– cco—Indicates that the price list has been updated from CCO.

– user—Indicates that the price list has been manually updated by the user who directly edited the 
price list. The user can modify the Discount field.

• Discount—If a discount applies, identifies the discount percentage. To modify this field, enter the 
new percentage.

Step 4 To search for a specific item in a price list, type the desired item in the Search field at the top of the list. 
As you type, Cisco TransportPlanner filters the list items to match your search entry. To choose Search 
options, click the Search Tool icon to the left of the Search field and choose one of the following:

• Column name—Searches only the specified column for the search string. The All option searches 
all columns.

• Case sensitive—Matches the case of the search string.

• Case insensitive—Disregards the case of the search string.

• Match from start—Searches only for the search string if it appears at the beginning of column text.

• Match any where—Searches for the search string if it appears anywhere in the price list.

Step 5 To sort the items in the price list, click on a column to sort by that column. 
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Step 6 Click Close to close the Price Manager dialog box.

2.10.3 Loading and Unloading Price Lists
To save memory, Cisco TransportPlanner automatically loads only the price list selected for the current 
project. An “L” by a price list in the Price Manager dialog box indicates that the price list is loaded; a 
“U” in the Price Manager dialog box indicates that the price list is not loaded. Use the following 
procedure to load or unload price lists in Cisco TransportPlanner:

Step 1 From the Tools menu, choose Price List Mgmt. The Price Manager dialog box appears (Figure 2-80 on 
page 2-131).

Step 2 Right-click the price list and choose Load or Unload from the shortcut menu.

2.10.4 Updating a Price List from CCO
Use the following procedure to update a specified price list from CCO or from a local file. You can also 
update all price lists, even the lists that are not currently loaded. You can update a price lists from CCO 
if no projects are currently open. 

Step 1 If a project is open, close the project. See the “2.1.5 Closing a Project” section on page 2-6.

Step 2 From the Tools menu, choose Price List Mgmt. The Price Manager dialog box appears (Figure 2-80 on 
page 2-131).

Step 3 Right-click the desired price list identifier in the PriceDBManager tree and choose Expand from the 
shortcut menu.

Step 4 Right-click the desired price list in the expanded tree and choose UpdateFromCCO from the shortcut 
menu.

Step 5 In the Update from CCO dialog box, choose Update single price list to download data for the specified 
list or Update all price lists to download the latest data for all price lists.

Step 6 In the CCO User Name/Password dialog box, type your user name and password and click OK. 
Cisco TransportPlanner downloads the price list.

Step 7 When the update is complete, click OK to close the confirmation dialog box. 

Step 8 Click Close to close the Price Manager dialog box.
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2.10.5 Copying a Price List
Use the following procedure to create a new price list by copying from an existing one. The new price 
list will have all of the attributes and values of the original price list (such as Updated By, Last Update, 
unit price, discounts, etc.). You can copy a price list if no projects are currently open. 

Step 1 If a project is open, close the project. See the “2.1.5 Closing a Project” section on page 2-6.

Step 2 From the Tools menu, choose Price List Mgmt. The Price Manager dialog box appears (Figure 2-80 on 
page 2-131).

Step 3 Right-click the desired price list in the PriceDBManager tree and choose Copy from the shortcut menu.

Step 4 Type the name for the new price list and click Ok. The new price list appears in the PriceDBManager 
tree.

Step 5 Click Close to close the Price Manager dialog box.

2.10.6 Deleting a Price List
Use the following procedure to delete a price list. You cannot delete the Master Price List or a price list 
that is in use by a project. You can delete a price list if no projects are currently open. 

Step 1 If a project is open, close the project. See the “2.1.5 Closing a Project” section on page 2-6.

Step 2 From the Tools menu, choose Price List Mgmt. The Price Manager dialog box appears (Figure 2-80 on 
page 2-131).

Step 3 Right-click the desired price list in the PriceDBManager tree and choose Delete from the shortcut menu.

Step 4 Click Close to close the Price Manager dialog box.

2.10.7 Viewing Maintenance Contracts
Use the following procedure to view maintenance contracts:

Step 1 From the Tools menu, choose Price List Mgmt. The Price Manager dialog box appears (Figure 2-80 on 
page 2-131).

Step 2 Right-click Maintenance Contracts and choose Expand from the shortcut menu. 

Step 3 Click ContractsList. The Contract PID column lists the service contract identifiers for the hardware and 
software parts used by Cisco TransportPlanner. The Contract Category column describes the service 
programs. 

Step 4 Click MapPidsContracts. The PID column lists the product identifiers. The Contracts column lists the 
service contract identifier.

Step 5 Click Close to close the Price Manager dialog box.
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